
3D Builder3D Builder

Converts Your Photos to 3D Models

Version 3.0

3D Construction Company3D Construction Company
122 Creative Station

Elizabethton, Tennessee USA 37643-5358
1-423-543-8917

Fax 1-423-543-4011
Email: threedc@usit.net





         3D Builder Reference Note

3D BUILDER REFERENCE NOTE
Copyright 1995, 1996, 1997, 1998 3D Construction Company
All rights reserved

SOFTWARE LICENSE AGREEMENT
3D Construction Company grants you a non-transferable, non-exclusive license to use only this copy of the 3D BUILDER
program and its accompanying materials according to the following terms:

LICENSE
a) You may use the program on only one computer at a time.
b) You may make one copy of the program only for backup purposes, provided that you reproduce all  proprietary notices
on the copy.
c) You may transfer the program onto your hard disk only for use as described above providing that you can prove
ownership of the original disks.
d) You may physically transfer the program from one computer to another provided that the program is used on one
computer at a time.
e) You may NOT use the program in a network unless you pay for a separate license for each terminal or workstation from
which the program will be accessed.
f) You may NOT reverse engineer, decompile, dissemble, modify, translate, or create derivative works based on, or copy
the program or accompanying materials(except for the backup copy listed above).
g) You may NOT transfer, rent or grant any rights to the program in any form or accompanying materials to any person or
company without the prior written consent of 3D Construction Company.
h) You may NOT remove any of the proprietary notices, or labels, or marks on the program or accompanying materials.
This license is not a SALE. Title and copyrights to the program, all or any accompanying materials, and any copy made by
you remain the property of 3D Construction Company.
TERMINATION
Any unauthorized copying of  the 3D BUILDER program (alone or merged with any other software) or any of the
accompanying materials, or failure to comply with the above restrictions will result in the automatic termination of this
license and will make available to 3D Construction Company other legal recourse and action.

WARRANTY AND DISCLAIMER
“As Is”. The 3D BUILDER program and all accompanying materials are provided to you “as is” without warranty of any
kind, either express or implied, including, but not limited to, the implied warranties or merchantability and fitness for a
particular purpose.
3D Construction Company does not warrant that the functions and/or performance of this program will meet your
requirements or that the operation will be uninterrupted or error free.  The risk as to the use, performance, and/or quality of
the program and any/all accompanying materials is entirely with you.  Should the program prove defective, you, and not
3D Construction Company assume the entire cost of any/and all necessary repairs. 3D Construction Company does
warrant the media on which 3D BUILDER is furnished to be defect free in workmanship and materials  under normal use
for a period of 30 days from the date of delivery to you as evidenced by a copy of your receipt. The duration of any implied
warranties is limited to the period stated above.  3D Construction Company’s entire liability will be the replacement of the
media.
The images presented here are for instructional purposes only and  may not look exactly like the ones on your machine.

LIMITATION OF LIABILITY
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Under no circumstances will 3D Construction Company be liable for any damages, including loss of data, lost profits, cost
of cover or other special, consequential or indirect damages arising from the use of 3D BUILDER or any or all of its
accompanying materials. You acknowledge that the license fee reflects this allocation of risk.

If you have any questions, please call or fax
3D Construction Company, 122 Creative Station, Elizabethton, Tennessee USA 37643-5358, 1-423-543-8917, FAX 1-
423-543-4011 or  you may write to us at the above address.

FAX or MAIL in your registration card today. Return of the registration card is required for all product updates and all
notices of new versions

All trade names referenced are the registered trademark of their respective owners. 3D BUILDER is a registered
trademark of 3D Construction Company,  Elizabethton, Tennessee USA.

Document  #L798
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IntroductionIntroduction

3D Builder for Windows is a productivity tool designed to help you convert photos
into 3D models. As a desktop photogrammetry system, 3D Builder provides the first
constraint-based  modeling software package to work directly from your photographs.
3D Builder gives you accurate “X”, “Y”, and “Z” locations for “as builts”, as well as
giving you both the camera locations and orientations.  3D Builder works seamlessly
with  the major rendering tools, such as 3D Studio, as well as CAD packages  such as
AutoCAD. 3D Builder uses a standard Windows  user interface making it easy to learn.
Our new CAD-style tools for creating circles, Bezier spline curves and extrusions saves
considerable time in the modeling process.

3D Builder does not require any special cameras or any special experience to
transform your photos of real world data  into detailed 3D models. 3D Builder offers a
cost effective solution for custom modeling needs, especially when compared to other 3D
modeling techniques. Using a powerful, comprehensive math solver, 3D Builder is able
to combine information from a large number of photos of simple or complicated objects,
extract information , and merge it all together into a single 3D model ready to export to
the target rendering program.

 This program can save you both hours of frustration and money.  3D Builder
simplifies the complex mathematical work and frees you to concentrate on the creations
possible with today’s rendering, animation, CAD or Internet packages. 3D Builder takes
the mystery and the drudgery out of  building dimensionally accurate 3D models.

If you are familiar with other programs for Microsoft Windows, you should have no
trouble using 3D Builder.  You will find the user interface comfortable and easy to use.
This manual describes 3D Builder’s features and gives procedures for using them.

All brands and products listed are the property of their respective owners.

 Chapter

  1
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System Requirements
The following minimum requirements are needed to run 3D Builder successfully:

• A  PC with a 386 or higher processor
• At least 16 megabytes of RAM and 16 megabytes of available hard disk space
• Windows 95 or 98,  WindowsNT 3.51, 4.0,  or later.
• 256 color (or higher)  capable video board

About This Manual
This manual contains information about how to use 3D Builder to convert photos into
3D models.  It assumes that you are familiar with how to navigate in a Windows
environment. This manual also assumes a basic knowledge of photography and/or video
techniques.

Conventions Used In This Manual
To help you find information, this manual adheres to the following conventions:

• Indicates a note of importance. Read carefully.

 

 

 -----------------------------------------------------------------------------------------------

• Indicates that this feature or function can only be used with the 3D Builder
PRO version.  It cannot be used with 3D Builder POWERLITE version.

 

   -----------------------------------------------------------------------------------------------
-

• Indicates a command button that you can select from the toolbar.

-------------------------------------------------------------------------------------------------

Note:  3D Builder gives you a lot of flexibility.  You may start with
any image you choose, in any order that you choose.

Note:  You can work with images that are in 16, 8, or black and white if
you convert the image in a Paint program, saving it as 256 colors first.
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• Indicates the name of a menu command, such as Edit.

• Indicates the name of an object, such as a dialog box or a menu, “Point Tool
Dialog Box”.

 ---------------------------------------------------------------------------------------------

• The plus sign (+) indicates that you should press and hold down the first key
while pressing the second key. Then release both keys at the same time. For
example, “Alt + C” indicates that you should press down “Alt” and hold it while you
press “C”. Then release both keys.

Installation Procedures
This section explains how to install 3D Builder on your computer’s hard disk.
During installation you will be given an opportunity to select either a full  Install or a
Custom Install.  A “Full Install” installs all necessary files, plus the Tutorials.  A
“Custom Install” allows you to install only the desired components of  3D Builder.

What You Will Need

To install 3D Builder you will need:
Either the 3D Builder program disks or the 3D Builder CD.

At least 16 mg of available space on your hard drive.

3D Builder Installation
To install 3D Builder, you must be running Microsoft Windows 95, 98 or

WindowsNT.  3D Builder requires at least 16 megabytes of hard disk space.

CD Installation Instructions:
1. 1. Insert the CD in your CD drive.  From the program manager or the File Manager,

type: e:setup, where “e” is the drive letter of your CD drive from which you will be
installing.  Then press “Enter” or “OK”.  After a pause, you will see the 3D Builder
setup window.  Follow the instructions given on the various message boxes which will
appear on your screen.

 
2. Enter a directory for installing 3D Builder in the entry field provided.  The default

directory  and drive for installing 3D Builder is C:\Program Files\3DCo\3DBuilder.
 
3. Follow the instructions given on the various message boxes will appear on your screen.
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It is recommended that you read the “Read Me” file for any last minute instructions that
may have been added after this manual was printed.

A message box will appear when 3D Builder has been successfully installed.
To run the 3D Builder program, double click on the 3D Builder icon.

Floppy Disk Installation Instructions:
1. Insert Disk 1 in any 3.5” disk drive.  From the Program Manager or the File

Manager, type A:setup where “A” is the drive letter of the 3.5” drive from which
you will be installing.  Then press “Enter” or “OK”.  After a pause, you will see the
3D Builder setup window.  Follow the instructions given on the various message
boxes which will appear on your screen.

2. Enter a directory for installing 3D Builder in the entry field provided.  The default
directory and drive for installing 3D Builder is C:\Program Files\3DCo\3DBuilder.
 
3. Follow the instructions given on the various message boxes which will appear on

your screen.

It is recommended that you read the “Read Me” file for any last minute instructions
that may have been added after this manual was printed.
A message box will appear when 3D Builder has been successfully installed.
To run the 3D Builder program, double click on the 3D Builder icon.

License Authorization Instructions

3D Builder for Windows is licensed to an individual machine.  After installing the
program you will need to license it by faxing or Emailing (preferred)information to 3D
Construction Company.   If 3D Builder has not been licensed it will display the License
Wizard when it starts up (see below).  The License Wizard will guide you through a
series of  questions and will prepare a form to be faxed or Emailed (preferred).  3D
Construction Company will then send you an authorization code which unlocks the
program.

Note: On some machines (or where a printer is not available, this information is
available in a file called “XNETINST.TMP” in your 3D Builder directory.

  IMPORTANT:  Make sure that you choose correctly when asked
  what system:  Win 95 98  or NT.
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Key Points
• 3D Builder is licensed to an individual machine and to a specific location on a

machine.
• 3D Builder automatically defaults to running in a demo mode.  Using the demo

mode, you can run the tutorials and learn about 3D Builder’s program tools and
features, but you are limited to working with the supplied tutorial image files.

• 3D Builder can be turned on for a free 30 day trial period or it can be turned on
for full unrestricted use.

• To activate the program for either a 30 day trial evaluation or for full
unrestricted use, refer to the chapter on “License Authorization” later on in this
manual.

Make A Back Up
It is a good idea to make a working back up copy of the 3D Builder master disks.  Store
the originals in a safe place.  If anything happens to the working copies, the originals
will be intact.
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Updates and Registration
Please take a moment to fill out the registration card and mail or fax it back to 3D
Construction Company with the address of where you want information sent.  This is the
best way for us to tell you about bug fixes, upgrades and new features.

Only registered owners can receive upgrades and technical support.

Getting Help
On-Line Help is provided on most topics in 3D Builder.  Use on-line help when you
want immediate information about any of the features of 3D Builder.
The help system includes an extensive topics index, a glossary, and special features.
Many of the new tools feature “Just-In-Time-On-Line Helps” which give you information
about using the tools.  Also, the tutorials are on-line and give additional help
information. Context sensitive helps are available by moving your mouse over the desired
object or menu item.

Using the Commands on the Help Menu
You can get help by selecting the “Help” button on the toolbar or pressing  “F1” to
access the  “on-line help”.
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New FeaturesNew Features

3D Builder  has added the following features  to help you convert photos into 3D models.

  Changes and New Features from Release 2.0

•  Circles and Arcs: 3D Builder Pro features new tools for circles and arcs.
Located under the “Draw” menu, each menu item is activated by clicking on it.  The
circle tool also has an icon for easy access from the toolbar.

 
•  Free-form Curves:  3D Builder Pro features new tools for free-form (Bezier

spline) curves.  The “curve” tool is used to create any type of curve. You can create an
“Open Curve” or a “Closed Curve”.

•   Extrusions: 3D Builder features new tools for creating extrusions from lines
and faces you have previously created.  The “extrusion” tool is used to extrude any type
of object. Located under the “Draw” menu, each menu item is activated by clicking on it.
The extrusion tool also has an icon for easy access from the toolbar.

•   Camera Wizard: 3D Builder now features an easy to use Camera Wizard for
entering data about camera and lenses.  The Camera Wizard will guide you through a
series of questions to help you determine the camera information.  This is especially
helpful if you are using a digital camera, since many manufacturers do not provide the
“true” focal length of the lens.

 
•   Camera Calibration Wizard: 3D Builder  now features a simplified camera

calibration wizard.  The wizard will guide you through a series of questions to help you
calibrate the camera and lens combination that you are using.

 
 
 

 Chapter

  2
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•   Added a new toolbar icon for displaying the “Project Window”.
 
•   Added power-user new shortcut keys,  such as “F3” for “Calc3D” and “F4” to

display the 3D Preview window. We have provided a bookmarker with the “Power
Shortcut keys” printed on it for your convenience.  The power shortcut keys are also
listed in the Appendix of this “User’s manual”.

 
•   Added sub-pixel precision for locating points.

•   Added VRML 2.0 export file format.

•  Added a "Camera Viewpoints" tab to the export dialog.  Allows check marks
to be placed on photos which are to have their camera position and orientation exported
(Inventor and VRML only).  These standard views  make it easier to navigate with
VRML browsers.

•   Added menu commands under Help/Tutorial to launch a web browser for
tutorials 1, 2, 3, 4 and 5. The 3D Builder tutorials are now available in an "on-line" form
The online tutorials can be viewed from your Internet browser. From your  Internet
browser, choose tutor1.htm, tutor2.htm, tutor3.htm, tutor4.htm or tutor5.htm. These files
can be found in C:\Program Files\3DCo\3Dbuilder\tutorial\tutor1 or tutor2 or tutor3 or
tutor4 or tutor5. Selecting one of these .htm files will run the online version of the 3D
Builder tutorials. If you resize your Internet browser and the 3D Builder screen, you can
see both at the same  time.  This will allow you to "do" a tutorial while you read about it.

•  Non-textured materials created during a project may now saved  to the master
“material.dat” file when the project is saved. A pop-up window will ask if this should be
done.

•  Expanded the “Tools/Verify Points” wizard by adding an option for verifying
point-point matchings between images.  If this option is selected the wizard will cycle
through pairs of what should be the same point in different images.  This tool is intended
as a aid when a project will not calculate correctly and it is suspected that one or more
points may have been incorrectly merged between images.

•   Added JPEG Texture Maps.  3D Builder now saves texture maps as both
.BMP and .JPG files.  The .BMP file is required for the 3D Builder “3D Preview”
window, accessed via the “Window/3D Preview” menu, and may be exported to 3D
Studio and other modeling programs.  The .JPG file is used for VRML  and Inventor
exports.  The .JPG file is much smaller which is better for the Internet.
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•   Tools/Settings: 3D Builder has added an option under the “Colors” tab for
setting “line” and “curve” weights.  You may now choose either a “single” or “double”
weight for the display of the line.  This was done  to improve the visibility of the lines in
curves.

•   Digital Camera Information: Because of the widespread growth of digital
cameras, 3D Builder has added a lot of information concerning various types of digital
cameras.  The “camera lens combo box” now displays all available camera types with
known camera magnification and other parameters.

 Note: There is now a new entry for “Generic digital camera”. If you know the
camera lens that took the image, be sure to specify the camera lens in addition to the type
of camera.  If you do not know the camera lens that took the picture,  at least specify the
type of camera.

 
•  Make Perpendicular constraints:  3D Builder Pro has added a  new command

for indicating that two or three lines are perpendicular to each other.
 

•   New Screen Layout: The layout is now optimized for 800 by 600 (or larger)
SVGA screens.  The 3D Builder program still runs on 640 by 480 VGA screens, but  you
will need to rearrange  the toolbars to fit the screen. Each toolbar is independent and can
be docked in several areas on the screen.

•    “Drag and Drop” to New Locations: 3D Builder has added a new “dragging”
action for moving a point to a new location.  Click once on a point with the “arrow” tool
to select the point, then mouse down and drag the point to the desired new location.

• • New Independent mini-toolbars: 3D Builder has added several new “mini-
toolbars” making it easier for you to use tools in your 3D modeling.  These new mini-
toolbars are described here:

Display mini-toolbar:
3D Builder has added a new, independent, mini-toolbar to control what you see on the
image. You may now turn off the visible display of lines, points and faces from the
toolbar.  This mini-toolbar is independent from the main toolbar and may be docked
anywhere on your screen.

Circle, Curve, and Extrusion mini-toolbars:
3D Builder has added new, independent, mini-toolbars to the new circle/arc tool, curve
tool and extrusion tool. These mini-toolbars are independent from the main toolbar and
may be docked anywhere on your screen.
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•      Line Flip Tool: 3D Builder has added a “Line Flip” tool to the “Line” and
“Select” toolbars.  You can now change the direction of a line by using the “Line flip” tool,
thus eliminating the need to double click on the line to bring up the “Line Properties” box.
Now the direction of the line can be changed directly from the toolbar with a single click.
This is done after selecting the line.

• Zoom Feature to the 3D Preview Window: You can now zoom in and out while
previewing your 3D model created by 3D Builder. This is very helpful for checking the
accuracy of the 3D model.  It is also useful when making a presentation to a client or
customer.  While running the 3D Preview window, clicking on the “+” key will magnify the
image in the 3D preview window.  Clicking on the “-”key will shrink the image in the 3D
Preview window.

• Polyline Tool: Additional points on the curve (or circle)  may be added by using the
new “Polyline Tool”.  The “Polyline Tool” adds a special kind of point when you create a line
or a polygon that ends or begins on a curve (or a circle).  To access the “Polyline” tool, select
the “Line” tool.  The “Line” tool mini-toolbar buttons appear on your screen.  If you have
already created a curve and you draw (or create) a polygon or a line, then a special kind of
point is created.  This special point is “tied” or connected to the curve (or circle). This special
point is displayed as a “circle” point rather than as the other types of points which are
displayed as a  “square”.  If you edit the curve, then the polyline point will also be moved.
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TO 3D BUILDERTO 3D BUILDER
Even If You Don’t Read Anything Else, Read This Section.”

The goal of using 3D Builder is to export a 3D model.  By using photos, 3D Builder
allows you to take advantage of the rich pool of colors, textures and measurement
information within the photos.  Other methods of  building 3D models of real world
existing objects take a lot of time, require a lot of measurements, and can be quite
frustrating.  3D Builder helps you synthesize all of the information and does all the
calculations needed to produce a  3D model.

Choosing Images
Take pictures of an object that you need to model. For suggestions for taking better
photos, please refer to the chapter entitled “Photo Tips for Improved Accuracy” near the
end of this user’s guide.  Have the pictures scanned from a 35mm camera, use a digital
camera, video camera or use Photo CD. 3D Builder recommends starting  with a photo
taken of the object from a reasonable distance and from an angle.
3D Builder also recommends starting  with a photo in which any reference targets or
“natural” X, Y, Z cues are visibly showing.

Add The Images To The Project           
Create a 3D BUILDER project and add the image files to it.  Load the images by
selecting  “File/ Add image to the Project” or select “Photo” under the “Insert/Photo”
menu or by clicking once on the “Insert Photo” toolbar button.  The first image added is
displayed in an image window.  This image window displays both a thumbnail and a
portion of the full image.  The additional images are added to your  project, but are not
displayed on your screen.  To display additional images, use the “Window/New

   
 Insert
 Photo
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Window” command after the images have been added to the project with the “Insert
Photo” command.

Figure 1 An image displayed in the main work area

Enter Camera Information If Known
If you know the camera used to take the photos, then select it from the drop down list in
the upper right corner of the image window.  If the camera does not appear in the list,
use the “Insert/Camera Lens” menu  to define the camera and lens. A “Camera
Wizard” will guide you through a series of questions to help you with the camera and
lens information.  Camera lens usage and other information about the image may be
accessed from the “Image Properties” pop-up window.  Single click with the right
mouse button in an open area of the image, then select “Properties” from the pop-up
menu.  Select “Camera Lens” tab page. Or double click with the right mouse button in
an open area of the image.

Note:  3D Builder gives you a lot of flexibility.  You may start
with any image you choose, in any order that you choose.
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Use Tools To Locate Reference Targets, And Coordinate Axes, If
Any

Look for any reference targets or “natural” X, Y, or Z cues in the photo.
Place points on any reference  targets by using the “Point Tool”.  Place lines on any
“natural” X, Y, or Z cues in the photos.  Add additional points on obvious places in the
photo, such as corners or key features.

Construction Hint Lines
For each image you must provide two pairs of coordinate axis lines, or at least coordinate
axis hint lines (ie,  2  “X” lines and  2 “Y” lines, or 2 “X” lines and  2 “Z” lines, etc.).
  3D Builder uses these to get a rough location and orientation of the camera.
If you are using an object like a building that already has several natural cues, it will be
easy.

Figure 2  You need to identify 2 pairs of coordinate axis lines in your photo

Otherwise, use whatever you have available, such as using trees as rough estimates for
verticals.  If all else fails, just “eyeball it” and try to imagine where the “X”, “Y”, or “Z”
axis lines would appear.  This is a must.

    
    Point
    Tool

     
    Line Tool
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Figure 3  Using construction lines for "Z" and "X" coordinate axes lines

3D Builder deals predominantly with points.  You will need to locate points to build your
model.  Many objects, such as buildings have natural features so that points are readily
visible in the images without any special markings before taking photographs. Other
objects, such as curved smooth surfaces, lack natural features.  You will need to prepare
these before the photo shoot by putting some form of marking on them.
If you are trying to build a accurate model, then you should carefully place a small
number of reference targets in the scene, and carefully measure the distance between
these reference points.  You will input these measured distances into the program by
constructing lines between the points and setting the measured lengths of the lines.

Figure 4 Construction "Hint" lines using measured reference targets
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Tie Reference Points Together In Multiple Images
Identify which reference points in each picture correspond to points in other pictures,
using the “Merge Tool”, which may be accessed via the “Merge Tool icon” on the
Toolbar or via the “Draw/Merge”  command.

Group Images Taken From Same Camera Station
If more than one picture was taken from the same camera location, you need to tell
3D Builder.  Use the “View” menu, select the “Properties” command or click with the
right mouse button in an empty portion of your screen.  Select “Properties” from the pop-
up menu.  The “Image Properties” window will appear.
 Select the “Station Location” tab and change the station number to be the same as the
station number from which the other image(s) were taken.

Note:  There is always one point that is known, the 0,0,0 point.
You may choose any point and declare it to be 0,0,0.  3D Builder
recommends, however,  that this 0,0,0 point be in a visible “key
feature” place, (such as a bottom corner of a building) and that the
0,0,0 point be visible in 2 images.

Note: You may need to use the “View/Pan” tool on the toolbar
to place images in a favorable position to be able to see key

reference points in both images.  Tool Icon Pan Tool 

   
Merge Tool
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Figure 5  "Camera Station" dialog box, from the "Station" tab page, "Image
Properties"

Initial Calculations Of Camera Stations
Choose the “File/Calculate 3D” menu or click once on the “Calc” button on the toolbar.
Or click on the “F3” key on the keyboard.  This action begins the 3D Builder calculation
process.  A  “Calculate Dialog Box” appears on the main window and a progress reporter
indicates the percentage of progress.  When finished, 3D Builder gives you the number
of points and cameras calculated as well as any points or cameras that were unreachable.
3D Builder also gives you suggestions as to how to improve the accuracy of any points or
cameras unreachable.  For further details on these accuracy suggestions, please refer to
Chapter 12  and Appendix A near the end of this user’s guide.

   
 Calc 3D tool
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Figure 6  "Calculate  3D" dialog box, showing error messages

Note: You may edit any point or line at any time by choosing
the “Select” tool  from the toolbar menu and double clicking
on the point or on the line. Or right mouse button click to
select the point and/or line.  The “Point” Properties tabbed
page appears and the point may be edited directly from there.
If a line has been selected, the “Line” Dialog Box appears
and the line may be edited directly from there.

Also note:  3D Builder puts the calculated view directly on
the photo, so you can check the accuracy.  Select “As
Calculated” under the “View” menu to see the 3D Builder
calculated model.  Select “As Input” under the “View” menu
to see the project as you placed it.

Remember to return to the “As Inputed” view before
doing any additional work on the project, including any
editing work to improve accuracy.

  Select Tool
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Use Tools To Create Objects
Using the 3D Builder tools, locate points, lines, circles, curves, extrusions, and/or faces
of interest in the object just as you did for the reference targets or axes coordinates above.

Tie object points together in multiple images. Identify which points in each picture
correspond to points in other pictures, using the “Merge Tool”, which may be accessed
via the “Merge Tool” on the Toolbar or via the “Draw/Merge” command menu”.
Repeat the merging process for all points common to both images.

Calculate Object 3D Geometry
As above for the initial calculations of the reference targets, have 3D Builder calculate
the 3D geometry by clicking on the “Calc” button on the Toolbar or by using the shortcut
key “F3”. The Calculate process may also be accessed via clicking on the “File/Calculate
3D” menu command.

Export the Model To A Rendering Package
 To export your project files to a rendering package, choose “File/Export”  menu
command.  This action brings up the “Export Options” window.  Select the name and
file format in which  you would like the project exported.  Click once on the “OK” button
to accept the data as entered.  If you want the textures of the model to be exported,
remember to export them as well as the model.  Your 3D model is now ready to be
imported into your rendering package.  Open your rendering package and use the
“Import” method your rendering package recommends to bring up the 3D Builder
project.

Note: 3D Builder recommends you save your
active data often. Choose “Save” under the “File”
menu.  This action saves all active data in your
project to your hard disk.

Calc 3D
tool

Save Tool

       Merge
        Tool

NOTE:  3D Builder gives you the flexibility to choose points in either
image, in any order.  As long as you “merge” the same point in both images,
3D Builder will do the rest.  Merging points will be easier if you use the
View Filter Tool to turn off the display of points that have already been
merged.  Select the “View Filter” option by clicking on the “View Filter” tool
icon (an eye shape) or click on the “View” menu and select “Filter”.
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Measurements And Natural Cues

3D Builder needs to determine where the cameras were that took your pictures and
how they were oriented. You can help this by recording some information as the pictures
are taken.  The more information the better, but 3D Builder can still produce a quality
3D model with only a small amount of  data. For further information and a  sample of the
3D Builder “Field Notes Forms”, please refer to Appendix B.

There are six kinds of data that 3D Builder can use:
• Measured “X”, “Y” and/or “Z” coordinates of target points in the

scene.
• Measured distances between target points, not necessarily along 

coordinate axes.
• Measured “X”, “Y” and/or “Z” coordinates of the camera stations.

Camera height(“Z”) is often easy to measure.
• Coordinate axis direction lines.
• Camera format.
• Camera lens focal length.

Mixing  many possible combinations of the above items is possible and will still produce
a successful 3D model.  The following are a few of the most often used combinations of
data:

Known Camera Height And Two Coordinate Axis Pairs

If natural x, y, and/or z coordinate axes are available in the scene,  then the only
measurement needed is the camera height.  You will also need to arbitrarily choose one
point in the scene as the 0,0,0 origin, although 3D Builder will do this for you in a
number of cases.

Figure 7 Known Camera Height
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Two Pairs Of Coordinate Axes

In order to locate and orient the camera, 3D Builder needs either three known widely spaced
non-colinear points, or two widely spaced known points and some lines along the world x, y,
and/or z axes.   If natural cues are available,  the latter case is the easiest to use.  One point
can always arbitrarily be chosen as the origin.  If scale is not important, then an axial line
from the origin point can arbitrarily be assigned a length.  This is the “no measurements at
all” case when using 3D Builder.

Figure 8 Two Pairs of Coordinate Axes
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One Known Point And Two Known Lengths

  Instead of  typing in “x”, “y” and/or “z” coordinates for three measured coordinates,  you
may use one known point and set the length of two axial lines connected to it:

Figure 9 One Known Point, Two Known Lengths

Three Known Points
You can always just type in three known points, of course:

Figure 10 Three Known Points
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Known Lengths Between Three Points
Another way of getting three known points is to have measured distances between three
points.  Again, you would arbitrarily pick one point as 0,0,0.  Also arbitrarily assign one
of the lines to a coordinate axis and put the other lines in that plane (“XY”, “YZ”,
“ZX”).

Figure 11 Known Lengths

3D Builder offers a lot of flexibility. You are not limited to a certain method, nor are you
required to “go” in a certain order.  You may find that certain combinations seem more
natural for you.
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LICENSE AUTHORIZATIONLICENSE AUTHORIZATION

This chapter includes basic information about the 3D Builder license authorization
procedures.  It will provide an overview of the 3D Builder license wizards.

License Instructions

3D Builder for Windows is licensed to an individual machine.  After installing the
program you will need to license it by faxing or Emailing (preferred) information to 3D
Construction Company.   If 3D Builder has not been licensed it will display the License
Wizard when it starts up (see below).  The License Wizard will guide you through a
series of  questions and will prepare a form to be faxed or Emailed (preferred) .  3D
Construction Company will then send you a password which unlocks the program.

Chapter
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Key Points
• 3D Builder is licensed to an individual machine and to a specific location on a

machine.
• 3D Builder automatically defaults to running in a demo mode.  Using the demo

mode, you can run the tutorials and learn about 3D Builder’s program tools and
features, but you are limited to working with the supplied tutorial image files.

• 3D Builder can be turned on for a free 30 day trial period or it can be turned on
for full unrestricted time use.  Select the type of license for the product you
purchased.  If you have already paid for the product, you have purchased an
unrestricted time period license.  Once you select the “unrestricted” mode, there

 is no refund of purchase price.
 

 
 Figure 12 License Wizard showing Time Periods

• To activate the program for either a 30 day trial evaluation or for full
unrestricted use:

1. Run the License wizard (under Tools/License menu).  The License
Wizard will lead you through a series of short questions.



3D Builder License Authorization 39

 

 Figure 13 License Wizard Screen showing the "finish" button.

 When you click on  the “Finish” button, a new window appears which will
assign you a “Machine ID number”.  This number will be requested for the license
authorization form.

2.  Fax or Email (preferred)  3D Construction Company the information
form provided by the License Wizard to receive your authorization code.

Email:threedc@usit.net
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 Figure 14 License Wizard Screen showing the "MachineID" location.

3.  Enter the authorization code you receive in the License Wizard .  This
action will activate the program.

  4.Click on the “Install” button.  A message will pop up indicating that the
licensing system was successful.  A second message box will appear, asking you is
you want to “Install another password? Yes  No”.  Click on “No.”

5.  Start 3D Builder program by double clicking on the 3D Builder icon.
 

• If you choose the 30 day trial option, you have 30 days of free evaluation of 3D
Builder.  If you decide you do not want the product, return the product to us. Call for an
RMA number.  We will be disappointed, but we will credit the invoice or return your
money.  Please note that we cannot refund the shipping costs and we cannot take a 3D
Builder return after it has been authorized for unrestricted use.  We encourage people to
begin with the 30 day free trial evaluation mode.

Thank you for purchasing 3D Builder.  We look on your purchase as an opportunity
to be of meaningful assistance to your company, and as past experience has shown, we
take this opportunity seriously.  We look forward to hearing from you.

⇒⇒
Email:threedc@usit.net
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STARTING A PROJECTSTARTING A PROJECT

This chapter includes basic information about the 3D Builder environment.  It will
provide an overview of the 3D Builder windows and it discuses how to:

• The 3D Builder Environment
• Use the Image Window
• Use the Project Window
• Use the 3D Preview Window
• Navigate between windows
• Set the display of the toolbar and status bar
• Keyboard Accelerators
• Save the contents of windows
• Close windows
• Exit 3D Builder

 Chapter
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The 3D Builder Environment
When you first open 3D Builder the main  menu bar, the tool bar, the status bar, and one
empty image window  appear.

Figure 15  3D BUILDER Opening Screen

From the main  menu bar, you can choose commands that will allow  you to manage
projects, create geometry, and work with  3D Builder.  Commands for creating geometry
are described in the chapters on “Menus and  Constraints”.

The buttons in the tool bar represent the frequently used menu commands.  You can use
the tool bar as a shortcut for choosing commands from the menus.  When you pass the
cursor over the tool buttons, a short tool tip appears and the corresponding command is
displayed in the status bar.

The main screen work area is blank when you first open the program.  It is the space
where photo images are displayed and where you will create your model.  The work area
can display any number of photo image windows.  If you are using the 3D Builder Pro
program, the maximum number of image windows that can be open at the same time is
determined by how much memory your machine has.  3D Builder PowerLite is limited
to six images.

Status Bar

Tool Bar

Menu Bar

Main Screen
Work Area
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Begin a New Project
To begin a new project, select “New Project” from the “File” menu. Next, you will be
asked the “Type of Project” you wish to begin. The default is the “Normal Project”.

Figure 16 "New Project" Window

Next, you will  need to select the images for your project. Click on “Add Images to
Project” from the “File” menu.  This will access a file requestor box from which you can
select your images, drives, directories, etc.   To view each additional image selected (after
the first image), you will need to create a “New Window” for the image. This is done by
selecting “New Window” from the “Window” menu.

The Image Window
The images in a project first appear in the main window in an “Image” window.  This
gives a thumbnail image of the entire photo, and a close-up view of a section of the
image.  The size of the thumbnail  can be adjusted by placing the mouse cursor over the
“splitter bar”.  Click once with the left mouse button, and drag the window to the desired
height.  Click-drag-release with the left mouse button in the thumbnail to define the
portion of the image to be displayed in the main close-up view.  All geometry creation is
done in the main close-up view.
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Figure 17  Splitter Bar in Image Window

The Project Window
The Project Window gives an overview of all the things in your project.  The window is

brought up with the “Window/Project” menu command or by clicking on the “Project
Window” toolbar icon button.   You can have only one project window open at a time.
The main topic headings are: camera lenses, materials, objects, camera stations, texture
maps, constraints, stations, and photos that  are in the project.  Clicking on the “+”

button to the left of the topic will expand the list to show the individual items.  Double
clicking  on an item will bring up its property window, from which the item may be
edited.  Single clicking on an item selects it.  Object and constraint items will be
highlighted in any open image windows when they are selected in the project window.
You may delete items selected in the project window with the “Delete” key on the
keyboard.

Splitter Bar

Project
Window

⇒⇒
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Figure 18  Project Tree, accessed by selecting "Window" menu, then choosing "Project"

The 3D Preview Window
Once the 3D model has been calculated (under the “File/Calculated 3D Preview” menu
command, it can be viewed through the “3D Preview Window”.  Click on the “Window”
menu and select “3D Preview” to bring up the 3D Preview Window. Or click on the “3D
Preview” tool icon on the toolbar. Or click on the shortcut key, “F4” from your keyboard.
This can be rotated and viewed from any  angle. The 3D Previewing window can be
resized. The smaller the window, the faster the rotation.  You can zoom in on the 3D
model by clicking on the “+” key or zoom out by clicking on the “_”.  The 3D model can
be viewed in either a wireframe mode and/ or a rendered, shaded mode.  Choose the
viewing mode by clicking on the “View/Solid” or “View/Wireframe” menu items.  The
background color of the 3D Preview window can also be adjusted for optimum viewing.
Choose the background color by clicking on the “View/Background Color” menu.
Note:  Be sure to check either solid or wireframe or both in order to view the model.
Also, if wireframe is checked, the wireframe image will be in white. Be sure your
background color is not white or you will not see the wireframe image.

3D Preview
Tool
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Figure 19  3D Preview Window

Navigating Between Opened Windows
The names of all open windows appear at the bottom of the “Windows” menu in the
main menu bar.  To make a window active, select any open 3D Builder window by
clicking in it.  Selecting a window brings it to the top of the window stack and makes  it
active.

     

Figure 20  Activate an Image Window by the "Window" menu, select the desired image by clicking on it.

Setting the Display of the ToolBar
The toolbar shows icons on frequently used 3D Builder actions. To set  a visible display
of the toolbar, select “Toolbar” under the “View” menu.  A “check mark” will appear to
the left of the word “Toolbar”.  To remove the tool bar from visible view, select
“Toolbar” under the “View” menu.  The check mark is removed.  The toolbar is no
longer visible near the top of  the main project window.
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Figure 21  Visible Toolbar & Status Bar

Setting The Display Of The Status Bar
The status bar displays information about the selected item.  To set a visible display of
the status bar, select “Status Bar” under the “View” menu.  A check mark will appear to
the left of the word “Status Bar”.  To remove the status bar from visible view, select
“Status Bar” under the “View” menu. The check mark is removed.  The Status Bar is no
longer visible at the bottom of your main program window.

Keyboard Accelerators
Several keyboard accelerator or “shortcut” keys are available for the power user.  Using
these keys minimizes the time needed for mode switching.  The keyboard accelerator
keys are listed  in the drop down menu boxes to the right of the menu item.  Please refer
to the Appendix C section for a complete list of keyboard accelerators.

Saving A Project
To save a project in  3D Builder, select “Save” under the “File” menu.  This action saves
the project to your hard disk.  To save the contents under a specific name or directory,
select “Save As” under the “File” menu.  This action brings up the “Save As Dialog   

Save Tool
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Box” and you may choose the file name and directory in which the contents of the active
window are to be saved.

Exiting 3D Builder
To leave the 3D Builder program, select “Exit” under the “File” menu.  If the file
contains any unsaved information,  3D Builder displays a confirmation message asking
you if you want to save changes.

Figure 22 Confirmation Message Box

Camera Lens Data File
The “Camera lens data” is stored in a separate file called “lens.dat”.   If you have added,
modified or deleted camera lenses during the session, you will also be prompted to write
these changes out to the camera lens data file. 3D Builder now prompts before saving
new/modified camera lenses to the master lens.dat file.  Similarly, if lenses are deleted
from a project, 3D Builder will prompt asking if they should be deleted from the master
lens.dat file.  This dialog box will also appear if a project was opened which contained
camera lenses that were not in the master lens.dat file.

Figure 23 Message Confirmation Box for "lens.dat" file.

Material Data File
 A similar message box appears if a new material has been added to the project.
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          3D Builder  Menus

MENUSMENUS

3D Builder uses a standard Windows application interface.  Each menu item is activated
by clicking on it.

File Menu Commands

The file menu lets you manage project files. A 3D Builder project is a list of image files
and a collection of geometry. You can create, open, and save project files. You can
choose to have 3D Builder perform calculations on your project.   In addition, you can
choose to have 3D Builder export to a rendering package.

Figure 24  "File" Menu Commands

File/ New Project (CTRL +N)
The “New Project” command closes the current project window and creates a  new
empty project. 3D Builder has changed the title on the “New” menu. These items now

 Chapter
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include the word “project”. Thus, “File menu/ New” now reads “New project”. The
word “Project” was added for clarity.

File/ Open Project (CTRL + O)
The “Open Project” command opens the file requester box for you to access a previously
saved project file.  You may choose directories, drives, networks, and file names. 3D
Builder has changed the title on the “Open”  menu. These items now include the word
“Project”. Thus,  “File menu/Open” now read “Open project”. The word “Project” was
added for clarity.

Figure 25  File Open Project Requester Box

File/ Close Project
The “Close Project” command closes the active project.  If the project contains unsaved
information, 3D Builder will display a confirmation message box.  When the
confirmation message box appears, choose:

• • “Yes” to save changes
• • “No” to discard the changes
• • “Cancel” disregards the “Close Project” command.
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Figure 26  Close Project Command Dialog Box

File/ Save Project (CRTL +S)
The “Save” command saves the active project, using the current name. 3D
Builder has changed the title on the “save” menu. These items now include the
word “project”. Thus, “File menu/Save” now reads “Save project”. The word

“Project”                                     was added for clarity.

File/ Save Project As (    ....)
The “Save Project  As” command saves the active project using a new name. To “Save
Project As” a file, Open the “File” menu and choose  “Save Project As” to display the
file requester box.  Select a drive, and then select a directory.  Next, choose a file type,
then enter the name of the file. Click “OK” to save the file.

Figure 27  "Save Project As" File Requester Box

File/ Add image to Project  (INS)
3D Builder has added a file menu item for adding an image to the project.

You may also add an image to the project via the “Insert menu/insert image”.
The keyboard  shortcut for this command is the “Insert” key on the keyboard.
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File/ Calculate 3D (F3)
The “Calculate” commands  takes the points, lines, curves, circles, extrusions,  and faces

that you have located and the various hints that you have supplied and calculates the
position of the cameras, camera information,  and the 3D model for the objects.  3D
Builder does the complicated math  for you and figures the “x”, “y”, and “z”

coordinates.

3D Builder gives you a one “beep” signal when the initial estimate of the 3D model has
finished.  At this time, clicking on “Stop” will show you a 3D model.  3D Builder gives
a second “beep” signal when 3DBuilder has completely finished calculating the 3D
model.  Greater accuracy is achieved by waiting until the second beep signal.

A progress reporter box shows you what is happening as 3D Builder converts your
photos to 3D models.  The dialog box will show the number of points calculated and the
number of points unreachable.  The dialog box will also show the number of cameras
positions calculated and the number of cameras unreachable. Once the camera positions
have been located and a 3D model has been calculated, 3D Builder  reverses the
calculations and projects the model back onto each of the image planes. After the
“Calculate 3D” dialog box has been closed, you may view these results by selecting the
“View” menu, “As Calculated” option or by hitting the “U” key on the keyboard.  Be
sure to return to “Input” mode to continue working. If faces have been set, you can view
them in the “3D Preview” window, accessed via the “Window “ menu.

Figure 28  "Calculate 3D" Dialog Box

The average difference between the location of the calculated points on the image and the
location of the points that you placed  on the image is displayed as a %.

If problems are found during the calculations, the dialog box will expand.  It will drop
down to show a picture of the image (s) where there is a problem and a brief description
of the problem.
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Figure 29 "Calculate 3D" Dialog Box expanded to show problem image

See “Appendix A”  for a description of various types of problems and how to fix them
The most common problem is that one or more points were not located because they were
visible in only one image and /or have no other hints available.  This problem may be
suppressed  by leaving the “Report unlocated points” check box blank. If you put a check
in this box and one or more points have not been located, the dialog box will expand
down and will indicate which images contain the points that were not located.

File/ Export…
The “Export…”  command allows you to export the files to a rendering,  animation,
Internet, CAD package.  You will need to do a “Calculate 3D” before selecting the
“Export…” command.

Figure 30  Export Menu Commands
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Clicking on the “Export” command under the “File” menu opens up the “Export
Options” window allowing you to choose the export format, file name, and which objects
to export.

Figure 31  Export Options Dialog Box

In the Section labeled format, choose the type of file format to be exported.  Simply click
on the radio box to the left of the desired format. 3D Builder can export files using the
following formats:

1.  DXF (used by many CAD systems)(Both Pro and PowerLite)
2.  3D Studio  (3D Builder PRO Only)
3.  IGES (used by many mechanical CAD systems) (3D Builder Pro

Only)
4.  Inventor (3D Builder Pro Only)
5.  VRML 1(used directly on the Internet) (Both Pro and PowerLite)
6.  VRML 2 (used directly on the Internet) (Both Pro and PowerLite)
7.  Wavefront. (3D Builder Pro Only)
8.  .STL (used by many rapid prototyping machines)

 (3D Builder Pro Only)

 
• Under “File name”, type in the file name, directory and drive or click on the button

labeled “Browse”.  This action will open up a standard Windows browser to select
drive, directory and file name.
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• Under “Objects”, choose the objects you would like to have exported.  Make sure that
at least one object is checked.  The default object is “unnamed-1”.

If there are any problems associated with exporting the desired file format, these will be
reported to you on the “Problems” tab section of the Export File Tab Page.

Figure 32  Export Problems Reporter

Perspective Correction for Texture Maps
By default, 3D Builder applies perspective correction to the 3D Preview window and

to all exported 3D models.  This improves the visual quality of the 3D models but does
increase their size.  You may choose a lower quality perspective correction or you may
turn off perspective correction altogether.  The option is selected from the “Options” tab
in the “Export” window, which is activated from the “File/Export” menu.  The options
are:
• no correction
• fast, but crude correction
• slow, but accurate perspective correction  (Pro version only)
If you want to change the perspective correction for the 3D Preview window but do not
need to do an export, use the “File/Export” menu command, set the option, then select
“Cancel” from the Export window—the perspective correction option will be
remembered even though Cancel has been selected.
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Figure 33 File export "Options" for perspective correction.

Texture maps are also exported with the files and these are automatically corrected for
perspective distortions. Automatic Correction for perspective is available in 3D Builder
Pro only.

3D Studio, Inventor, VRML, and Wavefront export files will include references to texture
maps if the objects are textures.  That is the export files will have the texture file name
embedded in the file in one or more places, and perspective corrected texture coordinates
will be contained in the file.  You will need to copy the texture map images that you have
previously created with the “Draw” texture map command, copy them to whatever
directory is required by whatever rendering tool package (3D Studio, VRML browser,
etc.)

File Export…/ Camera Viewpoints tab

A second tab has been added to the “File/Export” options tab page.  The “Camera
Viewpoints” tab gives you the option of exporting camera viewpoints into such rendering
packages as Inventor Studio.  The camera viewpoints exports are available for Inventor
and VRML file exports.
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Figure 34 Export Camera Viewpoints Options Box.

File/ Exit
The “Exit” command closes 3D Builder. If the file contains unsaved changes, 3D
Builder display a confirmation message asking you if you want to save changes.

• Yes saves changes before closing 3D Builder.
• No discards changes and closes 3D Builder.
• Cancel discards the “Exit” command.

Figure 35  Exit Command Confirmation Requester Box

Camera Lens Data File

3D Builder now prompts before saving new/modified camera lenses to the master
lens.dat file.  Similarly, if lenses are deleted from a project, 3D Builder will prompt
asking if they should be deleted from the master lens.dat file.  This dialog box will also
appear if a project was opened which contained camera lenses that were not in the master
lens.dat file.

Figure 36 Message Confirmation Box for "lens.dat" file.



3D Builder Menus 60

Material Data File
A similar message box appears if you have added a new  material to the project.

Edit Menu commands

The commands in the Edit menu let you perform editing operations on any selected item,
such as points, lines, and faces.  Other Edit menu commands let you perform editing
operations on materials, properties, and objects.

Figure 37  Edit Menu Commands

Editing an Individual Item
Before you can edit, the item must be selected. Clicking  once on the individual item will
highlight the points, circle, curve, lines and/or faces.  Double clicking on the individual

item will bring up a dialog box which tells you about the individual item to be edited.

You may also edit from the “Project Window”, accessed by the “Window” menu,
selecting “Project” or by clicking on the “Project Window” toolbar icon button.  This

will open the project tree. Clicking  once on the individual item will expand the tree
branch. Select the desired item.  This will highlight the individual item.  Double clicking
on the item in the project tree will bring up a dialog box which tells you about it.

Project
Window
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Edit/ Delete (DEL)
The “Delete” command removes the currently highlighted items from the project. The
keyboard  shortcut for this command is the “Delete” key on the keyboard.

Edit/ Properties…
The “Properties” command allow you to edit the properties of a selected item.  If you
have a single item selected, you may use the Edit menu command “Properties” to bring
up the “Properties” window for that point, curve, circle, extrusion, line, and/or face.

Figure 38 Edit menu "Properties" command, shown editing a selected "X" line

Edit/ Material Properties…
The “Material Properties” command allow you to edit the properties of a selected
face material.  This action will bring up the “Properties” window for the material
type associated with the selected face. You can also access the “Materials” window
by selecting the face, “right-mouse clicking” in an area of the face, then selecting
“Materials”.
You can also edit a “material” from the “Project” tree accessed from the “Window”
menu by selecting “Project”, then clicking on  the “+” sign by “Materials” to expand
the “Materials” tree branch.  Double click on the desired item to edit it.

Project
Window
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Figure 39  Edit "Material Properties" dialog box, showing selected face materials
being edited

Edit/ Object Properties…
The “Object Properties” command allow you to edit the properties of a selected object.
This action will bring up the “Properties” window for the selected object. You can also
access the “Object Materials” window by selecting the object, “right-mouse click” in an
area of the object , then selecting “Object Materials…”. You can also edit a “object”
from the “Project” tree accessed from the Window menu by selecting “Project”, then
clicking on  the “+” sign by “Objects” to expand the “Objects” tree branch.  Double click
on the desired item to edit it.

Figure 40 Edit "Object Properties" shown here editing selected object
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Edit/ Select
The “Select” command is the default cursor. Use the select command to locate and select
anything.  If you have a picture where you have more than one line to select, you may
multiple select by holding down the “shift key” and selecting the lines.  Go to the
individual “Axis Plane” toolbar icon buttons  at the top right of the main 3D Builder
window and select the correct axis.  All selected lines will now change to the selected
axis.  You can also multi-select points, lines, or faces, or a combination.

Edit/ Select All
Choose “Select All” from the “Edit” menu to pick all objects in the active image.  When
all objects are selected, they can be worked on as a group.

Draw Menu Commands

The Draw menu contains commands to create the 3D geometry.

Figure 41  Draw Menu Commands

Note:  If you select all and you hit the “Delete” key, you
will delete all items.
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Draw/ Point (P )
The “Point”  command is used to place points on the image.  Clicking on the point tool
will bring up the point tool icons on the toolbar and allows you to select from different
types of point types.  You may also use the “P” shortcut key to access this command.
Use the point tool  to place points on the image. When the point tool is chosen, the cursor
changes to a small square. Each time the mouse is clicked in a image, a new point is
created.   The location of the point is at the center of the small square. Be sure to use the
merge tool or “same point” tool later to tell the program which points are really the same.
The toolbar changes when the “Point Tool” is chosen by clicking  on it.  New tool icons
appear on the lower part of the toolbar. These point icons give you a chance to choose
among the different kinds of points to be drawn on the image.

• • Single Point Tool Icon: This is used to create a new point in one
image.  This icon is the default icon and is the same as the point tool.

-------------------------------------------------------------------------------------------
• • Same Point Tool Icon: This is used to create a point in one image that
already exists in another image.

-------------------------------------------------------------------------------------------
• • Point Pair Tool Icon: This tool is used to create the same point in two
images.

-------------------------------------------------------------------------------------------
• • Grid Point Tool Icon: This tool is used to create a grid.

The “Grid Point” tool will be grayed out unless you have previously created a grid
with the “Insert” Grid menu command. The Grid Tool window will then pop up .  If  you
have created more than one grid you may choose the appropriate grid from the list.  A
picture of the grid will then appear.  The cursor will create a point in the image on the
grid corresponding  to the red highlighted point showing in the grid window.  Before
locating a point in the image, click on the grid point from in the grid point tool.

Cursor

Create Point
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Figure 42  Grid Point dialog box

-----------------------------------------------------------------------------------------------------

• • Approximate Point Tool Icon: This is used to create a new point in
one image which is an approximate location.

-----------------------------------------------------------------------------------------------------
• • Object and Material Drop Down List Box  Icon: These list boxes are

grayed out because a point does not have an object or a material
assigned to it.

Draw/ Line (L )
The line tool , which appears as a straight line between two small squares on the toolbar,
is used to create a straight segment at any angle. You may also use the “L” shortcut key
to access this command. Use the line tool to draw a segment from one endpoint to
another.  The “Line”  command changes the cursor to draw a connected line from two
points. The cursor rubber bands following the mouse actions. The Line command has an
automatic “snap-to” feature. If the cursor is near an existing point, the line will start at
that point.  Otherwise a new point is created at the start of the line.  The same is true for
the end point of the line.

 Clicking on the line tool will bring up the line tool icons on the toolbar and allows you
to select from different types of line configurations.
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• • Skew Line Tool Icon: This is used to create a new line in one image
that does not lie along an coordinate axis plane or along one of the
horizontal or vertical coordinate axes.  This icon is the default icon.

  
  --------------------------------------------------------------------------------------

• • X Line Tool Icon: This is used to create a new line in one image that
does lie along the “X” coordinate axis line.

  
  ---------------------------------------------------------------------------------------

• • Y Line Tool Icon: This is used to create a new line in one image that is
lying along the “Y” coordinate axis line.

         
 -----------------------------------------------------------------------------------

• • Z Line Tool Icon: This is used to create a new line in one image that is
lying along the “Z” coordinate axis line.

         
 --------------------------------------------------------------------------------------------

• • XY Line Tool Icon: This is used to create a new line in one image that
is lying along the “XY” coordinate axes plane.

         
 --------------------------------------------------------------------------------------------

• • YZ Line Tool Icon: This is used to create a new line in one image that
is lying along the “YZ” coordinate axes plane.

         
 --------------------------------------------------------------------------------------------

• • ZX Line Tool Icon: This is used to create a new line in one image that
does lie along the “ZX” coordinate axis.
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 --------------------------------------------------------------------------------------------
• • ?Axis Line Tool Icon: This is used to create a new line in one image

that lies APPROXIMATELY along a coordinate axis or coordinate
axis plane.  This is used to give a “Help” to the program in cases where
an obstruction may hinder the actual sighting of the line or where a line
is nearly “axial” (but is not “axial”).

                     ------------------------------------------------------------------------------------------
• • Axis Plane List Box: This is used to visibly indicate that a new line in

one image lies along a coordinate axis or coordinate axis plane. The
default is in the “skew” position. The list box will change if you select a
different axis plane.

--------------------------------------------------------------------------------------------

When the LINE tool is selected, the cursor changes to a symbol for a line.  A line tool
dialog box appears in the main window. If you know that the line that you are  going to
create is vertical or horizontal along one of the coordinate axes, then select the
appropriate line type tool icon button.  The same is true if you know that the line lies in
one of the principle coordinate planes. Otherwise leave the line type as SKEW. Position
the cursor arrow over the starting  point for the line, then press the mouse button down.
The message "Move to end of line then release button” will be displayed in the Status Bar
at the bottom of your screen.  Move the cursor over the ending point, holding the mouse
button down.  As you move the cursor a line will be rubber-banded on the screen from the
starting point.  Release the mouse button when the cursor is over the desired end point

Draw / Line: Polyline Tool for Multiple Lines
A special kind of line has been added to 3D Builder to link lines together. You can
draw the line, click the left mouse button, and draw the next line.  3D Builder keeps
drawing lines on the image for you. This will save time in the 3D modeling process.

Draw / Line: Point on a Curve or Circle

Under the special circumstances involving drawing a line or a polygon that ends or
begins on a curve or a circle, 3D Builder now uses the “Point on a Curve or Circle” tool.
If you have already created a circle or a curve, and you draw (or create) a polygon or a

Cursor

Create
Line

Cursor

Create
Line
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line, then a special kind of point is created.  This special point is “tied” or connected to
the curve (or circle). This special point is displayed as a “circle” point rather than as the
other types of points which are displayed as a  “square”.

Figure 43  “Point on a Curve or Circle ”point  shown as a special "circle" point.  Note regular points
above and to the right of  the curve.  The dark box has been added for emphasis in this manual and
does not appear on your screen.

Draw /Free-form curve (B )
3D Builder has added a file menu item for drawing  free form curves or Bezier spline
curves. You may also use the “B” shortcut key to access this command. Use the “Curve”
tool to draw an open or closed Bezier spline curve in one or more images.  This tool is
explained in greater detail in the chapter on “Curves” later in this “User’s Manual”.

Draw /Circle/Arc (C )
3D Builder has added a file menu item for drawing circles and circular arcs. You may
also use the “C” shortcut key to access this command. Use the circle tool to draw an
open or closed circles in one or more images.  This tool is explained in greater detail in
the chapter on “Circles and Arcs” later in this “User’s Manual”.

Draw/ Polygon (F)
 The polygon tool appears as a series of short line segments between small squares. The
polygon tool creates faces on the image. You may also use the “F” shortcut key to access
this command. In order to “texture” an object, you must first use the “polygon” or
“face” tool to create a face(s) on the object. You may create a polygon by placing points
in either a clockwise or counterclockwise direction.  Just remember not to create polygon
points in a criss-cross or “bowtie” fashion.  Clicking on the polygon tool will bring up the
polygon tool icons on the toolbar and allows you to select from different types of polygon
configurations:
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• • 3 Point Polygon Tool Icon: A 3-point polygon is the default
box button. Use this if you want to place a polygon face consisting of three points in
the image.

  
  ------------------------------------------------------------------------------------

• • 4 Point Polygon Tool Icon: Use the four point polygon tool if
you want to place a polygon face consisting of four points that do not make a
rectangle in the image.

  
  ------------------------------------------------------------------------------------

• • 4 Point Polygon RECTANGLE Tool Icon: Use the four
point polygon tool if you want to place a polygon face consisting of four points that
do make a rectangle in the image.

  
  ------------------------------------------------------------------------------------

• Many Point Polygon tool icon:  Select this tool icon button
if you want to place a polygon face consisting of more than four points.

                                                        
-------------------------------------------------------------------------------------------
Polygon Plane Tool Icons: Use this if you want to identify an axis plane in

the polygon. The “Skew” plane is the default.

  
  ------------------------------------------------------------------------------------

      Polygon Object and Material Tool Drop Down List Boxes :  A polygon
can be assigned to an object  and it can have a material assigned to it.  Use these
drop down boxes to assign either an object or a material to the polygon at the time of
its creation. A “Blank” box is the default position.
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  ------------------------------------------------------------------------------------

When the polygon tool is selected, the cursor changes to a symbol
    for a polygon.  The display of "Select first point" appears  in the status bar
    1st Click:   If cursor is near a point, highlight the point and change
                 the status message to "Select second point".

    2nd Click:   If cursor is near a point, highlight the point and change
                 the status message to "Select third point".

    3rd Click: See if there is a point near the cursor.  If so, create a
               new face connecting the three points.
The process would be expanded to include the number of points selected for the polygon,
(four or more).  When you are doing a many point polygon, the last point must “close
the loop” and must be your first point again.

Draw /Extrusion (E )
3D Builder has added a file menu item for drawing extrusions of already created
lines and faces. You may also use the “E” shortcut key to access this command. Use
the line tool to extrude lines and faces that you have previously created.  This tool

is explained in greater detail in the chapter on “Extrusions”, later in this “User’s
Manual”.

Draw/ Merge (M)
The "Merge" command ties two points together and indicates that the two points
are the same in both images. You may also use the “M” shortcut key to access this
command. If you do not already have two image windows open,  the message area

will ask you to do so.  When there are two images visible, the message area in the status
bar will display the message "SELECT FIRST POINT".  Click on a point in one of the
images. The point you have selected will highlight and the message will change to

Cursors

   
lst Point
Cursor

   
2nd Point
Cursor

3rd point
Cursor

Point
Number
Cursor
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NOTE:  If you place a point in error,  click on the BACKSPACE key and this
will delete the previous point.  Then continue with the point placement of the
polygon.
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"SELECT THIS POINT IN ANOTHER IMAGE".  Click on the same point in another
image.  This process merges the two points together.

Semi-Automatic Point Matching
In order for 3D Builder to locate each camera station, you will need to locate one or two
known points and tie together a small number of points common to each image.  These
first points are tied together using the “Point Merge” tool as described in  the User’s
Guide (Menus Chapter).  Once you have done this you should use the “File/Calculate
3D” menu command to get 3D Builder to locate the camera stations and points.

Once the camera stations have been calculated, the “Point Merge” tool switches to
“semi-automatic” mode.  In this mode you can rapidly tie together the remainder of the
points in your model.  With two or more pictures visible on the screen, you select a point
in one picture.  The other pictures are zoomed in on the most likely candidate points to
match the selected point. This eliminates having to “roam” around the other photos,
looking for the correct area.   Other points that have not been merged together will still
appear on the second photo, but they will be drawn as small dots.  You will still be able to
choose which point you want to merge, but 3D Builder will offer its best choices for you
by automatically making its choices appear in a larger size. 3D Builder will not
automatically choose the point  for you.  You will still need to choose the point to be
merged by clicking once on it.   But this feature will save you time and prevent modeling
errors.

Figure 44  Semi-Automatic Point Matching Wizard.

Draw/ Pick Color

Cursor

   
Pick Color
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Use this command to pickup colors from images and assign them to the current material.
Choosing "Pick Color" from the "Draw" menu will bring up the "Pick Color Dialog Box"
and allow you to set the colors of materials to be used. The "Pick Color Dialog Box" may
also be accessed by clicking on the "Pick Color" icon (which looks like an eye dropper)
on the toolbar ribbon. More information on this topic is available in the chapter on
“Colors, Materials and Texture Mapping”, later in this “User’s Manual”.  Since a
“color” is associated with a “Material” and a “Material” belongs to a “face or polygon”,
the “Pick Color” menu item will be “grayed out” unless a “face” has been previously
selected.

Figure 45  Draw menu "Pick Color" dialog box

Materials have different properties of colors:
• Ambient
• Diffuse
• Specular
• All

A window pops up which displays the colors of the currently selected material and lets
you choose which properties, or all properties, to pickup from an image.  “All” is the
default radio box and appears in the “selected” position.

To assign colors to a different material, select the material from the “Material List” on
the toolbar. This is the drop down list box at the upper right of your screen.

To assign colors to a new material, use the “Insert” menu, select “Material” command.

Setting the colors of a material from an image window.
Colors for that material may be lifted from one of the images using the “Draw” menu,
“Pick Color or by using the “Eye Dropper” icon from the toolbar.  The cursor changes to
an “Eyedropper” cursor and is used to pick a color directly from the image.
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Draw/ Texture Map
Use this command to choose the texture pattern for a section of the project. This tool is
accessed by clicking on the "Texture Pattern" under the “Draw” menu or by clicking
directly on the "Texture Pattern" icon on the toolbar ribbon. Then draw a bounding box
rectangle encompassing the area to be textured.

Creating texture maps with the “Texture Map Tool”.  See additional information
in the Chapter on “Colors, Materials and Texture Mapping” in this  “Users Guide”

1. From the Draw menu command, choose “Texture Map”.
2. From the “Materials” list, choose a material from the drop down list box.
3. Click, drag and release to form a rectangle encompassing the portion of the

image that is wanted for the texture map.
4. This brings up the “Texture Map” dialog box.
5. Set the desired pixel size from the spin control arrows.
6. Hit “OK” to save it as a  .JPEG and as a .BMP file.

Figure 46 Draw "Texture Map", creating the bounding box around the area to be textured

Once the textured area has been drawn, the "Texture Map Dialog Box" will appear
on your screen.  This dialog box allows the user to give information concerning the
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texture patterns for the image and type of file format in which to save the image. 

Figure 47  Draw "Texture Map" dialog box, shown after drawing area to be
textured

Make Menu Commands

The “Make” menu commands are used to apply constraints to currently selected points,
lines, and/or faces.  The “Make Behind” is not actually a constraint.  This command is
used to “make” or put one face behind another.  Constraints are relationships that help in
the “Calculate” process.  Constraints are used to help the appearance of the model.  A
constraint acts as a “helper” to the “Calculate 3D” command.

Figure 48  "Make" menu commands
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Constraints do not go into effect until you hit the “Calc” tool  or “F3” shortcut key or
“Calculate 3D” under the “File” menu.  The program will then attempt to “satisfy” every
constraint in the model.  3D BUILDER gives you the option of several constraints.

Constraints are all created in the same manner.  Once constrained, each constraint will
appear in the “Project Window”.  A single click will highlight your constraint.  Double
clicking on the “constraint” will take you to a dialog box about  the selected constraint.

Constraints may be deleted from the “Project Window”.

Make/ Make Colinear
Colinear means lying in the same line.  If several points and/or lines lie along the
imaginary extension of a single line, then you should select these and use the “Make
Colinear” constraint to force the calculate command to snap these lines and/or points to
all lie along a single extended line in space. To declare that a point is colinear with other
points and/or lines, do the following:

1.    Select a point by clicking on it.  The point will highlight.
2.    Next, while holding down the “Shift” key, select the other points and/or
lines which lie along the same line.  These will also highlight.
3.    Choose the “Make” menu, then select “Colinear”.
4.    The result of this action is that all of the selected (highlighted) points
and/or lines will be constrained to be colinear to one another.
5.  If you were to edit one of these points by double clicking on it to bring
up the “Point Dialog Box”, a check box would be checked indicating that
the point is colinear to others.
6.  If you have any dimensions, this information can be entered by double
clicking on the “constraint” branch in the “Project” window.  This action
brings up the “Colinear Constraint” dialog box.

Following is an example of this constraint.
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Figure 49 Make "Colinear" command showing 2 "X" lines constrained to be colinear

The “Make Colinear” command can also be accessed via the toolbar ribbon icon.

Make/ Make CoPlanar
CoPlanar means lying in the same plane.  To declare that a point/ and or faces is
coplanar with other points and/or faces, do the following:

1.    Select a point by clicking on it.  The point will highlight.
2.    Next, while holding down the “Shift” key, select the other points of
faces which share the same plane.  These will also highlight.
3.    Choose the “Make” menu, then select “Coplanar”.
4.  The result of this action is that all of the selected (highlighted) points

and faces will be constrained to be coplanar to one another.
5.  If you were to edit one of these points or faces by double clicking on it

to bring up the “Properties Window”, a check box would be checked
indicating that the point or face is coplanar to others.

6.  If you know what plane in which the points lie, or any dimensions, this
information can be entered by double clicking on the “constraint”
branch in the “Project” window.  This action brings up the “Coplanar
constraint” dialog box.

Coplanar “Y” line   ⇒
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Figure 50  Points and Faces Constrained to be CoPlanar

The “Make CoPlanar” command can also be accessed via the toolbar ribbon icon.

Make/ Make Equal Length
To declare that a line is the same length as one or other lines, do the following:

1.    Select the line by clicking on it.  The line will highlight.
2.    Next, while holding down the “Shift” key, select the other line (or
lines) which share the same length.  These additional lines will also
highlight.
3.    Choose the “Make” menu, then select “Equal Length” by clicking on
it.
4.    The result of this action is that all of the selected (highlighted) lines are
now constrained to be of equal length to one another.
5.  If you were to edit one of these lines by double clicking on it to bring up
the “Line Dialog Box”, a check box would be checked indicating that the
line is of equal length to others.
6.  If you have any dimensions, this information can be entered by double
clicking on the “constraint” branch in the “Project” window.  This action
brings up the “Equal Length Constraint” dialog box.

The “Make Equal Length” command can also be accessed via the toolbar ribbon icon.

Coplanar “Y” line   ⇒
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Make/ Make Parallel
 Parallel means going in the same direction at the same distance apart.  To declare that a
line is parallel to another line, do the following:

1.     Select the line  by clicking on it.  The line will highlight.
2.    Next, while holding down the “Shift” key, select the other lines which
are parallel.  These additional lines will also highlight.
3.     Choose the “Make” menu, then select “Parallel” by clicking on it.
4.    The result of this action is that all of the selected (highlighted) lines are
now parallel to one another.
5.  If you were to edit one of these lines by double clicking on it to bring up
the “Line Dialog Box”, a checkbox would be checked indicating that the
line is parallel to others.
6.  If you have any dimensions, this information can be entered by double
clicking on the “constraint” branch in the “Project” window.  This action
brings up the “Parallel Constraint” dialog box.

The “Make Parallel” command can also be accessed via the toolbar ribbon icon.

Make menu/ Make Perpendicular
3D Builder has added a file menu item for indicating that two or more lines are
perpendicular to each other  It is accessed  by selecting the “Make Menu” and clicking on
“Make Perpendicular” menu command.

1. Select the line by clicking on it.  The line will highlight.
 2.    Next, while holding down the “Shift” key, select the other lines (or

lines) which you want to make perpendicular to the first.
        3.    These additional lines will also highlight.
        4.    Choose the “Make” menu, then select “Perpendicular” by clicking on

it.
        5.    The result of this action is that all of the selected lines are

perpendicular.
        6.     If you were to edit one of these lines by double clicking on it to bring

up the    “Properties” window, a check box would be check indicating that
the line is perpendicular to others.

This tool is explained in greater detail in the chapter on “Constraints”.

Make/ Make Behind (Behind/In Front Of Command)
Use this command to change the position of the active area on the main screen.  This tool
will be grayed out unless a face is selected.  This tool takes the currently selected face and
forces it to draw itself behind all other faces.  For example, you had created a face for a
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window. Later, you created a face for the entire wall.  Because the wall was created later,
it would obscure the window section.  Use of this tool would put the wall “back” a level
and thus make the window visible on top.

Click once to highlight the desired face.  Then choose the “Make Behind” toolbar icon
from the toolbar ribbon or select the “Make” menu, choosing “Behind”.  This action
moves the currently active layer back one layer.

Constraint Project Tree:
 All constraints can be viewed from the “Project Window”.  The “Project
Window” can be accessed by clicking on the “Project Window” tool icon
on the toolbar.  Click once on “Constraints” to expand the tree.  Clicking

once on the individual constraint will highlight the points, lines and/or faces constrained.
Double clicking on the constraint in the project tree will bring up a dialog box which tells
you about the constraint.

View Menu Commands

The “View” menu commands control the “view” windows (image view and 3D preview).
Use these commands to select which portion of an image or 3D space is displayed in the
window, and/or to select which types of objects are displayed.
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Figure 51  View
Menu Commands

View/ Tool Bar
The “Tool Bar” command opens and closes the toolbar ribbon of tool icons. Using the
tools icons is a faster method of accessing the tools. To set  a visible display of the
toolbar, select “Toolbar” under the “View” menu.  A check mark will appear to the left
of the word “Toolbar”.  To remove the tool bar from visible view, select “Toolbar”
under the “View” menu.  The check mark is removed.  The toolbar is no longer visible
near the top of  the main project window. The toolbar may be docked to the left side of
the screen, the right side of the screen or may be “floated” on the screen.  The toolbar
may be displayed as icons, text, or both.  For a more detailed explanation of the toolbar
command, please refer to the “Toolbar” reference section later in the user’s manual.



3D Builder Menus 81

View/ Status Bar
The “Status Bar” command opens and closes the Status Bar. The Status Bar features a
hint line for displaying help on many items, such as tools and commands. This
information appears on your screen when you pass the mouse pointer over an item on the
screen. To set a visible display of the status bar, select “Status Bar” under the “View”
menu.  A check mark will appear to the left of the word “Status Bar”.  To remove the
status bar from visible view, select “Status Bar” under the “View” menu. The check
mark is removed.  The Status Bar is no longer visible at the bottom of your main program
window.

View/ As Input (I )
The “As Input” command is a toggle switch which gives you an opportunity to add any
information about an image that you may choose, such as the creation of points, lines or
faces.  A “bullet” to the left of the words “As Input” indicates that the data is visible in
the image as you drew it. To set a visible display of the “As Input” menu, click once on
“As Input” menu.  A “bullet” will appear to the left of the word “As Input”.  To switch
out of input mode and into “As Calculated” mode, select “As Calculated”. The “bullet”
is removed.  The mode has now switched to the “As Calculated” mode.  If your “Status
Bar” is visible, you can verify which mode you are in by checking for the words “As
Input” or “As Calc” on the “Status Bar”. The keyboard shortcut key for the “View As
Input” image is the “I” key on your keyboard.

View/ As Calculated (U )
The “As Calculated” command is also a toggle switch which gives you a view of the
image as the program has last calculated it.  A “bullet” to the left of the words “As
Calculated” indicates that the data is visible in the image as 3D BUILDER calculated it.
To set a visible display of the “As Calculated” menu, click once on “As Calculated”
menu.  A “bullet” will appear to the left of the word “As Calculated”  To switch out of
calculated  mode and into “As Input” mode, select “As Input”. The “bullet” is removed.
The mode has now switched to the “As Input” mode. If your “Status Bar” is visible, you
can verify which mode you are in by checking for the words “As Input” or “As Calc” on
the “Status Bar”. The keyboard shortcut key for the “View As Calculated” image is the
“U” key on your keyboard.

Note:  You must be in the “As Input” mode to edit any
points, lines, and/or faces.
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View/ Select Image  (F2)
 The “Select Image” command allows you to select an image for display in the active
“Image Window”.  Clicking on the “image list” tool will bring up the “Select Image”
dialog box  displaying the name and  thumbnail pictures of each image photo in the
active        project.   Clicking on a photo image will display that photo in the “Image
Window.  The “Image list” dialog box also gives the file name of the image, and the
drive and directory of where the image is being stored on your hard drive. The image
itself is not affected by using this tool. The “Select Image” Dialog Box may be closed
using the “Close” caption bar. It may also be resized or move about your screen as any
other dialog box in 3D Builder.  Clicking on the “Image List” tool icon also activates
this tool from the toolbar ribbon of icons. The keyboard shortcut key for the “Select
Image”  is the “F2” key on your keyboard.

View/“Next” Image (> )
Use the “View/Next Image” when you want to quickly review your project and see the
next image.  The keyboard shortcut key for the “Next” image is the “>” on your
keyboard.

View/“Prior” Image (< )
Use the “View/Prior Image” when you want to quickly review your project and see the
prior image. Similarly, the keyboard shortcut key for quickly viewing the “Prior” Image
is the  “<” key on your keyboard.

View/ The Pan Tool (N)
The pan tool, which  appears as a hand, is used to scroll the image.  The image may be
scrolled both vertically and horizontally at the same time. The keyboard shortcut key for
the “View/Pan” tool is the “N” key on your keyboard.

View/ Zoom (Z)
The “Zoom” command allows you to magnify  the entire image for closer examination.
The keyboard shortcut key for the “View/Zoom” image is the “Z” key on your keyboard.

View/ Zoom In (+ )
The “Zoom In” command allows you to magnify an area for closer examination. The
keyboard shortcut key for the “View/Zoom In” image is the “+” key on your keyboard.
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View/ Zoom Out (- )
The “Zoom Out” command allows you to “step” back from the image, as if from a
greater distance. The keyboard shortcut key for the “View/Zoom Out” image is the “-”
key on your keyboard.

Placing Points Outside an Image
There are times when you need to draw a line or face that extends beyond the border of
an image.  To do this, use the “View/Zoom Out” menu command or toolbar button to get
sufficient white space around the image.  Then draw your point or line or face. The
point(s) drawn outside the image border will automatically marked as approximate.

Figure 52  Viewing Points Outside the Image.

View/All (A )
To view an entire image select the “View/All” menu command.  This will fit the image
to the current window.  3D Builder has added a file menu shortcut key “A” for viewing
all the images in a project.

View/ Properties… (D )
Use the “Properties” command to view  and edit information about the camera lens, the
camera station locations and the properties of the active image. The keyboard shortcut

è
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key for the “View Properties” of the image is the “D” key on your keyboard. Clicking on
the View menu, “Properties” command opens the “Image Properties” tab page.
The “Properties” command  tabbed page, gives you the options of the following:

• Camera Lens
• Station Location
• Image Properties

 The first tab page is the “Camera Lens” dialog box, which allows you to give
information relating to the type of camera and the lens focal length.  It will also show the
“Calculated focal lens length” by 3D Builder. If you want to create a new camera lens,
click on the “New…” button to the right of  the “Camera Lens” drop down box.  This
action brings up the “Camera Lens Properties” dialog box, allowing you to give
information concerning the new camera.

Fi
gure 53
View
Properties,
Image
Properties
Camera
Lens Tab
Page

Clicking on
“New…”
camera button
brings up the "
Camera Lens
Properties"
dialog box,
allowing you
to give
information
relating to the

type of camera and the lens focal length.
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Figure 54  Insert Camera, "Camera Lens Properties" dialog box

 If you do not know the camera lens, you may estimate it by clicking once on the
"Estimate" box to the right of the words "Target Film Height and Width". This action
brings up the "Estimate Camera Target Size Dialog Box". The "Estimate Camera Lens
Dialog Box" allows you to give information about the following:

• Focal Length (in Millimeters)
• Distance of the camera from the screen.
• Visible Height shown on the screen when looking through the camera lens.
• Visible Width shown on the screen when looking through the camera lens.

Figure 55  Estimate Camera Target Size  dialog box
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In most cases, 3D Builder can estimate the camera focal lens for you.

The second tab page under View Image Properties is the “Station Location” tab page.
The "Station Location" tab page, allows you to give information relating to the camera
station number.  If you have any known information about the measured location of the
camera station, you can type in the “X”, “Y” and “Z” locations.  The camera height, or
“Z” location is often an easy measurement to record.  The “Station Location” tab page
will also show the “Calculated Camera location” by 3D Builder.

Figure 56 View Properties,  Image Properties "Station Location" tab page

If you want to create a new camera station location, click on the “New…” button to the
right of  the “Number” drop down box.  This action brings up the “Camera Station”
dialog box, allowing you to give information concerning the new camera station.

Figure 57 View Properties, Camera Station ,"New Camera Station"   dialog box
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Camera Target Point
3D Builder calculates the camera location and orientation for each photo in the project.  This
information may be used to set a rendering program, such as 3D Studio, to reproduce one or
more images in your project.  The coordinates of the camera location and of a point in the
direction that the camera is looking are available from the camera station tab of the image
properties window.  The image properties window is accessed from the “View/Properties”
menu or by “right mouse clicking” in an empty area of the image.

Figure 58 Camera Target Point.

Figure 59  Camera Station Location Tab Page.

The third tab of the View Image Properties page is the “Image” properties tab page.

Camera Target Point
è
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Figure 60  View Properties, Image Properties, "Image" tab page

This “Image” tab page allows you to give information about the following:

• Contrast/Brightness:  Use this tool to lighten, darken, or sharpen the contrast
of the image for optimum viewing.

• Invert to the Negative: Use this tool to “invert” the image properties (what was
black is now white). This tool may be used to improve or sharpen the contrast
for optimum viewing.

• Rotate: Use this tool to turn the image by 90 degree increments.  Clockwise is
the direction.  Each click will rotate the image 90 degrees clockwise.  This tool
may be used to improve viewing range.

 
• Photo CD Select Resolution Size Box:  Photo CD has five sizes of images. If

you are using Photo CD, this box will be active, giving you a choice of
resolutions for the images.  The default position for this drop down list box is
“grayed out” or inactive position.

• • Camera Orientation: Use this tool to tell the program the orientation of the
camera when the pictures were taken.
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• • Default: Use this tool if you want to revert back to the original settings of the
image.  Otherwise the changes you have made will be in effect after you click on
the “OK” button.

 
• Filter Edges: Use this tool to provide a more concentrated view of the edges of

an image, as shown:

 Figure 61Edge Detection Filter Shown.

View/  Filter…
The Filter can also be accessed via the “View Menu” on the menu.

By using  the “Filter”, you can choose which viewing options are to be visibly displayed
on the image.  For example, if you only want to see the “lines” which you have created on
the image, mark a check in the “lines” check box.  Turn off the “points” and “faces”
check boxes.  Only the “lines” are visibly displayed on the image.

Select the “View Filter” option by clicking on the “View Filter” tool icon(an eye shape)
or click on the “View” menu and select “Viewing Filter”.
The “Filter” menu determines whether points, lines, curves, and/or faces in your 3D
model are displayed on top of the images.

   
View Filter
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This action brings up the “Filter View” dialog box.  This dialog box is a series of check
boxes which are explained in greater detail below the image of the “View Filter” dialog

box.

Figure 62  View Filter Dialog Box

Points: All created points will be visibly displayed on the image when this box is
checked.  The default position is in the “checked” position, showing all previously
created points.
Lines: All created lines will be visibly displayed on the image when this box is
checked.  The default position is “ checked” position, showing all previously created
lines.
Curves: All created curves will be visibly displayed on the image when this box is
checked.  The default position is “ checked” position, showing all previously created
curves.
Faces: All created faces (polygons) will be visibly displayed  on the image when this
box is checked.  A polygon mesh is  displayed on the image.  The default position is
to be “checked” position, showing all previously created  faces (polygons).
Axis Planes: Choose the axis planes which you want to be visibly displayed on the
image. This tool is useful in locating modeling errors, such as a “Y”  line that has
been marked with an “X” in error.

Only Show:
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Unlocated Points: Only the points or lines that have one or more coordinates that have
not been successfully calculated will be visibly displayed on the image when this box is
checked.

Locked: Only the points or lines  that have been indicated as “measured” will be visibly
displayed on the image when this box is checked.

Problems: If this box is checked, then only lines and faces which were flagged as having
problems in the last File/Calculate 3D command will be displayed.  This tool is very
helpful in finding and fixing modeling problems.

Note: Only one of these can be checked at one time.  Before closing the “Filter” box, turn
these back off.

3D Builder has added new, independent, mini-toolbars to control what you see on the
image.  You may now turn off the visible display of lines, points, curves, and/or faces
from the toolbar.  This mini-toolbar is independent from the main toolbar and may be
docked anywhere on your screen.  The ViewFilter mini-toolbar icon buttons let you
quickly select a choice of viewing only the points in the image, only the lines in the
image, only the curves in the image, or only the faces in the image.  Select by clicking
directly on the toolbar button icon.
The “Display mini-toolbars” determines whether points, lines, curves, and/or faces in
your 3D model are displayed on top of the images.

View/ Background Color
This is used to select a background color for the 3D Preview window to increase optimum
viewing of the calculated 3D model.

View /Solid
The “Solid” command is used to select a rendered, shaded mode for the 3D Preview
window to display the calculated 3D model.

View/ Wireframe
The “Wireframe” command is used to select a wireframe mode for the 3D Preview
window to display the calculated 3D model.
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Insert Menu Commands

Use the “Insert” menu commands to add to your project.

Figure 63  "Insert" Menu Commands

Insert/ Insert Photo… (Ins)
Using this menu command brings up the "Insert Photo" dialog box, allowing the user to
give information about the photo to be inserted into the 3D Builder project file. The
shortcut key for this tool is the “Insert” key on the keyboard.

You may also click on the “Add Image to the Project” toolbar icon button.

Figure 64  Insert Photo File Requestor Box

• Select the file name by clicking on it from the file list.
• Choose the type of file from the “List files of type” drop down list box.
• Choose the directory of your choice.
• Select the drive from the “drives” drop down list box.
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• If you were accessing the file from a network, you would click on the
“Network” button.  This would bring up the standard windows browser for files.

• To accept the currently selected item, click on  “OK”.
• To return to the main screen, click on “Cancel”.
• If you need to access the help engine, click on “Help”.

To display the photo, use “View” menu command  “Select image” from an existing
window or use the  “Window” menu command “New window” to bring up a new
window to display that photo in that window. Both of these commands can be accessed
via the toolbar ribbon icons.
3D Builder provides a set of components that can accept over 36 different file formats
into the program.  The following formats can be imported into 3D Builder:

TIFF JPEG PCX TGA DIB DCX
GIF GMP WMF PICT WPG EPS
KFX RLE LV CALS G3 G4
ATT CLP XWD IMG IFF SUN
XBM ICO ICA GX2 XPM ASCII
CUT BRK MAC MSP PSD PCD

3D Builder provides the key components to read Photo CD directly.  There is no need to
convert the files to another format

Insert/ Insert Object…
Using this command brings up the " Object" dialog box, allowing you to give information
relating to the object.

Select Image

New Window

Note: If you have an empty image window on your screen, the
photo will be displayed there. Otherwise the photo is added to
your project, but not immediately displayed on the screen
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Figure 65 Insert "Object" Dialog Box

The Object Dialog box allows the user to give information concerning the following:
• Name of the Object:  Each object must be assigned a unique name.  Type in

the name of the object if you are modeling several objects from one set of
photographs. “Unnamed-1” is the default name assigned.

• Parent Object: If you are planning to export the project files to a modeling
program that uses a hierarchy structure (knee-bone connected to thigh bone),
you may choose to have the named object be a child of some other object.  This
is declared by selecting the other object as the parent.

• A drop down list box is provided for you to choose the name of the parent object
if you are modeling several objects from one set of photographs.

• Export check box: A check box is provided for you to declare whether the
object is to be exported with the model.  In this way, you can “throw-away” any
background objects or other :reference target” aids that you may have used for
better accuracy of the model.

• • DXF layer: Objects can be tagged by layers.  DXF export has a type-in box
allowing you to assign a layer to the object.  Objects may be tagged by layers.

• Color/Texture Check Boxes: Materials may be assigned to the overall object
(default material) and to faces. If a material is assigned to a face it will override
the default material assigned to the object.

• Name of Material Box: Give the name of the material to be used or
Check box to use the "Face" for obtaining the color/texture.

• Area Calculations: Gives the calculated area of all the faces of the object.

Insert/ Insert Grid…
Using this menu command will bring up the “Insert Grid” dialog box which will allow
you to give information concerning the use of a grid in your project.  Grids are a type of
object and will show up in the “Project Window” under “Objects”.
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Figure 66  Grid dialog box

A grid is like any other object in that has a name, may be tagged for export, and may
optionally be assigned to a parent object.  All points on a grid object lie in a plane and
have a uniform spacing between each other.  The amounts of numbers of row and
columns on a grid have a maximum setting of 40 and the minimum is 1.

Use the “+” and “- “ buttons to set the rows and columns for the appropriate amount.  If
you know the spacing between the rows and columns for the grid, enter it under
measured spacing.  Otherwise, 3D Builder will calculate the spacing during the
“Calculate 3D” command.  If the grid spacing is accurately known, you should enter it as
grid spacing.  If the grid plane is parallel to one of the global coordinate planes, you
should select the plane from the global plane list.

If you need to change the settings on the grid alter you have created it, go to the
“Window” menu, select “Project”.  Expand the “objects” tree and you will see your grid
object there.  Double click on it and that action will bring you back to the same properties
window where you may change the grid properties. You may also access the “Project
Tree” by clicking on the  “Project” toolbar icon.

A picture of the grid will appear in the “Properties” window.

Insert/ Insert Material…
The Insert Material menu is accessed by selecting "Material" from the Insert menu.   Use
this menu command to define a new surface properties material.  This command brings
up the “Material” dialog box which allows you to give information about the following:

• Name of the Material
• Set the Ambient color from the Color Page
• Set the Diffuse color from the Color Page
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• Set the Specular color from the Color Page
• Work with the Texture Pattern

 The default settings are usually appropriate and do not need to be changed.
If you have a face created on the image, you can right mouse click on the face (this
highlights the face).  A list will appear on your screen.  Choose “Material Properties”.
This  action brings up the same “Materials” dialog box.

Figure 67  Insert "Material" dialog box

Creating a texture map from the photo.
1. From the “Insert” menu, choose “Material”.
2. From the “Materials Property Box”, give the material a name.
3. In the texture map section of the material box, choose “New”.
4. In the image, click, drag, release a rectangle encompassing the portion of the

image that is wanted for the texture map.
5. Give the texture a name and then click on “OK” to give the cropped texture file

a name and it is automatically saved it as a .BMP and a .JPG  file.

Insert Material Message Box
3D Builder has added a “safety” check when you “save” a project.  This additional

action is a “message box” which pops up at the “Exit” command to ask about adding a
material to the master “Material.dat” file.  This would occur after using the “Insert
Material” command, if you add a  new “non-textured” material, such as a blue color for a
water section of the model.  3D Builder comes with a small starter set of materials, but,
using the “Insert Material” command, you can add to the set of materials. The message
box is displayed as follows:
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Figure 68  Message Confirmation Box for "master materials" file.

Insert/ Insert Station…
Using this menu command will bring up the "Insert Camera Station" dialog box which
will allow you to give information concerning the addition of a camera station to the 3D
Builder project file.  If you wish to insert to station directly, use the “Insert Station”
command.  If any of the camera stations coordinates are known , they should be entered
into this dialog box.  Camera height is particularly easy to measure and could be input
here if known.

Figure 69  Insert "Camera Station" dialog box
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If you have selected “new camera station” for each image under the “Project settings” as
the default, new camera stations will be created automatically each time you insert a
photo.

Figure 70 Project Settings Camera Station default settings

After images have been assigned to the “camera station”, they will appear in the “Camera
Station Properties” window if it is brought up again.  When the “Camera Station
Properties” window appears for the first time from the “Insert Station” command, the list
of images will be empty.
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Figure 71  Camera Station Properties Window showing images assigned to camera station 1

Introduction to the Camera lens Wizard
In order to calculate a 3D model with any accuracy, 3D Builder needs some information
about the camera and lens combination used to take the pictures.  In order to simplify this
procedure, 3D Builder has created a new feature, the “Insert camera wizard”.  This
wizard will step you through a series of simple questions designed to calculate the focal
lens of the camera.

Insert/ Insert Camera Lens…
Using this command brings up the "Camera Lens Wizard”, allowing the user to give
information relating to the type of camera and the lens focal length.  This wizard will
guide you through a series of questions relating to your camera and help you determine
the best settings to use in 3D Builder.
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Figure 72  Insert Camera, "Camera Lens Wizard”.

Choose the type of camera that you are using for the project by clicking in the appropriate
radio box.  This action will activate the drop down list of camera types.  3D Builder has
already prepared  information on several of the leading camera  types.  If your camera is
not listed here, choose the selection labeled “other”.  Then click on the “Next” button.

In the unlikely event that you have a film camera type that does not appear on the list, a
window will appear asking for the film size (in millimeters).

Figure 73 Camera Name Screen.

Choose a name for your camera type by typing the information in the “camera name”
box. Then click on the “Next” button.
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Figure 74 "Zoom" Lens Screen.

Tell 3D Builder whether or not you are using a “Zoom” lens.  3D Builder will work
with zoom lenses, but you will need to zoom the lens all the way in (telephoto) or all the
way out (wide angle) lens, and treat these as if they were two separate lenses.

Click on the “Next” button to advance the wizard.

For film cameras, there will be just two more screens, one asking the lens focal length in
millimeters The second screen will ask what name you want to use for the camera lens.
We recommend names of the type camera/focal length, for example, “CanonAE/50mm”.

For digital cameras and video cameras, the following screens will appear:

Figure 75  Screen for the optics of digital and video  cameras.
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Most digital cameras use miniature sensors in the camera. These make the optics of the
digital camera smaller than the optics of a 35mm camera.  Most digital camera
manufacturers give an “equivalent” focal length of the lens rather than the “true optical”
focal length.  Professional video cameras will give actual focal lengths for lenses.
Consumer video cameras will vary in what information the manufacturer provides.  Click
on the “Next” button to advance the wizard to the next screen.

Figure 76  Screen for selecting option for focal length source.

You are now given a choice of selecting the source of your focal length.  If you choose the
“test images” option, your project will be saved and a “calibration” project will be opened
for you.
3D Builder strongly recommends this choice.  It is listed as the “default”.  This choice
involves taking two simple test pictures and then have 3D Builder calculate the focal
length of the lens for you rather than use the numbers provided by the manufacturer.
Your accuracy will be improved by taking the time to do this simple test.  The
approximate time to perform this test is 45 minutes. This does not include the time to set
up the project or the time to take the pictures and download them into the computer.

We will proceed through the Wizard using this option, then go back and pick up the
other two options and describe their actions.  Click on the “Next” button to advance the
wizard to the next screen.
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Figure 77  Screens showing positioning of targets.

Attach four targets to either the floor or the wall so that they form a precise rectangle.
The height and width of the rectangle do not have to be the same, but we recommend that
they differ by no more than 50%.   The rectangle should be large enough that the image
is in sharp focus.  We suggest at least 1 meter on each side.  Larger is better.  Take two
pictures of the “target square” from skew positions.
Click on the “Next” button to advance the wizard to the next screen.

Figure 78 Targets should form a rectangle for better accuracy.

The accuracy of the 3D model that you make with 3D Builder will be dependent on how
accurately your four targets form a “true rectangle”  An easy way to do this is to use a
tape measure.  Measure the side and the diagonal measurements.  Enter the height and
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width you will be using in the boxes labeled, “H”  and “W”. Click on the “Next” button
to advance the wizard to the next screen.

Figure 79 Pictures should be taken from skew angles.

Take the pictures from skew angles as shown in the figure above. Click on the “Next”
button to advance the wizard to the next screen.

Figure 80 Select the images for the calibration process.

Click on the “Add Image” button which will bring up a file requestor.  Select the images for
the calibration. Click on “Next” to advance the wizard.
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Figure 81 Locating the reference points in the image.

Locate the indicated point on each picture. Then click on “next” which will advance to
the next of the four points.  Locate each indicated point in each image.  Continue in this
manner until you have done all four points in all pictures.  Click on “next” to advance the
wizard.

Figure 82  Target Points identified.

Next 3D Builder will do the calculations for you to calibrate the lens focal length.
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Figure 83 3D Builder does the calculations for you.

Clicking on “Next” gives you an opportunity to name the camera lens.

If you did not elect to take the camera test pictures and do a camera calibration, 3D
Builder will ask you for the internal sensor size of your digital or video camera.
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If you have reliable manufacturer’s data on the sensor size, enter it in the sensor size
boxes. Otherwise, we strongly recommend using the test pictures, as described above. If
you are not willing to take the test pictures, or you do not have any other data, use “32”
millimeters wide and “24” millimeters high as the “equivalent” 35mm sensor size.  Click
on “next” to advance the wizard.

You will be asked to assign the camera lens a name. Then select “Finish” to create the
lens.
Your newly created lens will not actually be saved to the master “lens.dat” file until you
close the 3D Builder project.  At this point, you will be told that camera lenses have been
added or modified and your will be asked whether or not you want to save them.  Select
“Yes” to save the lens.

Editing A Camera Lens:

You can edit a camera lens at any time.  To edit a camera, open the “Project” window
using the “Window/Project” menu command or the “Project” window icon on the
toolbar.  Click on the “+” by the word “cameras”, and then double click on the desired
camera lens.  This action brings up the “Camera Lens Property window” as shown below:

Figure 84  Insert Camera, "Camera Lens Properties" dialog box
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Because of the widespread growth of digital cameras, 3D Builder has added a lot of
information concerning various types of digital cameras.  The camera lens combo box
now displays available camera types with known camera magnification and other
parameters.  Note that there is now a new entry for “Generic digital camera”. If you
know the camera lens that took the image, be sure to specify the camera lens in addition
to the type of camera.  If you do not know the camera lens that took the picture, try to at
least specify the type of camera.

When using a digital camera that is not already on the 3D Builder list of digital
cameras, type in the name of your digital camera in the “Name/Camera Lens” box.  Next,
fill in the camera focal length, and other information requested in the dialog box.  The
following dialog box shows the information fields completed for the “Canon PowerShot
350” digital camera.

Figure 85 Camera Lens Property Box, General Page.

On the next page is a list of some of the most widely used digital camera
information.
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Digital Camera Information Sheet

Name Focal
Length
mm

Target
(Film)
Height
mm

Target
(Film)
Width
mm

Image
Height
pixels

Image
Width
pixels

Canon PowerShot 350 6.0 3.860 5.140 480 640
Canon PowerShot 600/Normal 7.5 3.940 5.400 608 832
Canon PowerShot 600/Wide 4.2 3.940 5.400 608 832
Casio QV-100 5.8 3.860 5.140 480 640
Casio QV-300/Wide 6.6 3.860 5.140 480 640
Casio QV-300/Tele 15.0 3.860 5.140 480 640
Kodak DC-25 5.9 3.026 4.000 373 493
Kodak DC-50/Wide 7.0 4.528 6.792 504 756
Kodak DC-50/Tele 21.0 4.528 6.792 504 756
Kodak DC-120/Wide 7.0 4.974 6.632 960 1280
Kodak DC-120/Tele 21.0 4.974 6.632 960 1280
Konica Q-Mini 6.0 3.480 4.640 480 640
Minolta Dimage V/Wide 4.8 3.750 5.000 480 640
Minolta Dimage V/Tele 13.0 3.750 5.000 480 640
Olympus D-200L 5.0 3.750 5.000 480 640
Olympus D-300L 5.0 3.750 5.000 768 1024
Ricoh RDC-1/Wide 7.0 3.780 5.040 576 768
Ricoh RDC-1/Tele 21.0 3.780 5.040 576 768
Ricoh RDC-2/Wide 3.7 2.750 3.660 576 768
Ricoh RDC-2/Tele 5.6 2.750 3.660 576 768
Sony DCS-F1 4.8 3.675 4.900 480 640
Sony DKC-ID1/Wide 5.4 3.860 5.140 576 768
Sony DKC-ID1/Tele 65.7 3.860 5.140 576 768
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Tools Menu Commands

The “Tools” menu commands are used to make choices about preferences, such as
settings, licensing, calibration, and the editing of points.  The Project Settings command
sets up operating defaults for 3D Builder. This command displays the “Project Settings”
and allows you to choose the color, fonts, and other settings.

Figure 86  "Tools" menu commands

Tools/Verify Points…
Use the Verify Point Tool (Tools/Verify Points menu) to carefully fine tune each point.
Clicking on the “Verify Points” brings up the “Verify Points Wizard” which will help
you
determine which points need to be verified. Clicking on the “Verify Points” command
will launch the Wizard to cycle you through fine tuning the placement of each point or
set of points. This tool is especially useful in multiple photo projects to check for merging
point accuracy.  It can be used to help find modeling errors, especially in the “same
point” or “merging” of points in several images.

The wizard will cycle through either all the points in your project or just the
“unverified” points in your projects. An “unverified” point is a point that has not been
edited—or one that not been “fine tuned”.
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Figure 87 Verify Points Wizard.

The “Action” section of the first dialog box of the “Verify” Wizard is used to determine
whether you want to verify (fine tune) each point location in each image in your project
or whether you want to verify that each occurrence of the point in an image really
represents the same point (merged points) in additional images.  The default action is to
use the “Verify Point” wizard to fine tune each point location in each image of your
project.

The second section of the first dialog box in the “Verify Point” wizard gives a list of
images in your project.

The third section of the first dialog box in the “Verify Point” wizard is a check box
whose default is to only show points that have not been “verified” or fine tuned
previously.

The bottom section of the first dialog box in the “Verify Point” wizard gives you a choice
of four buttons: Back, Next, Cancel or Help.  Clicking on the “Next” button will begin
cycling of the wizard through the points of the first image in your project.

Action: Verify, fine tune point locations in  images
This is the  default action for the “Verify Points” wizard.  Use the “Verify Point” wizard
to fine tune each point location in each image of your project.
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As you edit or place each point, you are “verifying” that you want to place the point at a
certain location in the image.  Use the “up, right, down, or left” buttons to move the point
location.

Figure 88 Verify Points Wizard, fine-tuning of point locations.

The “Wizard” will cycle through all the points.  When finished, the “Finish” button will
replace the “Next’ button.  Clicking on the “Finish” button will close the “Verify Points”
Wizard.

Action: Verify occurrences  of the same point in pairs of images
Clicking in the other radio button of the first dialog box of the “Verify Points” wizard
will begin the wizard checking the points which you have identified as being “the same”
point  (merged) in pairs of images.
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Figure 89 Verify Points, Point Matching Screen.

The “Verify Points” wizard checks the points which you have identified as being “the
same” point  (merged) in pairs of images. The bottom section of the this dialog box in
the “Verify Point” wizard gives you a choice of four buttons: Back, Next, Cancel or Help.
Clicking on the “Next” button will begin cycling of the wizard through the points of the
first image in your project.

In between the two pairs of images, is a radio box section asking the question: “Same
point?” .  The default is “Yes”.  If the occurrence of the point is the “same point” in both
images, click on the “Next” button to continue the wizard.

 Use the buttons at the base of each image to zoom in  to magnify the image for better
viewing; zoom out  to gain a better perspective of the point location; or to edit the point
location for better accuracy.  Clicking on “Edit” will bring up the following dialog box to
fine tune or change the point location.

Figure 90 Point Properties Tab Page

The “Wizard” will cycle through all the points.  When finished, the “Finish” button will
replace the “Next’ button.  Clicking on the “Finish” button will close the “Verify Points”
Wizard.

Tools/ Settings…
Using this menu command brings up the "Project Settings" command which will allow
you to give information concerning choices about the project options such as:

• Color Settings
• Default camera settings and camera stations
• Toolbar
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The first tab page is the “Colors” settings which allows you to set choices of colors for
selected objects, points, and lines.  You can also set your choice of fonts.  To change a
color or font, click on the “Set…” button which is located on the right side of the tab
page.

Figure 91  Project Preferences for Setting Colors

Clicking on the “Set…” button will bring up the “Color” dialog box, with a palette of
custom colors from which you can choose.  When you finish adjusting the colors, choose
“OK” to apply the colors.

Figure 92  Setting Custom Colors for Project Preferences
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Tools/Settings/Line Weight…
3D Builder has added an option under “Colors” for weighing the size of a displayed line
and a displayed curve.  You may now choose either a single of double weight for the
display of the line.  This is to improve the visibility of the lines in curves.

Tools/Settings/Defaults…
The second tab page is the “Defaults” page, which allows you to set defaults for having a
new camera station added with each new image added to your project.  This page also
gives you a choice of setting a default camera type for your entire project.  Choose from a
drop down list of cameras.  There is also a checkbox for using an “odd size .JPEG texture
map” size.  This is necessary to work around a Netscape 3D bug.  When the check box is
in the checked position, an odd sized texture map is created.  If you experience difficulty
in your texture map using Inventor or Wavefront, be sure to “uncheck” this box as both
of these files expect an even number of pixels in the texture maps.

Figure 93  Project Preferences Setting Defaults

License
If 3D Builder has not been  fully licensed for unrestricted use, it will display the License
Wizard when it starts up.  The License Wizard will guide you through a series of
questions and will prepare a form to be faxed or Emailed (preferred).  3D Construction
Company will then send you an authorization code which unlocks the program.
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Figure 94 License Wizard Screen.

• 3D Builder is licensed to an individual machine and to a specific location on a
machine.

• 3D Builder automatically defaults to running in a “demo mode”.  Using the demo
mode, you can run the tutorials and learn about 3D Builder’s program tools and
features, but you are limited to working with the supplied tutorial image files.

• 3D Builder can be turned on for a free 30 day trial period or it can be turned on for
full unrestricted use.

To activate the program for either a 30 day trial evaluation or for full unrestricted use:
Run the License wizard (under Tools/License menu).  The License Wizard will lead you
through a series of short questions.
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 Figure 95 License Wizard showing the machine ID location.

When you click on  the “Finish” button, a new window appears which will assign you a
“Machine ID number”.  This number will be requested for the license authorization
form.
Fax or Email 3D Construction Company the information form provided by the License
Wizard to receive your authorization code.  Not all configurations of machine can print
the “License Wizard” file.  If yours can not print the license form correctly, you will need
to “copy and paste” to a text file and then print from the “text” file.

Calibrate Camera Lens
There is now a “Camera Calibration Wizard” to guide you through all the steps
required for calibrating the camera/lens combination.  This is done to help you determine
the camera focal length.  The Camera Calibration Wizard will “walk you through” the
steps.  The  “Calibrate Camera Lens” command begins the calibration process.
Calibration of the camera/lens needs to be done ONLY  ONCE.

 

 
 

Email:threedc@usit.net



3D Builder Menus 118

 Figure 96 Progress Reporter Box

 
• A progress reporter shows the percentage of calculations.
Click on “Finish” when the calculate calibration process is completed.
• Lastly, start the 3D Builder program and  open a project (File/Open menu) using
the camera/ lens settings that you have calibrated  When you click on “Calc 3d”
(File/Calc 3d menu), 3D Builder will use this new calibration data in making the 3D
model.  The results will be more accurate and well worth the time taken in calibrating the
camera lens.

Window Commands

The Windows commands indicate which windows are in your work space and how they
are arranged.  The Windows menu contains the following commands:

Figure 97  Window Menu Commands

Window/ New Window
The “New Window” command opens brings up a new image window.  “New Window”
creates a new image window and chooses a photo that is not being displayed to be
shown in the window.  To choose a different image to be displayed in the new window,
choose the “View” menu,  “Select image” command.  The “New Window” tool can also

be accessed via the toolbar ribbon icon.

Window/ Cascade
The “Cascade” command overlaps the open image windows diagonally in the creation
order.
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Window/ Tile
The “Tile” command spaces the screen with open image windows and adjusts sizing to
fit the available space in the window.

Window/ Arrange Icons
The “Arrange Icons” command spaces the icons evenly across the window.  If you have
collapsed several icons to miniatures (which is not recommended) the “arrange icon”
command will arrange them neatly across the bottom of the main screen area.

Window/ Split
If an image window is active, the Windows “Split” command attaches the splitter bar to
the mouse cursor.  You may use this instead of picking the splitter bar from the window.
When you do a left mouse button down, the window will be rearranged at the new splitter
bar location.

Figure 98  Windows "Split" command changes the cursor to control the splitter bar in the
active window

Window/ Project
The Project Window gives you an overview of  the objects in your
project.  This window displays tree listings of:
• cameras and camera lenses

• constraints
• materials
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• objects
• stations/photos
• texture maps

Click on the box with the “+” sign to expand each of these categories.  Double click on
any of the items or objects to bring up its property window. The Project window is the 3D
Builder "control center" for the project files.  It gives an overview, showing the files
contained in the project.  You can have only one project open at a time.

Figure 99  Project Tree with some tree branches expanded

The Project window shows a tree control system, with branches to view the following:
• Cameras/ lenses:  Gives a list of the cameras and lenses.  Click on the + sign to

expand the tree control level.
• • Constraints:  The constraint section  lists any geometric constraints.  If you

click on a constraint, the constrained points, lines, and/or faces will highlight in
any image views that are open.  Constraints will only appear in the project tree
if you have assigned them to any points, lines and/or faces.

• Materials: Gives a list of the materials identified in the project. Click on the +
sign to expand the tree control level.

• Objects: Gives a list of the objects identified in the project. Click on the + sign
to expand the tree control level.

• Stations/Photos:  Gives a list of the camera stations and individual photos
identified in the project. Click on the “+” sign to expand the tree control level.
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• • Texture Maps  Gives a list of the texture maps that have been applied to the project
faces.  The tree branch also lists the drive, directory, and file names of each texture
map. Click on the “+” sign to expand the tree control level.  Texture maps will only
appear in the project tree if you have assigned them to any faces.

Window/ 3D Preview Window (F4):
After calculating the 3D model, it can be viewed through the “3D Preview Window”.
Click on the “Window” menu and select “3D Preview”. Or you may click on the “3D
Preview” tool icon button on the toolbar.  The shortcut key for this command is “F4” on
the keyboard.  This action brings up the 3D View window and the 3D model appears in
the center.  This is a full 3D model which can be rotated and viewed from any angle. The
3D Previewing window can be resized.  Resizing the window smaller makes for a faster
rotation speed.  The background color of the 3D Preview window can be changed by
selecting the “View/Background Colors” menu command.  The 3D Preview window
can be changed to display a rendered, shaded 3D model by selecting the “View/Solid”
menu command.  The 3D Preview window can be changed to display a wireframe 3D
model by selecting the “View/Wireframe” menu command. The 3D Preview window
can also display both a rendered, shaded 3D model  and a wireframe by selecting both the
“View/Solid” menu command and the “View/Wireframe” menu commands.
Note: You need to have either “solid” or “wireframe” or both checked in order to see the
model. If using the “wireframe” mode only, be sure your background color is not white.

 
Figure 100  3D Preview Window

Note:  The images are listed under the “camera station”
branch of the tree.  Remember that if several images were
taken from the same camera location,  they should be
assigned to the same station (This is done from the
“Image Properties” window).
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3D Builder has added a warning message when you  have created more than 15 separate
textures.  The warning message says that it is “OK” to have more than 15 different
materials, but that only the first 15 will be displayed in the 3D Preview window.

Window/ Recent Files
The “Recent File” command displays a list of recently-opened files.  This command lets
you quickly access the most recently active files

Help Menu

Figure 101  Help Menu

The Help menu provides commands to assist you in using the on-line help. Help.  Help
information is also available about the dialog boxes in 3D Builder.  Clicking on the Help
button brings up the help information.  Context sensitive help information is also
available by clicking on the Help tool icon.  For more information about context sensitive
help, refer to the Toolbar section of this manual.

For information about using help, press F1 or choose How To Use Help From The Help
Menu.

Help/ Index
The “Index” command displays the table of contents for the on-line help.

Help menu/Tutorials
An addition to the File/Help command has been made.
3D Builder gives you several tutorials to help you up the learning curve  These tutorials
are launched from your Internet Browser.  Each tutorial is designed to be used together
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with 3D Builder in a hands-on learning session.  Click on the desired tutorial title from
the Help menu to launch the tutorial.  3D Builder recommends that you give the tutorials
approximately one-third of the screen space and run 3D Builder tutorial project on the
remaining two-thirds of the screen.  Do this by resizing your Internet Browser.

Figure 102 Help Tutorials.

Help menu/Show Tips for…
3D Builder has added a file menu item for “on screen, just-in-time” helpful tips for the
following:
• Show Tips for Circles
• Show Tips for Curves
• Show Tips for Extrusion

Each of these helpful tip sheets is explained in greater detail in the individual chapters on
circles, curves, and  extrusions.

Help/ About 3D Builder
The “About 3D Builder” command opens a dialog box containing the version number,
copyright materials and other information about 3D Construction Company.





          3D Builder  Toolbar

ToolBar

The toolbar provides easy access to 3D Builder’s main tools.

Figure 103  Toolbar Icons, shown here "docked" to the top of the screen

The numerous tools included in the 3D Builder toolbar are displayed above and each tool
is described in the following text. The toolbar consists of a series of icons.  Moving the
mouse pointer on top of an icon displays information about that icon. Clicking on the
icon makes it the active tool for your use.

 3D Builder for Windows has added and changed several of the toolbar icon buttons,
both in appearance and in behavior.  The layout is now optimized for 800 by 600 (or
larger) SVGA screens.  The 3D Builder program still runs on 640 by 480 VGA screens,
but there may need to be a rearrangement of the toolbars to best fit the individual screen.
Each toolbar is independent and can be docked in several areas on the screen.

Docking Toolbar:
3D Builder gives you the option of a docking or “movable” toolbar.  To change the
position of the toolbar, click once with the left mouse button on the toolbar and drag the
toolbar to either the side of the window, the top, or the bottom of the window. When you
release the mouse button, the toolbar stays “docked” to the side of the window or to the
bottom of the window.  This action allows you some flexibility in working with the
toolbar which provides shortcuts for the power user.

 Toolbar/  Selector Tool
The selector tool or pointer tool, which appears as an arrow on the toolbar, is a
commonly used tool in 3D Builder.  Use the selector tool  to select a point, line, or object
for editing.   

Select Tool

  Chapter

 7

NOTE: If points are difficult to select because they are
close together, use the “Zoom” option to enlarge the
image and then select .
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  Changes in Behavior of the Selector tool (Arrow tool)
The most important change is in the behavior of the “Selector” tool or the “Arrow” tool.
First, it displays in a larger size for easier visibility.  More importantly, however, is the
new “drag and drop” action for editing or moving a point to a new location.

To move a point, click once on the point to select it. Click again and continue holding the
left mouse button down, then drag the point to its new desired location.  There will be a
“rubber-band” action. The lines and faces will move also.
Note: This is a different clicking action than a “quick double clicking” action.
Note: Helpful hint: Turning off the visible display of faces will speed up the dragging
movement.

This action also applies to points that were used to define circles or curves.  The “special”
points on the circle will also be moved since they are connected to the circle or the curve.

Gone is the “drop down list” where you would change the “axis plane”. These are now
located on the toolbar, saving mouse clicks.  The axis plane of the selected object appears
in the “depressed” or “pushed in” position.  The axis hint icon is also located on the
toolbar for lines which were in question as to their axis plane. To change the axis plane,
choose the toolbar icon button of choice.

Note: You can also multiple select and change the axis plane of lines and faces.

Multiple Select:  To select more than one item in the image, hold down the shift key
while making additional selections.

Toolbar/  Point Tool
The point tool  appears as a small square on the toolbar.  Use the point tool  to place
points on the image. When the point tool is chosen, the cursor changes to a small square.
Each time the mouse is clicked in a image a new point is created.  The location of the
point is at the center of the small square.  Be sure to use the merge tool later to tell the
program which points are really the same.
The toolbar changes when the “Point Tool” is chosen by clicking on it.  New tool icons
appear on the lower part of the toolbar.  These point icons give you a chance to choose
among the different kinds of points to be drawn on the image.

• • Single Point Tool Icon: This is used to create a new point in one
image.  This icon is the default icon and is the same as the point tool.

   
Point Tool

Cursor

Point Tool
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-------------------------------------------------------------------------------------------
• • Same Point Tool Icon: This is used to create a point in one image that

already exists in another image.

-------------------------------------------------------------------------------------------
• • Point Pair Tool Icon: This tool is used to create the same point in two

images.

-------------------------------------------------------------------------------------------
• • Grid Point Tool Icon: This tool is used to create a grid.

The “Grid Point” tool will be grayed out unless you have previously created a grid
with the “Insert” Grid menu command. The Grid Tool window will then pop up .  If you
have created more than one grid, you may choose the appropriate grid from the list.  A
picture of the grid will then appear.  The cursor will create a point in the image on the
grid corresponding  to the red highlighted point showing in the grid window.  Before
locating a point in the image, click on the grid point from in the grid point tool.

Figure 104  Grid Point dialog box
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To Edit A Point
Click on the “Selector” tool icon, which looks like an arrow, from the toolbar ribbon
icon.  Double click on the desired point or right mouse button click.  This action brings
up the “Point” tab page.

Figure 105  Edit Point “General” Tab Page

The “General” tab page of “Edit” Point allows you to give information about the
following:
• Hint, approximate image location check box: This check box indicates whether the

point has been declared as an “approximate” position.  There are times when you
need to place a point in an image to connect lines or to complete a face, but the point
is obscured by something else in the image by something else, such as a bush.  You
need to mark points like this as “approximate” so that the 3D Builder solver will not
try to force an exact solution through these type points. Failure to mark the points as
“approximate” so can throw off the entire 3D model.

• Hidden Point: Objects that are created with the “Extrusion tool” will usually have
several points that are not really visible in the image because they are hidden by
other extruded faces.  3D Builder tags these points as “approximate” (see above) and
“hidden”.  Lines to these “hidden” points are shown in “dashed” form.  The purpose
for showing points like this, rather than just deleting them entirely, is so that you can
go to another image where the back side of the object is visible and use the “Same
Point tool” to tie the points together.  If 3D Builder has incorrectly marked the point
as “hidden”, you may click on the check box to clear the “flag”.

• Image Area: This area displays a small portion of the image, enlarged to zoom in on
a detailed area.

• Up, Down, Left, Right buttons: These buttons are used to “fine-tune” or to
reposition the point for a more exact location.
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• Verified check box: This check box indicates whether the point has been zoomed in
previously for editing or repositioning. It is designed to help you keep track of which
points you have already “fine-tuned”.

• Zoom In and Zoom Out buttons: Use these buttons to enlarge or shrink the area.
• Global Coordinates input boxes:  These boxes give you an opportunity to input any

known data about the point.  If you know or have measured any of the coordinates of
the point, type in the “X”, “Y” and/or “Z” locations.

• Coplanar constraint check box:  This is used to show if the point has been marked
as being coplanar with other points/faces.  This will be grayed out unless a constraint
has been applied.

• Colinear constraint:  This check box indicates whether the point has been
constrained to be colinear with other points/lines.  The default position for this check
box is in the grayed out position.

• On A Curve:  Use this check box to indicate that the point is located on  a curve.
 
The second tab of the “Point Properties” page is the “Object Local” tab.  This is used to
attach points to objects, and/or grids, and to optionally specify the “local” coordinates of
a point in the axis system of the object.

Figure 106  Edit Point Properties, "Object Local" dialog box

Since points may be shared a number of objects, a list of the objects in the projects
appears on the left, with a check mark by the ones in which the point is already assigned
(or attached to).  Clicking on one of the objects will bring up a display of the local
objects.

 For a grid object, this action brings up a picture of the grid, with a red highlighted box
for the point to which  the selected point corresponds. To change the grid location,
simply click on the appropriate grid spot.   If two grids intersect, this may also be used to
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assign a point to two or even three grids.  This would be used , for example, when a
vertical grid and a horizontal grid intersect and they have a common point, as shown in
the following example:

Figure 107  Edit Point, "Local Object" tab page, shown with two grids intersecting.

In the above described  case, you would select the other grid object and then click in the
grid picture on the grid point that corresponds to the grid. Other than grids, object local
coordinates are not presently used by 3D Builder.

Toolbar/  Merge Point Tool
The merge point tool appears on the toolbar  as two arrows with an equal sign between
them. The “Merge” command ties two points together and indicates that the two points
are the same in both images. If you do not already have two image windows open the
message area will ask you to do so.  When there are two images visible, the message area
in the status bar will display the message    "SELECT FIRST POINT".  Click on a point
in one of the images. The point you have selected will highlight and the  message will
change to "SELECT THIS POINT IN ANOTHER IMAGE".  Click on the same point in
another  image.  This process merges the two points together.

Merge Tool

Cursors

NOTE: These changes take effect immediately.  Cancel will not
undo these changes.  You will need to select the point and call it
back up to re-edit.
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Semi-Automatic Point Matching
In order for 3D Builder to locate each camera station you will need to locate one or two
known points and tie together a small number of points common to each image.  These
first points are tied together using the “Point Merge” tool as described in Chapter 5 of the
User’s Guide (Menus).  Once you have done this you should use the “File/Calculate
3D” menu command to get 3D Builder to locate the camera stations and points.

Once the camera stations have been calculated, the “Point Merge” tool switches to
“semi-automatic” mode.  In this mode you can rapidly tie together the remainder of the
points in your model.  With two or more pictures visible on the screen, you select a point
in one picture.  The other pictures are zoomed in on the most likely candidate points to
match the selected point. This eliminates having to “roam” around the other photos,
looking for the correct area.   Other points that have not been merged together will still
appear on the second photo, but they will be drawn as small dots.  You will still be able to
choose which point you want to merge, but 3D Builder will offer its best choices for you
by automatically making its choices appear in a larger size. 3D Builder will not
automatically choose the point  for you.  You will still need to choose the point to be
merged by clicking once on it.   But this feature will save you time and prevent modeling
errors.

Figure 108 Semi-Automatic Point Matching.

Toolbar/  Line Tool
The line tool , which appears as a straight line between two small squares on the toolbar,
is used to create a straight segment at any angle. Use the line tool to draw a segment from
one endpoint to another. When the LINE tool is selected, the cursor changes to a symbol
for a line.  A line tool dialog box appears in the main window. If you know that the line
that you are going to create is vertical or horizontal along one of the coordinate axes,
then select the appropriate line type.  The same is true if you know that the line lies in
one of the principle coordinate planes. Otherwise leave the line type as SKEW. The
message "Move to end of line then release button" is displayed in the message area.
Position the cursor arrow over the starting  point for the line, then press the mouse button

Line Tool
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down.  Move the cursor over the ending point, holding the mouse button down.  As you
move the cursor,  a line will be rubber-banded on the screen from the starting point.
Release the mouse button when the cursor is over the desired end point.

To Edit A Line
Click on the “Selector” tool icon, which looks like an arrow, from the toolbar ribbon
icon.  Double click on the desired line or right mouse button click.  This action brings up
the “Line” dialog box.

Figure 109  Edit "Line" Dialog Box

The “Line” Dialog Box consists of the following elements:
• Global axis/plane drop down list box: The global list box should

be selected if the line lies along one of the global coordinate axes lines.  Choose from
a drop down list box.

• Approximate check box:  This check box is grayed out unless the
line has been marked as an approximate location.

• Direction indicator arrows:  This set of arrows is used to indicate
the direction that the coordinate axis line should go.

• Measured Length input box:  This box gives you an option of
typing in any known measured lengths of lines.  If you know the measured length of
a line, you could type it in .

• Constraint check boxes: These check boxes are grayed out unless
the line has been constrained.  A line may be parallel to other lines, perpendicular to
other lines, colinear to other lines and/or the same length as other lines. If a
constraint has been marked, a check will appear in the constraint box
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Toolbar/  Polygon Tool
The polygon tool appears as a series of short line segments between small squares.  Use
the polygon tool to create faces or polygons on an image.  You may create polygon points
in either a clockwise or counterclockwise direction.  Remember, however, do NOT go in
a crisscross or “bowtie” direction. Clicking on the polygon tool will bring up the polygon
tool icons and allows you to select from among the following types of polygon
configurations:

• • 3 Point Polygon Tool Icon: A 3-point polygon is the default box
button. Use this if you want to place a polygon face consisting of three points in the
image.

• • 4 Point Polygon Tool Icon: Use the four point polygon tool if you want
to place a polygon face consisting of four points that do not make a rectangle in the
image.

• • 4 Point Polygon RECTANGLE Tool Icon: Use the four point polygon
tool if you want to place a polygon face consisting of four points that do make a
rectangle in the image.

• Many Point Polygon tool icon:  Select this tool icon button if you want
to place a polygon face consisting of more than four points.

When the polygon  tool is selected the cursor changes to a symbol
    for a polygon.  The display of "Select first point" appears  in the status bar
    1st Click:   If cursor is near a point highlight the point and change
                 the status message to "Select second point".

    2nd Click:   If cursor is near a point highlight the point and change
                 the status message to "Select third point".

    3rd Click: See if there is a point near the cursor.  If so create a
               new face connecting the three points.
The process would be expanded to include the number of points selected for the polygon,
(four or more).  When you are doing a many point polygon, the last point must “close
the loop” and must be your first point again.

Toolbar/  Pan Tool (N)
The pan tool, which  appears as a hand, is used to grab a portion of the image and scroll
the image. The image may be scrolled both vertically and horizontally at the same time.

Polygon Tool

Cursors

   
lst Point
Cursor

   
2nd Point

3rd point

Point Number

   

Note:  If you make a mistake during the creation of a
polygon, click on the backspace key to delete the last
point placed .  To delete all of the points,   go to the
“selector” arrow tool.  Click on it once with the left
mouse button and all of the points in the face will be
deleted.



3D Builder  Toolbar 134

Toolbar/ Zoom (Z)
The “Zoom” tool gives you the opportunity to magnify the entire image for better
visibility.

Toolbar/ Zoom In Tool (+)
The “zoom in” tool appears as a magnifying glass with an inset plus sign. Use the zoom
in tool to expand the view size.  The image itself is not affected by this tool.  It allows you
to zoom in on a detail.

Toolbar/ Zoom Out Tool (-)
 The zoom out tool appears as a magnifying glass with an inset minus sign.  Use the
zoom out tool  to zoom out to contract or shrink the view size. The image itself is not
affected by this tool.  It allows you to zoom out to take in the “big picture” of a segment
of the image.  Another way of zooming out is to select “Window/Tile” menu command.
Then grab the “side bar” of the window and “shrink” the window, effectively zooming
out on the photo.

Toolbar/  Insert Photo (Add image to the Project)Tool
The “insert photo tool”, which appears as an opened file folder on the toolbar, is used to
add a new image or photograph to the project.  Clicking on the insert photo tool opens up
at the “Insert Photo” dialog box and allows you to add a new photo image from your
selected file and directory.

Figure 110  Insert Photo Dialog Box
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• Select the file name by clicking on it from the file list.
• Choose the type of file from the “List files of type” drop down list box.
• Choose the directory of your choice.
• Select the drive from the “drives” drop down list box.
• If you were accessing the file from a network, you would click on the “Network”

button.  This would bring up the standard windows browser for files.
• To accept the currently selected item, click on  “OK”.
• To return to the main screen, click on “Cancel”.
• If you need to access the help engine, click on “Help”.

Toolbar/  New Window Tool
The “add window” tool appears as a small window  on the toolbar.  Clicking on the “add
window” tool will add another window to the active project.

The “New Window” command is also available by choosing the “Window” menu and
then selecting “New Window”.

Toolbar/ Select Image List Tool (F2)
The “image list” tool appears as  a series of  images on the toolbar icon.  Clicking on the
image list tool will bring up the “Select Image” list  and  thumbnail pictures of each
image photo in the active project.  Double clicking on a photo image will bring that
photo image to the front and it becomes the active photo image. Clicking on the tool icon
activates this tool.  Use the “Select Image List” tool to bring up the “Select Image” dialog
box which gives a list of images in your project.  The list gives the file name of the
image, and the drive and directory of where the image is being stored on your hard drive.
The image itself is not affected by using this tool. The “Select Image” Dialog Box may be
closed using the close caption bar. It may also be resized or move about your screen as
any other dialog box in 3D Builder.  You may also access “Select Image List” by right
mouse clicking in an open area of the screen. Then choose “Select Image”. You may also
access “Select Image List” by selecting the “View”, and selecting “Select image…”.

Note: If you have an empty image window on your
screen, the photo will be displayed there. Otherwise
the photo is added to your project, but not
immediately displayed on the screen

   
New Window

Select Image

Note: If you want to add an additional image to the project
and have it be displayed in the main window area, you
need to click on the new window tool to create a window for
the image.  It is used to create a space (window) for the new
image.  You will need to do this any time you want more
than one image displayed at the same time.



3D Builder  Toolbar 136

`

Figure 111  Select Image List Dialog Box

Toolbar/ Save Tool
The save tool, which appears as a computer floppy disk on the toolbar, allows you to
quickly save active data to the hard drive.

Toolbar/ Calculate Tool (F3)
The calculate tool appears as “Calc” on the toolbar.  Use the calculate tool to begin the
3D Builder calculation process for converting the information given about the photo
image to a 3D model.
The “Calculate” commands begins the 3D Builder calculate process.  3D Builder does
the complicated math  for you and figures the “X”, “Y”, and “Z” coordinates.  A progress
reporter box shows you what is happening as 3D Builder converts your photos to 3D
models. A “Calculate” dialog box  appears and displays  the results. The dialog box will
show the number of points calculated and the number of points unreachable.  The dialog
box will also show the number of cameras positions calculated and the number of
cameras unreachable. For more information on the “details” in the Calculate dialog box,
see  “Appendix A” near the end of this user’s guide.

   
Save Tool

Calc 3D
Tool
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Figure 112  Calculate 3D Progress Reporter Dialog Box

Toolbar/ Help Tool

The help tool  appears as a diagonal arrow and question mark on the toolbar. Clicking on
the context sensitive help tool allows you to access on-line information from the help files
to help you in answering questions or clarifying details. Move the help tool icon over an
area in question and click on the left mouse button.  This opens up the help information
about that section and provides you with more information.

New Independent mini-toolbars

Display mini-toolbar:
3D Builder has added new, independent, mini-toolbars to control what you see on the
image. You may now turn off the visible display of points, lines, curves, and faces from
the toolbar.  This mini-toolbar is independent from the main toolbar and may be docked
anywhere on your screen.

   
Help Tool
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Circles mini-toolbar:
3D Builder has added new, independent, mini-toolbars to the new circle/arc tool. This
mini-toolbar is independent from the main toolbar and may be docked anywhere on your
screen.

The circle/arc mini-toolbar is explained in greater detail in the chapter on circles.

Curves mini-toolbar:
3D Builder has added new, independent, mini-toolbars to the new curve tool. This mini-
toolbar is independent from the main toolbar and may be docked anywhere on your
screen.

The curve mini-toolbar is explained in greater detail in the chapter on curves.

Extrusion mini-toolbar:
3D Builder has added new, independent, mini-toolbars to the new extrusion tool. This
mini-toolbar is independent from the main toolbar and may be docked anywhere on your
screen.

The extrusion mini-toolbar is explained in greater detail in the chapter on extrusions.

Points           Lines            Curves       Faces
Display Mini-toolbar icon buttons
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Changes in the line mini-toolbars:

Flip Line/Curve Sense  Tool:
3D Builder has added a “Flip Line/ Curve Sense” tool to the “Line” toolbar.  You can
now change the direction of a line by using the “Flip Line/ Curve Sense” tool, thus
eliminating the need to double click on the line to bring up the “Line Properties” box.
Now the direction of the line can be changed directly from the toolbar with a single click.
This is done after selecting the line with the “Selector” (arrow) tool.  The “Line Flip”
tool only applies to axis lines (lines that have been designated as being along one of the
axis planes.)

Hint: Remember, a line can have three states: one direction, the other direction, or a third
state which is “no direction” or the questionable state in which you do not which
direction the line is.

It is very important that you mark the direction of each line. Because if you get a line,
even one line, that is going in the wrong direction, the calculations can suffer drastically!

Note: With the creation of curves, this line direction is also very important. If you want
to merge curves (saying that this curve in image “a” is the same as this curve in image
“b”) you need to be sure the curves are going in the same direction.  Use the “Flip Line/
Curve Sense” tool to change the “sense” or “direction” of the curve.  You need to do this
before merging the curve.  After you merge the curve, flipping the direction of the curve
will flip both curves.

Object and Material Assignment from the Toolbar
“Setting the object” to which lines and faces belong  or “assigning the material” for faces
may be done directly from the toolbar by simply selecting the desired lines and/or faces
and then selecting the object and/or material from the “combo boxes” in the toolbar.
This is faster than double clicking on the line and/or face and selecting the object or
material from the line or face property window.  Both combo boxes show a “blank” box
as the “default” position.
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WORKING WITHWORKING WITH
PHOTOGRAPHSPHOTOGRAPHS

Working with photographs is a key component in 3D Builder.  The program works with
all important sources of images.

Getting Images Onto Your Hard Drive
3D Builder can use images from many sources, including 35mm cameras, digital
cameras, video cameras, scanners and from Photo CD directly.  Although there are many
models of each type available,  the program works to integrate the many different ways of
accessing image information.  Each source has advantages and disadvantages, ranging
from price considerations to length of turn-around time for processing images.

Importing File Formats
3D Builder  offers you flexible and high performance in working with file formats for
your photographs.  3D Builder provides a set of components that can accept over 36
different file formats into the program.  The following formats can be imported into 3D
Builder:

TIFF JPEG PCX TGA DIB DCX
GIF GMP WMF PICT WPG EPS
KFX RLE LV CALS G3 G4
ATT CLP XWD IMG IFF SUN
XBM ICO ICA GX2 XPM ASCII
CUT BRK MAC MSP PSD PCD

3D Builder provides the key components to read Photo CD directly.  There is no need to
convert the files to another format.

Adding Photos to a Project by “Inserting” them in a Project
You may add photos to a 3D Builder project by the menu or by the toolbar icon.  Click
on the “Insert” menu, “Add Image to Project” command. The insert photo tool, which
appears as an opened file folder on the toolbar, is used to add a new image or photograph
to the project.  Or use the “Insert” shortcut key on your keyboard.

Chapter
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Clicking on the insert photo tool opens up  the “Insert Photo” dialog box and allows you
to add a new photo image from your selected file and directory.

• Select the file name by clicking on it from the file list..
• Choose the type of file from the “List files of type” drop down list box.
• Choose the directory of your choice.
• Select the drive from the “drives” drop down list box.
• If you were accessing the file from a network, you would click on the “Network”

button.  This would bring up the standard windows browser for files.
• To accept the currently selected item, click on  “OK”
• To return to the main screen, click on “Cancel”.
• If you need to access the help engine, click on “Help”.

Add Images All At Once To Your Project.
One way of saving time is to add several images at once to your project.
You can “multi-select” images to add to your project ion the same way as you would
multiple select files for any Windows program.  This method will vary depending on
whether you are using Windows 95, or Windows NT.

File Menu/ Add image to Project
3D Builder has added a file menu item for adding an image to the project.  Click on

the File menu, “Add image to Project”.

Add New Window And More Photos
The “New Window” command opens a new window.  It is used to create a space

(window) for the new image.  The “New Window” tool icon appears as a miniature
window box on the toolbar.  The “New Window” command is also available by
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choosing the “Window” command and then selecting “New Window”. The “New
Window” command creates a new image window and chooses a photo that is not being
displayed to be shown in the window.  To choose a different image to be displayed in the
new window, choose the “View” menu “Select image” command.

Manipulate The Image On The Main Screen
Resize it by moving splitter bar
You can resize the image on your screen by moving the splitter bar in an upwards
direction.  Move your mouse to the upper line of the large image on your main viewing
screen.  When the pointer cursor changes into a double line, click, drag and release the
left mouse button to enlarge the main image.

The Pan Tool
The pan tool, which  appears as a hand on the toolbar, scrolls the image. The image may
be scrolled both vertically and horizontally at the same time. Clicking on the tool icon
activates this tool. You may also access “Pan” by right mouse clicking in an open area of
the screen. Then choose “Pan”.  Additionally, you may also access “Zoom In” by
selecting the “View” menu, and selecting “Zoom In”.

View/ Zoom
The “Zoom” command allows you to magnify  the entire image for closer
examination.

The Zoom In Tool
The zoom in tool appears as a magnifying glass with an inset plus sign on the toolbar.
Clicking on the tool icon activates this tool.  Use the zoom in tool to expand the view
size.  The image itself is not affected by this tool.  It allows you to zoom in on a detail.
You may also access “Zoom In” by right mouse clicking in an open area of the screen.
Then choose “Zoom In”.  Additionally, you may also access “Zoom In” by selecting the
“View”, and selecting “Zoom In”.

The Zoom Out Tool
 The zoom out tool appears as a magnifying glass with an inset minus sign on the
toolbar. Clicking on the tool icon activates this tool.  Use the zoom out tool to zoom out
to contract or shrink the view size. The image itself is not affected by this tool.  It allows
you to zoom out to take in the “big picture” of a segment of the image.  You may also

   
  Pan Tool

Zoom In

Zoom Out

Zoom Tool
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access “Zoom Out” by right mouse clicking in an open area of the screen.  Then choose
“Zoom Out”.  You may also access “Zoom Out” by selecting the “View” menu, and
selecting “Zoom Out”.

Enlarge an area of the image in the Splitter thumbnail
You can quickly and easily zoom in to enlarge any area of the image in the main viewing
window by choosing the desired area in the thumbnail window image near the top of your
screen.  Zooming in on a section of the photo is done by moving the cursor into the
thumbnail image in the upper section of the active window.  Click, drag and release to
form a “bounding box” around the desired area.  This action will enlarge and zoom in on
the selected region of the photo.

Properties
The “Properties” command is available under the “Edit” menu by choosing “Properties”.
You may also access “properties” by right mouse clicking in an open area of the screen.
The “Properties” command opens up a tabbed page.  Choose “Image”, giving you the
options of the following:

• Contrast/Brightness Use this tool to lighten, darken, or sharpen the
contrast of the image for optimum viewing.

• Negative Use this tool to “invert” the image properties (what was black
is now white).  This tool may be used to improve or sharpen the contrast for
optimum viewing.

• Rotate Use this tool to turn the image by 90 degree increments.
Clockwise is the direction.  Each left mouse click rotates the image 90 degrees
clockwise. This tool may be used to improve viewing range.

• Filter Use this tool to help increase the visibility of the lines.
• Orientation  Tells you which way the camera was positioned when you

took the picture.
• • Photo CD Size This button lets you choose the size resolution of the

Photo CD image.

Resize the Image Window using the Maximize/Minimize Boxes
Use the Windows maximize or minimize buttons to enlarge or reduce the image window.
The frame around the window is also used to resize the window.
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Close The Image
The “Close” command closes the active image.  Closing the project frees the memory that
was used by the project. If the project contains unsaved information, 3D Builder will
display a confirmation message box.  When the confirmation message box appears,
choose

• • “Yes” to save changes
• • “No” to discard the changes
• • “Cancel” disregards the Close command.

Figure 113  Close Command Dialog Box

Working With Multiple Images

How many images at a time?
You may work with one image at a time on the main viewing screen or you may work
with any desired number of images at one time. 3D Builder will allow you to
automatically work with as many images at once as you wish.  Each time you choose
“New Window” from the “Window” menu, a space is created for the new image.

Cascade
The “Cascade” command overlaps the open image windows diagonally in the creation
order. You may access “Cascade” by selecting the “Window”, and selecting “Cascade”.

Tile
The “Tile” command spaces the screen with open image windows and adjusts sizing to
fit the available space in the window. You may access “Tile” by selecting the “Window”
menu, and selecting “Tile”.
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Take one or more images down to an Icon
Each image may be reduced to an icon by clicking on the Windows “Minimize” button
located in the upper right hand corner of each image window.  The image is enlarged
again by clicking on the icon near the bottom of your screen.

Close One Photo
You may close any image at any time by clicking on the Windows Close caption button
located in the upper left hand corner of the image Window.

Resize one image
You can quickly resize an image by moving  your mouse to the line separating  the
images horizontally on your main viewing screen.  When the pointer cursor changes into
a double arrow, click, drag and release the left mouse button to resize the desired image.

Image Select Viewing Window Tool
The “Select Image List” tool appears as a filmstrip viewer on the toolbar. Clicking on the
tool icon activates this tool.  Use the “Select Image List” tool to bring up the “Select
Image” dialog box which gives a list of images in your project.  The list gives both a
thumbnail sketch of the image, the file name of the image, and the drive and directory of
where the image is being stored on your hard drive. The image itself is not affected by
using this tool. The “Select Image” Dialog Box may be closed using the close caption
bar. It may also be resized or move about your screen as any other dialog box in 3D
Builder.  You may also access “Select Image List” by right mouse clicking in an open
area of the screen. Then choose “Select Image”. You may also access “Select Image List”
by selecting the “View” menu, and selecting “Select image”.

Select Image
List tool icon
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Figure 114  Select Image List Dialog Box

Project Tree
The Project window is the 3D BUILDER "control center" for the project
files.  While a project window is open, the Project Window is displayed,
showing the files contained in the project.  You can have only one

project open at a time.  The Project window shows a tree control system, including
branches to view the camera stations and images in the project. Click on the “Project
Tree” button icon from the toolbar OR

• From the “Window” menu, choose “Project ”.
• Expand the project control tree to show the “Stations/Photos” branch.
• Stations/Photos  Gives a list of the camera stations and individual photos
identified in the project. Click on the + sign to expand the tree control level.
• • Click on camera stations, click on the photo brings up the image as the active
window on main viewing screen.

Delete a Photo from a Project
You may delete a photo from the project from the “Project Window”.

• From the “Window” menu, choose “Project ”.
• Expand the project control tree to show the “Stations/Photos” branch.
• Stations/Photos  Gives a list of the camera stations and individual photos
identified in the project. Click on the + sign to expand the tree control level.
• • Click on camera stations, select the photo and click on the “Delete” key.
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Saving A Project And Re-opening It Next Time
Use the “Save” tool to save a project.  The save tool, which appears as a computer floppy
disk on the toolbar, allows you to quickly save active data to the hard drive.  If this is the
first time you have requested to save the project, the “Save As” dialog box will appear,
allowing you to select the drive, directory, file name and type of file. The “Save As”
command saves the active file using a new name, file type, directory and drive.

Figure 115 Save As Dialog Box

Summary
Working with photographs will become very comfortable for you within a few projects.
There are a lot of capable tools and rich features in the program to help you.  3D Builder
allows you a lot of flexibility in image management.
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EXPORTING YOUREXPORTING YOUR

3D BUILDER PROJECT3D BUILDER PROJECT
Introduction

Exporting a good 3D model is the primary goal of 3D Builder.  Offering you a variety of
export file formats helps accomplish this goal.  3D Builder will allow for a seamless
integration with the family of rendering, animation, CAD, or the Internet Web choices.
In most cases, all you will need to do is open your rendering, CAD, or animation
program and choose the “Import file” command.  The 3D Builder export files transfer all
of the key components of your 3D model.

Export File Formats
3D Builder can export the following file formats:

• • DXF  Data Exchange Format, used by many CAD packages,
including AutoCAD 3D. (Both Pro and PowerLite)

• • 3D Studio File format  (3D Builder Pro Only)
• • IGES Initial Graphics Exchange Specification, used by many

mechanical CAD packages. (3D Builder Pro Only)
• • Wavefront (3D Builder Pro Only)
• • Inventor (3D Builder Pro Only)
• • VRML 1 & 2, Virtual Reality Modeling Language, used by the

Internet Browsers.  3D Builder allows you to harness the power of the Internet.
Exporting the VRML .wrl file will allow your model to be taken directly to the
Web.  This also allows you to quickly introduce 3D elements on your Web
pages, evolving them from static pages. (Both Pro and PowerLite)

• • STL Stereo Lithography (used in rapid prototyping machines)
(3D Builder Pro version only)

Beginning The Export Process
To begin the Export of your 3D model, make sure your have calculated it by clicking on
the “Calc” tool icon accessed via the toolbar ribbon or by selecting “Calculate 3D” under
the “File” menu.  Then select “Export” under the “File” menu.

 Chapter
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Figure 116 The "Export”  menu command is accessed via the File menu

Clicking on the “Export” command under the “File” menu opens up the “Export
Options” tab page allowing you to quickly choose where to export the files or project.

F

I

F

Figure 117 The "Export" Options tab page

The Export Options Tab Page provides details for you to make choices concerning the
file to be exported.
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• In the Section labeled format, choose the type of file format to be
exported.  Simply click on the radio box to the left of the desired format.

• Under “File name”, choose the selected file name, directory and drive or
click on the button labeled “Browse”.  This action will open up a standard Windows
browser to select drive, directory and file name.

• Under “Objects”, choose the objects you would like to have exported.
Make sure that at least one object is checked.  The default object is “unnamed-1”.

Problem Reporter
If there appears to be a problem with exporting the desired file format file in 3D Builder,
a tab page labeled “Problem Area” will appear upon the selection of “Export”.  The
problem is identified for you and explained.  You may choose to return to your project
and correct the problem.  Or you may choose to continue on with the export procedure.

Figure 118  "Export" Problems Tab Page

Texture Exporting
Texture maps are also exported with the files and these are automatically corrected for
perspective distortions. Automatic corrections are in 3D Builder Pro Only.

3D Studio, Inventor, VRML (Both Pro and PowerLite), and Wavefront export files will
include references to texture maps if the objects are textures.  That is the export files will
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have the texture file name embedded in the file in one or more places, and perspective
corrected texture coordinates will be contained in the file.

You will need to copy the texture map images that you have previously created with the
“Draw” menu texture map command to whatever directory is required by whatever
rendering tool package (3D Studio, VRML browser, etc.) you plan to use.  When you
select “OK”, the texture map image file will be created and saved to disk at the location
indicated.  You will need to remember this location when you export files to other
rendering programs.  You may need to move or copy the image somewhere else,
particular if you need to copy and export the project file to another machine for a
rendering program. You will need to make sure you copy the texture map files at the
same time.  3D Builder does not automatically do this for you.
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COLORS, MATERIALS,COLORS, MATERIALS,
TEXTURE MAPSTEXTURE MAPS
Overview

3D BUILDER  uses the same metaphor as most rendering programs.  The color, texture,
and other visual attributes of the faces are defined by “material”.  A small starter set of
materials is supplied with 3D BUILDER.  All faces are assigned to an object.  Materials
(colors or texture maps) are applied to objects and faces. If a face does not have a
material assigned, it will, by default, use whatever material was assigned to its object.
Colors can be picked from a list of “material colors” or new colors can be made by either
“setting” or “picking” a color off the image.

If a texture map is to be used as the material, the texture map is “cut” out of the image
and saved as a small .BMP and a .JPG file and is associated with the material name.  If
possible, 3D BUILDER recommends the use of a naming convention that is closely
related to the object.  For example, if the front of a building makes up an object named
“FRONT”, name the material “FRONT” and name the bitmap “FRONT.BMP”.

JPEG Texture Maps
3D Builder now saves texture maps as both .BMP and .JPG files.  The .BMP file is

required for the 3D Builder “3D Preview window”, accessed via the “Window/3D
Preview” menu, and may be exported to 3D Studio and other modeling programs.  The
.JPG file is used for VRML  and Inventor exports.  The .JPG file is much smaller which
is one reason that it is the preferred standard for VRML.  Valid filenames must be given
for both the .BMP and .JPG files.  3D Builder will generate default names using the
directory the project .B3D file is in and the name of the material to which  the texture is
assigned. 8 character filenames work best, especially if you are using 3D Studio.

If you have edited the .BMP file with a paint program, be sure to go back to the
texture map properties window (accessed from the “Window/Project” menu) and select
the “Refresh” button to regenerate the .JPG file.
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Figure 119 Texture Map Dialog Box.

Functions
Texture is associated with “materials”.

Creating materials with the “Insert” menu command.
1. From the “Insert” menu, choose “Materials”.
2. Give the material a name.
3. Choose to create a texture or set a color from the “Materials” box.

Creating texture maps with the “Texture Map Tool”.
1. From the “Draw” menu command, choose “Texture Map”.
2. From the “Materials” list, choose a material from the drop down list box.
3. Click, drag and release to form a rectangle encompassing the portion of the

image that is wanted for the texture map.
4. This brings up the “Texture Map” dialog box.
5. Set the desired pixel size from the spin control arrows.
6. Hit “OK” to save it as a .BMP and a .JPG file.

Creating a texture map from the photo.
1. From the “Insert” menu, choose “Material”.
2. From the “Materials Property Box”, give the material a name.
3. In the texture map section of the material box, choose “New”.
4. In the image, click, drag, release a rectangle encompassing the portion of the

image that is wanted for the texture map.
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5. Click on “OK” to give the cropped texture file a name and it is automatically
saved it as a .BMP and a  .JPG file.

Assigning a material to a face.
1. Double click on the face to bring up the “Properties Box” for that face.
2. Select material from the “Materials” drop down list box.

Setting or changing a material for an object from an image window.
1.     Use the right mouse button and click somewhere over the object.
2. Select “Properties” from the pop-up menu.  This action brings up the object

properties box.
3. Select material from the drop down list box.

Setting a material for an entire object from the “Project Window”.
1. From the “Window” menu, choose “Project”, bringing up the “project

window”.
2. Open the “Objects” branch.
3. Double click on the desired object.  This action brings up the object properties

box.
4. Select material from the drop down list box.

Setting the colors of materials from the “Project window”.
1. From the “Project window”, choose “Project”.
2. Open the “materials” branch, choose “materials” from there.
3. Double click on a material brings up the “Material Box” and edit the colors.

Setting the colors of a material from an image window.
1. Colors for that material may be lifted from one of the images using the “Draw”

menu.
2. Selecting “Pick Color” or by using the “Eye Dropper” icon from the toolbar.

The “Eyedropper” tool is used to pick a color directly from the image.

Touching Up Textures
With 3D Builder, you can edit or touch-up textures.  3D Builder can launch whatever
“Paint” program is registered in your “Windows” directory.  Select the “Edit” menu,
then choose “Material Properties”.  This action brings up the “Material” dialog box,
which should contain a thumbnail of the texture map in the “texture map” section near
the bottom of the dialog box, as shown on the following page.
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Figure 120  Edit Material Properties Dialog Box

Clicking on the button marked “Touch Up...” in the texture map section of the “Material”
dialog box will automatically take the texture to whatever program has been “registered”
or associated in Windows as the tool for .bmp files (Example, Microsoft Paint).  This
action also brings up an “Information Box” with a reminder NOT to resize the texture
image in your paint program.

Figure 121 Information Box

Clicking on the “OK” button in the information box launches the “Paint” program, as
shown:
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Figure 122 Editing through the Paint Program.

• Use the tools in your Paint program to zoom in, select colors, erase portions and
perform other types of editing operations on your texture.

• Save the touch-up work.  Exit the paint program by clicking on “Exit”.
• This action closes the Paint program and returns to the main screen of 3D Builder.

The “Materials” dialog box is still active on your main viewing screen.  Click on
“OK” to close this dialog box.

Reviewing the Touch-Up Texture Map
To review the touched-up texture map, go to the “Window” menu and select the project
file. This action reopens the “3D Preview” window and displays the texture map as it is
“glued” to the 3D model.

Figure 123 3D Preview window with textures touched up in Paint program

Note:  If the changes are not displayed on your
screen, close down the “3D Preview” window and
reopen it to “refresh” your screen.
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Exporting Textures
3D Studio, Inventor, VRML*,and Wavefront export files will include references to
texture maps if the objects are textures. The export files will have the texture file name
embedded in the file in one or more places, and perspective corrected texture coordinates
will be contained in the file.  You will need to copy the texture map images that you have
previously created with the “Draw” texture map command, to whatever directory is
required by whatever rendering tool package (3D Studio, VRML browser, etc.) .

When you select “OK”,  the texture map image file will be created and saved to disk at
the location indicated.  You will need to remember this location when you export files to
other rendering programs as you may need to move or copy the image somewhere else.
This is especially important if you need to copy and export the project file to another
machine for a rendering program.  You will need to make sure you copy the texture map
files at the same time.  3D Builder does not automatically do this for you.

*VRML export available for both 3D Builder Pro and PowerLite versions.

Perspective Correction for Texture Maps

By default 3D Builder applies perspective correction to the 3D Preview window and
to all exported 3D models.  This improves the visual quality of the 3D models but does
increase their size.  You may choose a lower quality perspective correction or you may
turn off perspective correction altogether.  The option is selected from the “Options” tab
in the “Export” window, which is activated from the “File/Export” menu.

The options are:
• no correction
• fast, but crude correction
• slow, but accurate perspective correction  (Pro version only)
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If you want to change the perspective correction for the 3D Preview window but do not
need to do an export, use the “File/Export” menu command, set the option, then select
“Cancel” from the Export window—the perspective correction option will be
remembered even though Cancel has been selected.
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                This chapter applies to Pro Version Only

CONSTRAINTSCONSTRAINTS
Introduction

Constraints are relationships that help in the “Calculate 3D” process.  Constraints are
used to help the appearance of the model.  A constraint acts as a “hint” to the “Calculate 3D”
command.  Constraints do not go into effect until you hit the “Calc” tool or “Calculate 3D”
under the “File” menu.  The program will then attempt to “satisfy” every constraint in the
model.

3D BUILDER gives you the option of several constraints.  These are all located under
the “Make” menu of the main program screen. The constraints include:

• Make CoLinear
• Make Coplanar
• Make Equal Length
• Make Parallel
• Make Perpendicular

Functions
Constraints are all selected in the same manner, which is described in detail below.  Once

selected, each constraint appears in the “Project Window.  Clicking on the “constraint”
branch in the project window will take you directly to the selected constraint.

Make CoPlanar
CoPlanar means lying in the same plane.  To declare that a point is coplanar with other
points and/or faces, do the following:

1. Select a point by clicking on it.  The point will highlight.
2. Next, while holding down the “Shift” key, select the other points of faces
which share the same plane.  These will also highlight.
3. Choose the “Make” menu, then select “Coplanar”.
4. The result of this action is that all of the selected (highlighted) points and
faces will be constrained to be coplanar to one another.

Chapter
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5. If you were to edit one of these points by double clicking on it to bring up the
“Point Dialog Box”, a checkbox would be checked indicating that the point is
coplanar to others.

Make Equal Length
To declare that a line is the same length as one or other lines, do the following:

1. Select the line by clicking on it.  The line will highlight.
2. Next, while holding down the “Shift” key, select the other line (or lines)
which share the same length.  These additional lines will also highlight.
3. Choose the “Make” menu, then select “Equal Length” by clicking on it.
4. The result of this action is that all of the selected (highlighted) lines are now
constrained to be of equal length to one another.
5. If you were to edit one of these lines by double clicking on it to bring up the
“Line Dialog Box”, a check box would be checked indicating that the line is of
equal length to others.

Make Parallel
 Parallel means going in the same direction at the same distance apart.  To declare that a line
is parallel to another line, do the following:

1. Select the line  by clicking on it.  The line will highlight.
2. Next, while holding down the “Shift” key, select the other lines which are
parallel.  These additional lines will also highlight.
3. Choose the “Make” menu, then select “Parallel” by clicking on it.
4. The result of this action is that all of the selected (highlighted) lines are now
parallel to one another.
5. If you were to edit one of these lines by double clicking on it to bring up the
“Line Dialog Box”, a check box would be checked indicating that the line is
parallel to others.

Make CoLinear
Colinear means lying in the same line.  If several points and/or lines lie along the imaginary
extension of a single line, then you should select these and use the “Make Colinear”
constraint to force the calculate command to snap these lines and/or points to all lie along a
single extended line in space To declare that a point is colinear with other points and/or lines,
follow the same steps as above.
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Make menu/Perpendicular
3D Builder has added a file menu item for indicating that two or more lines are
perpendicular to each other.

1. Select the line  by clicking on it.  The line will highlight.
2. Next, while holding down the “Shift” key, select the other lines which are

perpendicular.  These additional lines will also highlight.
3. Choose the “Make” menu, then select “Perpendicular” by clicking on it.
4. The result of this action is that all of the selected (highlighted) lines are now
perpendicular to one another.
5. If you were to edit one of these lines by double clicking on it to bring up the
“Line Dialog Box”, a check box would be checked indicating that the line is
perpendicular to others.

Constraint Project Tree
All constraints can be viewed from the “Project tree”, under the “Window” menu.  Select

“Project” from the “Windows” menu. Click once on “Constraints” to expand the tree.
Clicking  once on the individual constraint will highlight the points, lines and/or faces
constrained.  Double clicking on the constraint in the project tree will bring up a constraint
properties window.
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This chapter applies to Pro Version Only

CIRCLES and ARCSCIRCLES and ARCS

3D Builder Pro features new tools for circles and circular arcs. 3D Builder’s new circle tool
lets you model real world circles without having to have reference targets along the circle.
Without the “circle tool”, these objects would be very difficult to model.

Introduction
The “circle” tool is used to create three dimensional circles and circular arcs. An object

that is a circle in the real world usually appears as an ellipse in a photograph unless the
picture has been taken in a “straight on” camera station position.

Circles are always in a plane and the default plane is “skew” in 3D Builder.  Otherwise,
if the circle is in one of the three coordinate planes (Like horizontal on the ground and in the
“XY” plane, for example) you only have to locate the circle in one image.  You will need to
locate the circle or circular object in two or more images and then “merge” the circles just as
you “merge” points in different images.

Draw Menu/ Circle Tool
The Circle tool can be accessed from the “Draw/Circle” menu or from the “Circle Tool”
icon located on the toolbar. Located under the “Draw” menu, each menu item is activated
by clicking on it.

 Clicking on the “Draw/Circle” menu item or the  “Circle Tool” icon located on the toolbar
will activate the  “Circle Tool” mini-toolbar, giving you a choice of the type of circle to be
created and the plane of the circle, as shown below:

 Chapter
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“Just-In-Time” On-Screen Helps for the Circle Tool

The first time you choose the “Circle Tool”, the “Helpful Tips on Circle” window appears on
your main viewing screen.  It gives an explanation of the process used in creating a circle.
There is an option to turn off “Show Tips for Circles” in  the “Helpful Tips” window in the
lower left corner of the window.

To turn the “Show Tips for Circle” window back on and make it come up on your viewing
screen again when you choose the “Circle Tool”, go to the “Help” menu. Choose the “Show
Tips for” menu item, then choose “Circles”.
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How the Circle Tool Works
Choose the type of circle you want to create. 3D Builder gives you a choice between a full
circle (closed) or a circular arc (open circle or partial circle). Click on either the circle tool or
the circular arc tool from the mini-toolbar.

Next, if you know the plane of the circle, indicate this by clicking on one of the plane
indicator icon buttons.  The default is “skew” plane.

Drawing a Full circle (Closed circle):

Making a full circle takes four mouse clicks. First, place three widely spaced points around
the circle.

After the 3rd point,  the cursor changes to a special symbol for “Circle center”.
(The next action will be a “button down, move, button up” operation.) Looking at the
image, decide where you think the center of the circle is.  Click there with the left

mouse button on the center of the circle.  While holding down the left mouse button, drag the
center of the circle until the visual display of the circle mostly closely matches the circle on
the image. Then release the left mouse button and the circle is created on your image. The
center of the circle appears as an “x” mark on your image.

Note: The circle is completed with the “mouse up” action.

Full
Circle

Circular
Arc
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At this point, you can continue making more circles, or, go back to the toolbar and select a
different tool or another operation.

Locating the Circle in 3D from two or more images:
Locating the circle in 3D space requires creating circles (or ellipses) in two or
more images and then, using the “Merge” tool to tie the circles (or ellipses)
together.

Locating the Circle in 3D from a single image:

Circles (ellipses) and circular arcs can be located from a single image if their plane and one
of the points on the circle (ellipse) or circular arc can be located.   If the circle was in the
“XY”, “YZ”, or “ZX” plane, then you only need to locate it in one picture if at least one point
on the circle (or the center of the circle) can be located.  If you created the circle as “skew”
and then wish to change it to a plane, select the circle with the arrow tool.  It will highlight.
Then click on the appropriate plane in the “select circle” tool bar.
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Placing Additional Points on the Circle:
Additional points will automatically be placed on the circle if you start or end a line or a face
on the circle. Double clicking on the point will bring up the “Point Dialog Tab Page” and will
show the

Figure 124 A point which starts or ends on a curve or circle are a different
shape.  Note regular  points above and to the right of  the circle point.  The dark box has
been added for emphasis in this manual and does not appear on your screen.

Polyline Tool:
The “Polyline Tool” lets you create multiple lines, one right after another. This is a

timesaving feature when you need to make a lot of lines. To access the “Polyline” tool,
select the “Line” tool.  The “Line” tool mini-toolbar buttons appear on your screen.  The
“Polyline Tool” is activated by clicking on the “Polyline” tool button icon on the “Line tool

mini-toolbar”.  Click on the desired end point location, then draw the line. Click again to end
the line. Then upon the next click, another line will be started, as shown:

Drawing a Circular Arc (Open Circle):

Drawing a circular arc is identical to drawing a full circle except that you click on the
“circular arc” button on the toolbar.  The first point is the circular arc “start” and the
third point is the circular arc “end”.
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Editing a Circle or Circular Arc
You may edit a circle or a circular arc at any time.  Select the “Selector Tool” (Arrow tool)
and select a point on the circle. Then click, drag, and release the left mouse button to fine
tune points or the circle.

Exporting a Circle or Circular Arc
To export the circle, you will need to either put a “face” or a set of “lines” around the circle.
If you use the “polyline” tool or the “multi-point” face tool, the circle will automatically be
faceted into a series of small, straight lines.

Texturing a Circle or Circular Arc

To texture a circle or circular arc, you will need to first create a “face” on the circle using the
“multi-point” face tool.  If you just click twice on a point on the circle, 3D Builder will
automatically put a face on the circle.  This face can then be textured using the “Draw
Texture” tool.

Useful Notes on the Circle Tool
1.  The movement of the circle center cursor is an exaggerated movement. The location of the
circle center will most likely not be the visual center of the circle.
2.  Remember when choosing the circular arc to declare the “plane” of the arc.
3.  Be sure to check the direction of your circles before merging the circles. Before you

merge the circles, you can use the “line flip” tool to change the direction of the circle so
that both circles are going the same direction.   If you have one circle going one direction
and the other circle going the other direction and you merge them, the line flip tool
cannot correct the direction.



          3D Builder   Free Form Curves

Free-Form CurvesFree-Form Curves
Bezier  Spline Curves

This chapter applies to Pro Version Only

3D Builder features new tools for free-form (Bezier  spline) curves. Many objects in the real
world are composed of curved surfaces.  Using the new “free form curve” tools lets you model
shapes without the extensive use of reference targets.  Without these curve tools, curves
would be very difficult to model.

Introduction
The “curve” tool is used to create any type of curve. You can create an “Open Curve” or a

“Closed Curve”. Also, you can create a curve that is “flat” and in one plane or a curve that is
not in a plane.

  If the curve is flat and in one of the three coordinate planes (xy, yz, or zx), then it may
be located from a single image.  Otherwise, the curve needs to be modeled in two or more
images.

The creation of a curve is different from the creation of a circle in that (1) the curve does
not get created until you click on the “OK” button on the  curve mini-toolbar button and (2)
the curve may be created in two or more images at the same time, eliminating the need to
“merge” the curves.
Caution: Non-Planar curves are not very stable.   3D Builder recommends the use of
planar curves.

Draw Menu/ Curve Tool
The Curve tool can be accessed from the “Draw/Curve” menu or from the “Curve Tool” icon
located on the toolbar.  Clicking on the “Draw Menu/Draw Curve” or the  “Curve Tool” icon
located on the toolbar will activate the  “Curve Tool” mini-toolbar, giving you a choice of the
type of curve to be created and the plane of the curve, as shown:

 Chapter
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 “Just-In-Time” On-Screen Helps for the Curve Tool

The first time you choose the “Curve Tool”, the “Helpful Tips on Curves” window appears on
your main viewing screen.  It gives an explanation of the process used in creating a curve.
There is an option to turn off “Show Tips for Curve” in  the “Helpful Tips” window in the
lower left corner of the window.

To turn the “Show Tips for Curve” window back on and make it come up on your viewing
screen again when you choose the “Curve Tool”, go to the “Help” menu. Choose the “Show
Tips for” menu item, then choose “Curves”.
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How the Curve Tool Works
Choose the type of curve you want to create. 3D Builder gives you a choice between a
full curve (closed) or an open curve . If you know the plane of the curve, indicate this
by clicking on one of the plane indicator icon buttons.  The default is “skew” plane.

Drawing a Free-Form (Bezier  spline) Curve:

Making a curve takes four or more points—a minimum of four points must be used for each
curve.
To draw the free-form curve, do the following:
1. Click on the “curve tool”.  The cursor changes to a “point cursor” with the number “1”.

Place the first point on the beginning of the curve in your image.
2. Next, the cursor changes to a “point cursor” with the number “2”,  indicating the

program is ready for you to place the second point on the curve.
3. Then the cursor changes to a “point cursor” with the number “3”,  indicating the

program is ready for you to place the third point on the curve.
4. Next, the cursor changes to a “point cursor” with the number “N”,  indicating the

program is ready for you to place the fourth point on the curve.
5. After the fourth point, the cursor remains with the “N” , indicating that the program is

ready for you to place as many points on the curve as you choose.
6. If the curve is in one of the principal coordinate planes, click on the “XY”, “YZ” or “ZX”

toolbar icons.
7. If the curve is visible in multiple pictures, lay out the points for the curve in both

pictures.  Be sure to start the curve at the same point in both pictures.  Then click on
the “OK” button to tell the program that you have finished the curve”.

8. Click on the “OK” button icon on the “curve” mini-toolbar to display the curve.

Helpful Tip:  Be sure to locate the points along the curve in order.  The first two points along
the curve and the last two points along the curve influence the curve the most.

Note: The curve is not completed until you hit the “OK” button and the curve is visibly
displayed.  Clicking on the “OK” button creates and saves a free-form Bezier curve that

passes through the points on the curve.

At this point, you can continue making more curves, or, go back to the toolbar and select a
different tool or another operation.
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Locating the Curve in 3D from two or more images:
Locating the curve in 3D space requires the creation of curves in two or
more images.  The best way to locate the curve in 3D is to have both
images up at the same time and create the curve in both images before

clicking on the “OK” button.  However, you can use the “merge” tool later to merge the
curves. Then, use the “Merge” tool to tie the curves together.

Note:  Both curves must have common “start”  and “end” points, i.e., you will need to merge
the “start” and the “end” point in both pictures before merging the curves.

Locating the Curve in 3D from a single image:

Curves may be located from a single image if their plane and one of
the points on the curve  can be located.

Placing Additional Points on the Curve:
Additional points will automatically be placed on the curve if you start or end a line or a face
on the curve. If you have already created a curve and you draw (or create) a polygon or a line,
then a special kind of point is created.  This special point is “tied” or connected to the curve
(or circle). This special point is displayed as a “circle” point rather than as the other types of
points which are displayed as a  “square”.

Figure 125  A special "curver" point.  Note regular points above and to the right of  the
point on the curve.  The dark box has been added for emphasis in this manual and does not appear
on your screen.

If you edit the curve, then the curve point will also be moved.  Double clicking on the point
will bring up the “Point Tab Page”. The tab page will show the point to be located on a curve.

Drawing a Closed Curve:

The steps for the closed curve are the same as above, except that you would choose
the “Closed Curve” tool.
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Editing a Curve
You may edit a curve at any time.  Select the “Selector Tool” (Arrow tool) and select a point
on the curve. Then click, drag, and release the left mouse button to fine tune points or the
curve.

Note: The shape of the curve is heavily influenced by the first two points created, and the last
two points created.  If you do not like the curve that is displayed, you can select it and delete
it.  Then repeat the creation of the curve, adding more points to the curve. In particular, the
first two points and the last two points determine the shape of the curve.  Do not have a lot of
space between the first two and the last two points on the curve.

Note: You can change your mind about open/closed curves up until you hit the “OK” button.

Texturing  a Curve

Same as for the Circle.  See more details in the Circle Chapter.

Useful Notes on The Curve Tool

1.  Remember to choose which plane in which to locate the curve (or declare it to be skew).
2.     Check the direction of your curve before you merge the curves.  Use the “line flip” tool
to change the direction of the curve before you merge the curve.  After the curves are merged,
the “line flip” tool does not change the direction of the curve.
3.  You can save steps by locating the curve in one image, then going directly to the second

image and doing the same curve.  Both curves will be merged and become the “same”
curve.
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ExtrusionsExtrusions
This chapter applies to Pro Version Only

3D Builder features new tools for creating extrusions from lines you have previously
created.  With one command, the extrusion tool creates dozens of lines and faces, saving
time in the modeling process.

Draw Menu/Extrusion Tool
The Extrusion tool can be accessed from the “Draw/Extrusion” menu or from the
“Extrusion Tool” icon located on the toolbar.  Clicking on the “Draw/Extrusion” menu
item or the  “Extrusion Tool” icon located on the toolbar will activate the  “Extrusion
Tool” mini-toolbar, giving you a choice of the type of extrusion to be created, as shown:

“Just-In-Time” On-Screen Helps for the Extrusion Tool

The first time you choose the “Extrusion Tool”, the “Helpful Tips on Extrusion” window
appears on your main viewing screen.  It gives an explanation of the process used in
creating an extrusion.  There is an option to turn off “Show Tips for Extrusion” in  the
“Helpful Tips” window in the lower left corner of the window.

To turn the “Show Tips for Extrusion” window back on and make it come up on your
viewing screen again when you choose the “Extrusion Tool”, go to the “Help” menu.
Choose the “Show Tips for” menu item, then choose “Extrusion”.
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How the Extrusion Tool Works
Since the extrusion tool works with lines you have previously created and then extrudes
them, it is important to create the lines or faces that you want to extrude first.  This is
done with the “Line” or “Face” tool. The tools can also be accessed from the “Draw”
Menu.

Create the base (top or bottom)  of the object that is to be extruded.

Note: You do not have to use the “File/Calc3D” command before extruding, but you will
save time and get a much better extrusion if you do.  More specifically, the “extrusion”
tool will automatically place the extruded points in the correct locations in the image if
the image camera and the points to be extruded are already located in 3D.  Otherwise, the
points will just be extruded in the image parallel to the extrusion line that you draw and
you will have to select them individually and move them to their “real” locations.



3D Builder  Extrusions 177

Click on either the  extrusion toolbar icon from the mini-toolbar or
click on “Draw Menu/Draw Extrusion” from the menu.  The cursor
changes to the extrusion tool.

Select the base lines and/or faces to be extruded.  These will be highlighted. Hold
down the shift key to “multiple select” lines.

Once you have selected at least one line, the “Draw Path” button on the extrusion mini-
toolbar will be enabled.  Click on the “Draw Path” button on the
extrusion mini-toolbar.  If you know that you are going to be
extruding along the X, Y, or Z coordinate direction, indicate this by

clicking  on the appropriate button on the     extrusion mini-toolbar.

Next, pick a point on the base, then click, drag and release the left
mouse button to define the direction of the extrusion.  Release the left
mouse button at the desired location.  The extrusion has now been
created.

When you release the left mouse button, the base will be extruded parallel to the line you
have just drawn, and the cursor changes to display “moving points”.

Use the mouse to move each of the generated points of the extrusion to match up with
their actual location in the photo.  Do this one at a time, clicking down on the newly
generated point with your left mouse button and move it to their proper location in the
image.  The extrusion follows the mouse movements.

Note: If the image camera and/or the base points were not already located in 3D (by a
“File/Calc 3D” command), then these newly created points will have a question mark on
them when they are first displayed.  You may need to move several points if there is a
significant amount of perspective in the picture.  After you have moved a point, the
question mark will disappear.

If you have indicated that you were extruding along the X, Y, or Z axis, use the “Flip
Axis Sense” button icon on the mini-toolbar to set the direction of the axis.

Note: Remember to keep everything in a right-handed coordinate system!

If you want to continue making more extrusions, click on the “New”
tool.  This resets the tool to draw another extrusion.  Or go back to
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the toolbar and select a different tool or another operation. This helpful hint will also be
displayed in the Status Bar.

Editing the Results of an Extrusion
You may edit the results of an extrusion at any time. The extrusion is simply a tool which
generates some parallel lines, some faces, some equal length lines and some parallel
constraints on those lines.  You may edit any of those entities jut as you had created them
using the “Draw Line”, “Draw Face”, “Make Parallel”, or the “Make Equal Length” tool.

 Select the “Selector Tool” (Arrow tool) and select a point on the extrusion. Then click,
drag, and release the left mouse button to fine tune points on the extrusion.

Viewing the Results of an Extrusion
If the base points and the image camera were already located by a “File/Calc3D”
command before starting the extrusion, then a full 3D model will be created by the
extrusion tool and may be viewed immediately in the 3D Preview window.

If the image camera and/or some of the base points were not known, then you will need
to select  the “File/Calc3D” command first.

Useful Notes on the Extrusion Tool

1.  You can also select a face to extrude by drawing a “bounding box” around the face.
It is best, however,  to simply click on the “face”; then the points and line associated with
the face will be automatically be selected.
2.  Be sure to select one of the “axis” (x,y,or z) if the line extrudes in any of those axis
planes before drawing the extruded path.
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3.  After selecting the “path” for the extrusion, make sure that the line direction is
correct.  If not, use the “line flip” tool to change the direction of the line path.
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PHOTO TIPS FOR IMPROVEDPHOTO TIPS FOR IMPROVED
ACCURACYACCURACY

Take Good Pictures...Build Great Models!
The taking of good pictures is very important for making good 3D models with 3D
Builder. Taking a little extra time in planning your photo session before you take
pictures is  well worth the effort.  3D Construction Company offers these tested tips for
getting better quality of photographs to use in your 3D modeling project and for
improved accuracy.

Avoid the frustration of coming back from a photo shoot, discovering that one
critical area of the model could not be processed because there were not enough visual,
natural cues in the photo to locate the camera. This is particularly a problem with objects
that do not have a lot of natural X, Y, or Z axes features.   So, when in doubt, place a few
targets and take measurements.

 3D Builder offers you a lot of flexibility and a lot of choices in the data that its
powerful, comprehensive math solver can process.  Of course, the more accurate the
input, the more accurate the 3D model will be. Film is not very expensive, but time is.
Take lots of pictures.

Plan Ahead
Planning is one of the essential keys to successful photo sessions.  If possible, plan

your photo “shoot” on paper before arriving at the site.  This action saves a lot of time
and frustration when you are on the site, especially if site time is limited. It takes time to
complete a photo shoot of an object to be modeled.  It is expensive, especially in terms of
time, to have to go back and repeat the photo shoot.  In some cases, the location may be
remote, dangerous or have been completely removed.

Planning how and where you want to set up your camera stations is also time well
spent.  Determine ahead of time which key points of interest you want to be included.
Plan to take more pictures than you think you will need.  Film is cheaper than time in

 Chapter
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most cases. You do not have to use all the photos that you have taken in your 3D
modeling project.  3D Builder gives you the option and flexibility of adding additional
photos to a project at any time. But taking many photos insures that you will have several
good quality ones to include in your project.

3D BUILDER has provided a “Planning and Field Notes” forms pack for you to use.
A small sketch of the project and camera station locations proves helpful.

Equipment Needs
Make a list of all the equipment (lenses, props, targets, measuring devices) that you

think you may need and assemble these together in a central location. If you plan to use
targets as reference points, choose targets that are big  enough to be seen when viewed
through the camera viewfinder.  A camera tripod avoids a lot of blurs.

Location Is Important
Choose the location before the day of photography.  Plan camera stations to get

various angles of the object.  Widely spaced camera stations get the best results.
Check for obstacles and obstructions of sighting.  If possible, go to the site ahead of

time and check through  the viewfinder. Be sure the camera stations are neither a safety
hazard to you or to others.

Obtain any necessary “permissions” from owners to avoid any problems later.

Several Pictures From Widely Spaced Angles
Try to take several pictures of the object to be modeled.  These pictures should be

taken from widely separated angles, close to 90 degrees, if possible.  3D Builder
recommends using the Field Guide Forms included with your 3D Builder program to
record and sketch out the positions (camera stations)from which you took the photos.
Film is cheap, so take lots of photos.

Overlapping Coverage Of An Object
The ideal scenario is to have overlapping coverage so that the same key points of interest
appear in more than one photograph.  The more points that are common to multiple
photos, the more accurate your model will likely be.  In fact, key points that show up in
three photos from three different widely spaced camera stations is better.

The following examples show a good camera station layout: Notice that the camera
angles overlap to provide a good coverage of the entire object.

 If taking photos all around the object, take from the corners, and overlap



3D Builder Photo Tips for Improved Accuracy 182

Figure 126  Good coverage is obtained by overlapping angles

If taking front of an object, such as a building, take from these angles

Figure 127  Take angled shots for better coverage

Notice that the key points appear in all three photographs.

Photographing A Small Object
If you are photographing a small object for modeling, place a light object on a dark
background to improve the contrast.  Place a dark colored object on a light background.
Glare is of special importance when photographing a small object.  Be sure that the
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lighting has been checked to reduce the glare bouncing off any shiny parts, especially the
background.

Different Camera Heights
Having camera stations of different heights is another way of obtaining key points of

interest in multiple photos from differing camera stations.  Camera stations may be
placed low to the ground.  Check carefully through the camera viewfinder, however, to be
sure bushes or other obstructions are not blocking the key points of interest you want on
the photo.

Camera stations may be taken from heights.  Examples have included pictures taken
from on top of a ladder, from a rigid pole, the rooftop of another building, and a bucket
truck.  Care will need to be taken to keep the camera steady.  3D Builder can also use
photos taken from a helicopter or airplane, although it is very difficult to pinpoint the
actual camera station location.

One Photo
If you can take only one photo, take from an angle.
 You will not be able to model the back side of the object, however, as we show in the
post office tutorial, a lot of information can be used from only one photo.  In many cases,
you can go into a CAD program and mirror the other side still have a complete model.

Figure 128   A "One-Photo" shot should be from an angle

A camera station taken from directly in front of the object is not good.

Mixed Lenses
3D Builder can accept photos taken with different lenses.  These can be used together
within a single project.  This enables you to take close-ups of key interest areas. Again, it



3D Builder Photo Tips for Improved Accuracy 184

is helpful when taking the photos to mark the changing of the lenses and camera stations
on the Field Guide Forms.

Problems:
 Bad camera angles  too close together

Figure 129 Camera Stations need to spaced widely apart

Bad coverage
One of the most common mistakes made by beginning photographers is to take pictures
from too far back away from the object.  Try  to place the camera stations so that the
viewfinder of the camera is filled with the object.  Choose a mid-range lens.  The closer
to 50mm lens, the less lens distortion.

Obstructions In The Way
In some cases, the key point cannot really be seen in the photo because of a bush or

similar obstruction.  In many cases, 3D Builder can still convert the 2D information into
a 3D model.  3D Builder uses an “Approximation” tool feature to help you place the
point in an approximate position.  3D Builder then combines other information to
overcome the lack of precise point placement.  You could also use background
construction lines as hints to build the model.  You would need to select the line, and
label it as background.  Be sure not to mark these construction background lines as part
of the exported model.

Lighting Changes
Check your lighting at the beginning of the Photo Shoot and then re-check again

near the middle as lighting can change during a short space of time. Shooting into the
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sun can be a problem as you walk around an object. Be wary of automatic cameras.
Instead use a camera with a light meter that can focus on the object. Be sure to include
film for both bright sunlight  and overcast or cloudy conditions.  Generally, early
morning is the best time for taking photos. However, taking the photos near noon will
reduce the length of the shadows.

Set-Up Takes Time
Expect that it will take several times as long to setup/mark/measure as it will to

actually take the pictures.  Check the setup from a distance.  Often you can see what
needs to be adjusted for a better setup before you begin.  Start and end the photo shoot by
taking an overview shot from a distance.  This gives a good reference later for the
project.  Make sure the object does not move (unless you are trying to capture motion).

If This Is A Critical Project
Have a second person independently repeat measurements and verify all field notes.

Recheck all field notes before breaking down the shoot. A second person is very helpful
in many ways--from helping with the setup and moving of equipment to keeping other
people from moving targets or equipment.

Know Your Camera
Learn as much about your camera as you can. A basic book on photography is a good

investment.  So is spending some time with the people at your local camera and
photographic supply shop.

Basics Count
Check to see that your film is loaded properly; check that your batteries are fresh,

and be sure the lens cap is off.  Fill the frame with the object and targets.  Keep a
constant focus setting  if possible.

Targets Improve Accuracy
Targets are work, but they do improve accuracy.  Use contrasting color targets.  Put stick-
on targets on curved parts of the object. A wide angle lens needs BIG targets. Mark target
locations with chalk, and you may need more than one color of chalk.  Where to place
targets is always an issue.  Try planning a grid for the object and put targets along the
grid.  Try to make sure you can see the same target in photos taken from two different
camera stations.  Spacing your reference targets widely apart improves accuracy.
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Measurements Help
One of the quickest and easiest ways to improve the accuracy of a model is to take a few
measurements.   Measure the distance between at least two points of interest.  For
example, if you are taking photos of a building, measuring the base wall of one side of
the building is a good choice.  Rounded edges make it more difficult to get accurate
measurements.  Taking a few measurements also help in setting the scale of the model
more accurately.
It’s a good idea to measure each target -to- target distance.  This triangulation of targets
is a valuable reference later on.  If your measuring device reads both inches and decimal
feet, choose one and be sure you record the same method each time you measure.
Measuring the camera height before you change it helps.

3D Builder deals predominantly with points. You will need to locate points to build your
model.  Many objects, such as buildings have natural features so that points are readily
visible in the images without any special markings before taking photographs. Other
objects, such as curved smooth surfaces, lack natural features.  You will need to prepare
these before the photo shoot by putting some form of “reference target” on them.  If you
are trying to build a accurate model, then you should carefully place a small number of
reference targets in the scene, and carefully measure the distance between these reference
points.  You will input these measure distances into the program by constructing lines
between the points and setting the measured lengths of the lines.

Cropping of the Photos
3D Builder can deal with minor cropping (typically from a photo lab).  Major cropping
lessens your accuracy.  You should not use cropped images or crop the images during the
scanning of your prints.  If you use cropped images, expect that your accuracy will suffer.

After The Shoot
Going over your field notes as soon as possible after breaking down the shoot avoids

errors.  Consider using a 1-hour photo finishing service for making quick “proofs” to
check your work.  But be sure to tell them NOT to cut the negatives if you plan to use
Photo CD.  Use these proofs as you work with 3D Builder as a “hands-on” reference
story-board later on.  Number the photos as the ones you add to the project.

Summary
The taking of quality photographs is one of the most important requirements for building
a good 3D model.  Many photographic mistakes can be compensated for in the 3D
Builder program. Many of the program’s tools are designed to deliver a 3D model,
without the need for a professional photograph.  However, investing some time and
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practice beforehand will reap big dividends when a major project comes around.
Investing in a good basic book on photography (or finding a knowledgeable resource
expert on the subject) is also time well spent.
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ACCURACYACCURACY

Introduction
Accuracy will vary widely, depending on the type of camera and lens used, the way in
which the images are scanned, and the number and type of ground measurements taken.
3D Builder offers a calibration program which will calibrate the camera/ lens.

The highest absolute accuracy requires calibrated camera lenses.  The 3D Builder
calibration “Wizard” is used for calculating focal length  and will substantially improve
accuracy. The calibration process is simple. The Calibration “Wizard” is described in a
separate “3D Builder Calibration Guide” booklet.

The process or steps in going from the 2D real world to the 3D model are shown below.
Some distortion may be introduced in each of these steps.

Digital cameras are easier to calibrate because they have fewer sources of error.  The
tradeoff , except for the high end digital cameras, however, is reduced pixel resolution.
Note:  when scanning prints from photographic enlargement from negatives, distortion is

Chapter
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introduced both from the original camera lens, in the enlarger, projector lens, and in the
image scanning.

3D Builder will automatically compensate for the cropping that occurs during
photographic enlargement and with many film scanners (including  Photo CD).  More
specifically, using the available information from the picture,  3D Builder will calculate
the amount of cropping.

3D Builder uses “sub-pixel positioning”, so the accuracy of the placement of points is
determined by image resolution, the size and type of target features in the scene, and the
time the operator is willing to take for the process of “zooming in” when locating points.

To achieve better accuracy, tighten up the accuracy along each part of the chain, or
eliminate parts of the chain (example, use a digital camera instead of a print scanner.)

Sources of Error
• Camera lens focal length *
• Camera lens optical decentering*
• Camera lens distortion**
• Film flatness in camera
• Film flatness in photo enlarger
• Photo enlarger optical decentering*
• Photo enlarger lens distortion**
• Print paper flatness in enlarger
• Cropping in enlarger*
• Cropping in scanner*
• Scanner sampling resolution
• Scanner position accuracy
• Location of target points in image by operator

*3D Builder Pro automatically compensates for these sources of error.

**3D Builder Pro automatically compensates for these sources of error if the lens has been
calibrated with 3D Builder Pro.

If you are working on a project where accuracy is a major concern, you will want to
calibrate your camera lens with the 3D Builder calibration “Wizard”.
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Other Accuracy Features in 3D Builder

3D Builder includes tools for control points and perspective matching.  This includes
tools for entering known control points or 3D point locations.  3D Builder will produce
the camera position accurately.  You can input a variety of known measurements types
into 3D Builder, including known “x”, “y” and/or “z” coordinates of control points and
known lengths of lines between points. You can use known camera points if you have
them.  The known camera height is often very easy to measure and can be used.  The
program has a full triangulation solver and can accept linear measurements
(measurements between points for example).

3D Builder  also uses a number of tools to improve the usability of models by forcing
vertical surfaces to be vertical and horizontal surfaces to be horizontal. The program  also
use a series of constraints, for example, that force parallel lines to be parallel and
imposing similar sets of constraints.  In addition, 3D Builder has tools for forcing
geometry to align with the major coordinate planes.

How to Improve Accuracy
• Place targets on the object being modeled.
• Calibrate your camera/ lens.
• Use a higher resolution digital camera.
• Use a high resolution film scanner rather than scanning from prints.
• Use a better scanner.
• Place targets on the object being modeled.
• Use good lighting (makes features easier to pick in photos).
• Place known measured objects in the scene for reference or independently measure parts

of objects.  3D Builder will adjust the model to agree with known measurements
• Frame objects so they fill the image area (picture area as seen through the view finder of

the camera).
• Take more pictures, take close-up pictures of objects of interest.

  

How to Determine Accuracy
Taken together,  the camera, the  scanner, and 3D Builder are a sophisticated measuring
instrument.  Any instrument  used where accuracy is important  should be calibrated, and
the camera/scanner/3D Builder combination is no different.

Take one or more objects which are of the same size and type as what you will be
working with, measure them by an independent means, and then take three  independent
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sets of pictures of the objects.  Process each set of pictures as a 3D Builder project.
Comparing  these results to the independent measures of the object will give you a
reliable measure the accuracy of your camera, scanner, 3D Builder combination in the
particular domain that you are using.

The best results that may be obtained with 3D Builder are in the range of 1 part in 3,000
(0.3 mm on a 1 meter object).  This level of accuracy requires a carefully calibrated high
resolution digital camera.  At the other end of the accuracy scale, people using 3D
Builder for rapid conceptual modeling where accuracy is not as important will typically
be getting between 1 part in 50 to 1 part in 200 accuracy.
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Camera Lens CalibrationCamera Lens Calibration

All camera lenses have some distortion.  Objects that are straight lines in the real world
may project onto the film as slightly curved.  This is most apparent with extreme wide
angle lenses, such as shown in the figure below.

The effect is present in all camera lenses, to a greater or lesser extent.  This is why, when
accuracy is  important, camera calibration should be used.  The calibration feature of 3D
Builder can calculate the camera focal length (Pro and PowerLite versions) and optical
decentering and optical distortion (Pro version only).  Once a lens has been calibrated,
3D Builder will  and then automatically compensate for distortion when calculating 3D
models.

The “Calibration Wizard”, accessed by clicking under the “Tools/Calibrate Camera
Lens” menu will step you through the calibration process.

Chapter
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There are two types of calibration: (1) focal length only, and (2) full calibration for
distortion and optical centering.  Focal length calibration requires two pictures of four
targets placed on a wall, forming a rectangle.  This procedure is described in this chapter
and can be accomplished in about 10 minutes.  Full calibration for distortion and optical
centering requires 6 to 9 pictures of a number of targets placed in rectangular grid
patterns on two perpendicular walls.  This procedure typically takes three hours to
perform, is only available in the 3D Builder Pro version, and is described in a separate
booklet.

Preparation
Attach the four targets in your 3D Builder package to the floor or wall so that they from
a precise rectangle.  The height and width of the rectangle do not have to be the same,
but we recommend that they differ by no more than 50%.  The rectangle should be large
enough that the image is in sharp focus.  We suggest at least 1 meter on a side, preferably
larger.

Take two pictures of the target square from skew positions as shown.

The accuracy of your calibration will be dependent on how accurately the four targets
form a true rectangle.  An easy way to make a precise rectangle is to use calculator in the
Calibration Wizard which will give you the exact diagonal dimension for the rectangle if
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you tell it the height and width.  Simply use a tape measure to position the targets at the
correct height, width, and diagonal.

Using the Calibration Wizard
The Calibration Wizard is launched from the Tools/Calibrate Camera Lens menu.  For
focal length only, calculations the Calibration Wizard steps through most of the same steps as
the Insert/Camera Lens command.  See the section titled Insert Camera Lens in the chapter
on Menus.

The “Focal Lens Calibration Wizard” can also be launched from the “File/New Project”
menu selection.  Choose “Lens calibration wizard” from the “New Project window, as
shown.
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Select "Finish" to exit the Calibration Wizard.  You will also need to select "OK" to close
the calculation progress reporter if you have not already done so.

Note: IMPORTANT:  When you exit the program or open another project you will be
prompted "Camera lens have been added, deleted, or modified. Save changes to
lens.dat?".  Be sure to select "Yes" or the lens calibration values will not be saved to disk.

You may use the same calibration project for more than one camera lens.  Just start the
“Calibration Wizard” again from the “Tools/Calibrate Camera Lens” menu and select
the next camera lens and the appropriate image.

The results will be more accurate and well worth the time taken in calibrating the camera
lens.

Remember: Each camera/lens must be calibrated separately.  However, once the
camera/lens has been calibrated, it will be accurate for all 3D Builder projects using
that camera/lens.
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WHAT DO I DO IF?WHAT DO I DO IF?

This chapter includes information about possible problem or unusual scenarios that may
occur in your working environment.  It discuses how to solve the problem in 3D Builder.

Unknown focal length of the camera
If the focal length of the camera is unknown, 3D Builder can estimate it for you.  Give
3D Builder a start by putting in a “best guess” estimate for the focal length of the
camera.

Put in several “X,Y, and Z” axis hint lines.  Make sure these are fairly long lines.

Note: This will give you a “rough estimate” and should be good enough under the
circumstances for a “starting point”.

 Chapter
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Double click the left mouse button in a blank area of the image screen to bring up the
“Image Properties” box.  The “calculated” focal length appears in the “Image Properties”
box.

Unknown camera type
If the camera type is unknown, bring up the “Camera Lens Tab Pages” by right mouse
button clicking in an empty area of the screen.  This dialog box will bring up the “pop-
up” menu. Then, click on “properties” with the left mouse button.  On your screen will
appear the “Camera Lens”.
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1. Click on the “New” button.
2. Give Camera/Lens a name.
3. If focal length is known, put that information in the focal length box.
4. If you do not know the type of  camera or none of the listed cameras seem to be

correct, choose the “Blank” item , the last item in the  drop down list box.
5. If the Target Height and Width is known, put that information in the “Target

(Film Height) and “Target” (Film Width)
6. If the Target Height and Width is NOT known, click on the “Estimate” button to

the right of the dialog box.  This information brings up the  “Estimate Camera
Target Height and Width” Dialog Box.

 
 The  “Estimate Camera Target Height and Width” Dialog Box will guide you

through the estimation of the camera target size.
 
 
 
 
 
 
 
 
 
 

If  neither the focal length or target height and width information is NOT known, go to
“Estimate” and take your best guess to give the 3D Builder program an initial starting
point.  In most cases, 3D Builder can estimate the focal length for you after the
calculation process has been completed.

       6.    If the camera is a digital camera, fill in the image height and width and internal
magnification.  This information can be obtained from the camera manufacturer.

Camera not on 3D Builder “camera list”
Camera companies are coming out with new types of cameras almost weekly.  Our
camera list will be updated as camera information becomes available.  If the camera used
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to take the photos is not on the 3D Builder camera list, it can be added easily. The
instructions are similar to the “Unknown camera type” above. This dialog box may also
be accessed by “right mouse clicking” in an open area of the main image screen to bring
up the “pop-up” menu. Then, click on “properties” with the left mouse button.  On your
screen will appear the “Camera Lens Properties box”, as shown In the above section of
text.  This time, select  the “New” button to the right of the “Camera Type” drop down
list box by clicking on it.  This action brings up the “Camera Lens Property” box.  Add
the name of your camera type and lens by typing in the text box “Name, Camera/Lens” as
shown below:

No measurements known
Set some artificial  values and everything will scale from these.  Look closely at the photos for
objects to help you with this estimation.  For example, entrance doors are usually a standard
6’8” in height and usually 3’0” in width in the United States.  From just these kinds of initial
estimates, 3D Builder will scale the rest of the 3D model proportionally.

No reference marks visible in the photo

Look carefully at the photos to determine if there are any visible features in more than one
photo.  If there are, use them to help you get the modeling project started.  Zooming in on the
photos may help you see natural features that can be used as target areas.

If the photos have not yet been taken, plan to place a few targets or reference marks on the
object.  Colored dots, tape, stickers, chalk, paint, pencil….all of these have been used as
targets on objects.  A few targets in some key places on the objects, visible in more than one
photo, will make your job of modeling so much easier and faster.
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Pictures taken by someone else and “Handed to You”
         If Accuracy important:  First, get as much information from the person who took
the photos as you can.  For example, the type of camera and  the focal length of lens
used.
If this information is not known, you will need to give 3D Builder an initial start by
filling in the “Camera Type” from the “Camera Lens/Image Properties” box.  Refer to the
“Unknown camera type” section of text described above.

3D Builder cannot work with photographs that have been greatly cropped.
If you find yourself in this situation and you have access to the negatives, give one of our
technical staff a call and we will discuss some techniques that have been moderately
successful for us.   3D Builder can work with photos that have been slightly cropped as
in Photo CD.

 If possible, return to the scene and make a few measurements.  This would greatly
help in making your model more accurate.  If this is not possible, then go ahead and
begin your 3D Builder project by adding the images.

When working with the images in your 3D Builder project, use extra care in placing
the points on the photos.  Zooming in helps in accurate placement of points. Remember,
the more points you can tie or “merge” together in more than one photo, the more
accurate your 3D model will be.

If you have access to the camera and lens used to take the photos, use the 3D Builder
calibration chart and calibrate the camera lens. Refer to the chapter in the User’s Manual
for details on the Calibration process.

If accuracy not important, as in a conceptual modeling project:  Estimate the focal
length of the camera lens.  Try to place the points as best you can to create an initial
starting model.

No natural right angles and parallel lines in the photos
3D Builder needs a rough estimate of the direction the camera that took each

picture was pointed in.  You give this information to 3D Builder by drawing in pairs of
x, y, and/or z coordinate axis lines in each image.

If there are no natural “x”, “y” or “z” axis lines in the picture then just imagine a
cube somewhere in the scene and rough in two pairs of edges for the “cube”.  Be sure to
use the same convention for all images.  That is, if you decide that the “x” axis is pointed
in a particular direction in one picture then be sure that the “x” axis is pointed in roughly
the same direction in world space in all pictures.  Most people put the “z” axis up.
Select the “? Axis” (axis hint) toggle on the toolbar when creating these lines so that 3D
Builder will not assume that the lines are exactly along the world “x”, “y”, and/or “z”
coordinate axes.   If you forget to do this, the “File/Calculate 3D” command will give
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bad results because it is trying to match the axes exactly.  In this case, go back and select
the lines.  Then from the toolbar, change the axis from “X Axis” to “X Axis Hint”, “Y
Axis” to “Y Axis Hint”, and so forth.  Alternatively,  you may double click on each line
and check the “Approximate” checkbox next to the axis/plane field.
Keep in mind that parallel lines, when not viewed from the perpendicular line of sight
seem to come together in the distance, like looking down a set of railroad tracks.

Need to know the location of a point or “point location”
After doing a 3D Builder “Calculate 3D” from the toolbar button or from the “File

menu/Calculate 3D”, the calculated “X,Y, and Z” location for each point can be viewed.
Double click (or right mouse button clicck) on the point to bring up the “point properties”
box.  The calculated “X,Y, and Z” location is shown for the point.
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Need to know the length of a line
After doing a 3D Builder “Calculate 3D” from the toolbar button or from the “File

men/Calculate 3D”, the calculated length of each line can be viewed.  Double click (or
right mouse button click) on the line to bring up the “Line Properties” box.  The
calculated length of the line is shown for that line.

Point location is unseen/blocked by something
Use the “Approximate” Point Tool on the toolbar.   First, click on the “Point” tool

either on the toolbar icon or by the “Draw/ Draw” menu.  Then click on the “?XY”
toolbar icon which is the “Approximate tool”  Locate where the point location is
“thought” to be and click with the cursor there.  The newly created point appears on the
photo image with a “?” on it to indicate that the point location is not absolute.

Here are three examples from a building, where the point cannot be seen in any photo:
• Measure from roof down to the ground
• If you are working with a building and you can see clearly the end points of one

corner wall, but not the other, you can tell 3D Builder that line “Z1” and “Z2”
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are parallel and equal. (this corner and that corner are parallel and equal and
you can clearly see corner “1”, but not corner “2”)

• Use a control rod of known length (a piece of electrical conduit 4’ placed against
corner, with end resting on the ground.  Now the top of the rod can be seen in
two photos and the point in question is 4’ below.

Suggestions for complex, organic objects or objects with unusual
shapes…

If possible, shoot on or against a known grid.  A tile floor, a tiled corner, a wall with
vertical and horizontal stripes. Show the grid table and lay out several “X,Y, and Z” axis
lines before photos are taken. Put reference marks or targets on the object, such as tape,
magnets, stickers, chalk, paint, etc. Shine a grid onto the object.

Model due YESTERDAY!  Need model ASAP
Take a few moments to read the chapter on “Taking Better Photos” in the User’s Manual.
Use a digital camera.  They can often be rented if you do not own one.  You can use a
Video camera, but be sure you have access to a digitizer or frame grabber. Place targets
on the object. Take a few measurements before you take photos. Make sure you take
overlapping photos, so that key features appear in more than one photo. Begin the 3D
Builder project as described in the “Getting Started” section of the “User’s Manual”.

Have Pictures, but no negatives
Best suggestion is to have the pictures scanned, using the best scanner you can find.

Be aware of cropping errors.  Try to line the photos up in the same corner of the scanner each
time.  Be sure to try to keep the photo flat.

Have pictures AND negatives, BUT need to model ASAP

IF accuracy IS important:  Depending on the time factor, scan the photos from a
high quality scanner, such as a  “Negative scanner”. Photo CD will give you better results.  In
many areas, you can get a several hour turnaround for Photo CD.

IF accuracy is NOT important:  Have pictures scanned and work from those to begin
the model.

I am Having Trouble with Texture Maps in Wavefront and/or
Inventor files: Go to Tools/Settings/Defaults…

The second tab page is the “Defaults” page, which allows you to set defaults. There is a
checkbox for using an “odd size .JPEG texture map” size.  This is necessary to work
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around a Netscape 3D bug.  When the check box is in the checked position, an odd sized
texture map is created.  If you experience difficulty in your texture map using Inventor or
Wavefront, be sure to “uncheck” this box as both of these files expect an even number of
pixels in the texture maps.  Also see the “Menu” chapter of this User’s Manual, Tools
menu.

How Do I Delete a Photo from a Project ?
You may delete a photo from the project from the “Project Window”.

• From the “Window” menu, choose “Project ”.
• Expand the project control tree to show the “Stations/Photos” branch.
• Stations/Photos  Gives a list of the camera stations and individual photos
identified in the project. Click on the + sign to expand the tree control level.
• • Click on camera stations, select the photo and click on the “Delete” key.

I Keep Getting An Error Message when I Calculate…What Am I
doing Wrong?

Modeling errors are the usual cause of the calculate error messages.  Here are a list
of the most frequently found modeling errors (from looking at customer projects):

• Check lines to see if they are the correct axis and direction.
• Check faces to see if they are the correct plane and type of polygon (example, 4
point rectangular polygon when you meant to have just a 4 point polygon)
• Check points to see if they are placed correctly.  A pixel up. down, left, or right
can sometimes make a difference in the accuracy level.   Zooming in on the area
where the points are being placed is a tremendous help in accurately placing points.
Also, check to see if you have placed the correct type of point (example, placing a
grid point instead of a ‘single’ point)
• Check curves and circles to see if they are set correctly as to plane, open/or
closed.
• Make sure “same” or “merged” points are really merged. (Highlighting one
point with the select tool will make the merged point highlight in the other image).
• Make sure you do not have points “stacked” on top of other points (or lines on
top of other lines, or faces on top of other faces). To correct this:

• Point: select it, move it over and see if there is one (or more) under it.
If so, select the duplicate point and delete it with the “Del” key.
• Line: select the endpoint, move it over, see if there is another under it.
If so, select the endpoint of the undesired line, and delete it with the “Del”
key. look in “status Bar” at bottom of screen, noting the number assigned to
the line.
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• Face: select the face (it highlights), look in “status Bar” at bottom of
screen, noting the number assigned to the face. Use the “Make Behind” tool
from the Make/Make Behind menu, put the 1st face behind. Select the
currently showing face, check its number in the “Status Bar”. If it is a
different number, there is a duplicate face. Decide which to delete and use
the “Del key”.

I Get A Message after Calculating: Lens Focal Length Conflicts
with Actual…

Refer to Appendix A for the correction to this error message.

Other Error Messages Upon Calculating…
Refer to Appendix A for the list of the most common error messages and what to do to
correct them.

The Password For the License that I Typed In Does Not Work…
The most common mistakes made in working with the License Wizard are either not
giving the correct “machine ID” number (see the chapter on License Authorization
earlier in the User’s Manual) or incorrectly typing in the password key returned to you.
• Check to see that the “machine ID” number that you sent to 3D Construction

Company is the correct machine ID for your machine. This is an 8 character (alpha-
numeric) number located on the same screen in the License Wizard as the field in
which to type in the password. (May be listed as Xhost ID on some machines)

• Check to see that you have correctly typed in the password.
• Use all lower case letters.
• Use “-“ (dash symbol) not “_” (underscore symbol).
• Use “0” ( number zero symbol) not “o” (letter o symbol).
• Use “1” (number one symbol) not “l” (lower case letter “l” symbol

• Check the clock (date and time) on your computer to be sure it is showing the
current date.

• If the above items are correct, contact 3D Construction Company at the number and
address listed below and we will guide you through getting set up.

Other Problems not Listed Here
If you have another type of problem that is not listed here, give 3D Construction
Company a call at 1-543-543-8917, a fax message at 1-423-543-4011,or contact us by
Email at “threedc@usit.net”.  Talk with one of our staff members and we will be glad to
help you find a solution to your unique situation.
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3D BUILDER

CUSTOMER SERVICECUSTOMER SERVICE PLAN PLAN
Registration:

To register your 3D Builder product, complete the registration card included and drop it
in the mail or fax it to us at 1-423-543-4011.

Customer Service:
Call our Customer Service to:

• Register your 3D Builder product

• Order an upgrade

• Request product information

• Change your registration address (You may mail, fax, or phone)

• Request the replacement of missing or defective package parts (disks, CD,
manuals, charts, etc.)

Call Our Technical Support For Specific Questions About Using
The Software.

We are very focused on making this software work for you.  We believe in helping our
customers, providing support to solved problems with large or small projects.  We
provide free technical support.  This support is available to all registered 3D Builder
customers.  If you need help immediately, you can contact 3D Construction Company at
the number listed below.  You will receive more thorough technical support if you Email
us of fax in the Technical Support form, as this gives us more time to study your
problem. Before you call Technical Support, please have the following information ready
to give the Technical Support staff:

•   Which 3D Builder program you are using (Pro or PowerLite)
•   Type of Operating System and Version (example: Windsows 98)
•   How much memory (RAM) your machine has
•   Video Card type (if known)
•   A brief description of what you were doing when the problem occurred

 Chapter
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•   What steps you have taken to try to solve the problem before you called us.
 Having this information readily available will save time and allow us to better help you
resolve the problem.  A Technical Support form is provided for you in Appendix E.

We may ask you to send us the file that demonstrates the problem.  We consider all
data sent to us confidential, of course.  Without the file, it may be difficult to determine
exactly what is going on, find the bug or explain the problem.

If the problem is not urgent, or if you prefer to write, contact 3D Construction
Company at the address listed below.  Include a disk with the problem .B3d file.  We will
also need all the images and all the texture maps used in the project. We will need the
type of camera and focal length of the camera lens (if known).  Be sure to write your
name and address on the disk label.  Support is also available form our Web site. Contact
us at threedc@usit.net.

.  A member of our staff regularly checks for messages.

Customer Service And Technical Support
3D Builder

3D Construction Company
122 Creative Station
Elizabethton, Tennessee USA 37643-5304
Phone 1-423-543-8917, Fax 1-423-543-4011
Email  threedc@usit.net
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APPENDIX AAPPENDIX A

 CALCULATE CALCULATE 3D MESSAGES 3D MESSAGES

Need At Least One Known Point

When you have given a camera height but have not located any points in the scene, this
message is a reminder that you need to locate at least one point.

Figure 130  Calculate 3D error message 'Need at least one known point"
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Need Three Known Points Or Two Pairs Of Axes.

In order to locate and orient the camera, 3D Builder needs either three known widely spaced
non-colinear points, or two widely spaced known points and some lines along the world x, y,
and/or z axes.   If natural cues are available, the latter case is the easiest to use.  One point
can always arbitrarily be chosen as the origin.  If scale is not important then an axial line
from the origin point can arbitrarily assigned a length.  This is the “no measurements at all”
case when using 3D Builder.

Figure 131  Calculate 3D error message "Need at least three known points or two
known axes"
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  Instead  of typing in x,y,z coordinates for three measured coordinates,  you may use one
known point and set the length of two axial lines connected to it.

Figure 132 Two measured axial lines and one known point
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You can always just type in the three known points, of course:

Figure 133 Three known points

Another way of getting three known points is to have measured distances between three
points.  Again, you would arbitrarily pick one point as 0,0,0.  Also arbitrarily assign one of
the lines to a coordinate axis and put the other lines in that plane (xy, yz, zx).

Figure 134  Measured distance between three points
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X Axis Line Direction Conflict

Y Axis Line Direction Conflict

Z Axis Line Direction Conflict

In addition to saying that a line is along the “X”, “Y”, or “Z” axis, you must also specify
the axis direction.  3D Builder has detected two or more lines that appear to be in
opposite directions.  Use the “view filter” command under the “View” menu (or access
via the Toolbar ribbon icon which looks like an eye).

Examine the image to find the lines in question; check to be sure you are using a right
handed coordinate system.  Use the arrow tool to select the line(s) and bring up its
property box.  Change the direction arrow toggle and “OK” the data.

Figure 135  Axes lines going conflicting directions
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X Axes Do Not Intersect

Y Axes Do Not Intersect

Z Axes Do Not Intersect
In perspective pictures, including photographs, lines which were parallel in the real
world will converge to a point.  3D Builder checks for this and reports cases where
parallel lines intersect poorly.  This is only a warning.  Use the arrow tool to bring up the
property box for the end points of these lines and move the points if their positions are
off.

Figure 136  Examples of Good and Poor Axes Lines Intersections

How to Correct This Problem:
• Bring the image up in the window.
• Use the “view filter” command under the “View” menu (or access via the

Toolbar ribbon icon which looks like an eye).
• Select the appropriate axes so that only those lines are shown.  (for example,

only “X’ lines)
• Look first for obvious errors like X lines that are really Y lines.
• If the axes lines are only estimates, (such as using a tree for a vertical) make

sure they are tagged as approximate.
• Double click on each end point of each axes line and use the fine tuning

controls to carefully position the points.  This is the most common mistake made.

Note: This message is only a warning.  There are some cases,
such as when you have  fairly short axes lines that is just not
possible to position them accurate enough that they really do
intersect  at a single point.  In that case, ignore the message.
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Known Points Are Colinear

If three points are being used to locate the camera, they must not lie on a straight line.  In
fact, they should be widely spaced from each other and in different directions.

Figure 137  Point Location recommendations

Note that this problem goes away if you use natural x, y, and/or z axis lines in the image since
only two known points are required in this case.
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Points Not Located Because They Are Visible In This Image Only

In order for 3D Builder to locate a point, the point must either be visible from two or
more different camera stations, or one coordinate must be given or the point must lie
along an axis or plane that 3D Builder can locate.

If the program tells you that it can’t locate a point because it is only located in one photo,
you hopefully will have another  picture with that point located in it. Use the “merge”
tool to tie these points together.

If you are working with only one image and you get this message, then the points need to
be tied together, whose directions 3D Builder can determine.  So if you are working with
a single photo, make sure you have all the points tied together with lines.  State the axes
or apply other constraints to the lines.

Figure 138  Points not calculated correctly
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Points Not Located Because The Other Image(s) That They Are
Visible In Have Not Been Calculated Successfully

This is just a reminder that some additional information is required to locate and orient one of
the other camera stations before some points in this image can be calculated.

Figure 139  Need additional information to calculate correctly

Nominally, 3D Builder has to be able to locate each camera station from which that you
took the picture.  This message comes up telling you that  something is wrong and it
could not locate the camera.  Messages appear describing what is wrong with the picture
in which the camera could not be located, so begin correcting this problem by working on
each individual message.
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Lens Focal Length Calculated From Axes Conflicts With Actual

3D Builder can estimate the lens focal length by examining the angles that world
coordinate axis lines make with each other.  This is not a very accurate procedure and
you should tell the program the actual lens focal length if possible, using the
“View”/Photo Data menu command or by right mouse clicking in an empty area of the
image.  As a check, 3D Builder will warn if its estimated value is substantially different
from the stated lens focal length.  This may be a symptom of incorrectly placed lines or
lines that are not really coordinate axes, or the stated lens focal length may be wrong.

Figure 140 Lens focal length conflict

• First, double click on each of the end points of each lines and use the fine tuning
tools to make sure that they are lined up correctly.

• Secondly, go to the image and look carefully at each of the X”, “Y” and “Z” axis
lines and verify that they really are “X”, or “Y” or “Z” axis lines.

• Also, go back and re-check your Field notes to be sure you have entered the camera
information correctly.

In some camera orientations, the estimation of the focal length is very  sensitive to the
positioning of the axis lines, so a move of an axis end point of even one pixel can make a
substantial difference in the camera focal length .  Again, sometimes, especially when you
have really short axial lines, you will need to do the best you can and realize that this message
is just a warning.
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Need To Specify Camera Lens Focal Length

In general you should always state the camera lens used if it is known.  If there are
enough coordinate axis queues in the scene 3D Builder can estimate the lens focal length
(see above), but this is not a very accurate procedure.  Use the Image/Photo Data menu or
right mouse click in an open area of the image to bring up the image properties box.

Figure 141 Need to give camera focal length
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Axis Coordinate System Is Not Right handed

3D Builder requires the “X”, “Y”, and “Z” coordinate axes to be right-handed.  That is, the
“X” axis should point along your thumb, the “Y” axis along your first finger, and the “Z” axis
along your bend second finger.  Use the arrow tool to choose the line(s) to be changed and
then change either the axis name or the axis direction of one the appropriate lines.

Figure 142  Coordinate Systems/See illustration later in manual

• Bring the image up in the window.
• Use the “view filter” command under the “View” menu (or access via the

Toolbar ribbon icon which looks like an eye).
• Select the appropriate axes so that only those lines are shown.  (for example,

only “X’ lines)
• Look first for obvious errors like X lines that are really Y lines.
• Make sure that they really are in a right handed orientation.   

Note: In particular, be on the lookout for very short lines which may have
their direction wrong.



        3D Builder  Appendix B Field Notes Forms

APPENDIX BAPPENDIX B
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APPENDIX C
KEYBOARDKEYBOARD
ACCELERATORSACCELERATORS

Under File Menu:
New Project          Ctrl + N
Open Project         Ctrl + O
Close
Save                       Ctrl +S
Calculate 3D   F3
Exit

Under Edit Menu
Delete                       Del

Under Draw Menu
Point                          P
Line                           L
Circles/Arcs              C
Polygon                     F
Freeform Bezier curve     B
Extrude                     E
Merge                       M

Under View Menu
As Input                   I
As Calculated          U
Select Image            F2
Next Image             >
Prior Image             <
Pan                          N
Zoom                       Z
Zoom In                  +
Zoom Out                -

Under View Menu
All                        A
Properties              D

Under Insert Menu
Photo/Ins               Ins

Under Window Menu
New Window
Cascade
Tile
Arrange Icons
Split
3D Preview         F4

Help Menu
Index
Help                            F1
Using Help
About 3D Builder
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APPENDIX DAPPENDIX D

FUNDAMENTAL 3D CONCEPTSFUNDAMENTAL 3D CONCEPTS

Coordinate Systems
   The term “coordinates” comes from calling numbers “ordinal”.  To ordinate
something is to name it.  In this case,  coordinates refers to locations in space and it
means to number them.  So “coordinates” means to co-number locations in space so you
can find them.

Picture yourself flying a kite.  We can describe the kite’s motion in three dimensions,
left/right, forward/backward and up/down.

                Left/Right

Forward/Backward

                                 Up/Down

 But describing the motion of the kite does not describe the kite completely.  How could
we tell someone else how to locate the kite in the sky?  We would need to locate its
position relative to a reference point. This reference point should be independent of other
objects being measured.  This non-moving reference point is called the “Origin”.  Space
is measured using a coordinate system that is built upon a reference point at the origin,
and the axes radiating from it.

For example, you might describe the kite as being 10 feet south, 8 feet west and 32
feet above the first tall pine tree.  So the kite is located by stating its distance from the
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origin.  The directions we just gave (south, west, up) all have a distance associated with
them.   When we measure along that distance line, that line is called the “axis” line.  The
way these axes are aligned is called a “coordinate system”.  The north/south, east/west,
up/down directions are replaced by the letters “X”, “Y”, and “Z”.
The coordinate system that 3D Builder uses is the “Cartesian coordinate system”,
developed by French mathematician Rene Decartes.  In this system, the axes are at right
angles to each other.  This system is also the most commonly used in computer graphics.

There are two possible orientations of the axes in three dimensions.  They are called
the left hand coordinate system and the right hand coordinate system.  3D Builder also
used a “right-handed” coordinate system.  This means that if you line up your right hand,
your thumb would equal the X axes, your first finger would equal the “Y” axis and your
second finger, pointing up would equal the “Z” axis. This system is also the most
commonly used in computer graphics.

Example of a Right -Handed Coordinate System

2-D Space
Photographs are 2-D, flat objects on the paper.   Most of us are used to identifying

things in 2-D space.  Each point has an address.  Think of a piece of graph paper from
geometry class.  The “X” axis runs along the horizontal grid lines of the graph paper and
the “Y” runs along the vertical grid lines of the paper. The first number is always the “X”
address, the second number is the “Y” address location. So a point address of  (3,4)
would be three coordinate points along the “X” horizontal grid lines of the paper and
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four coordinate points along the “Y” vertical grid lines of the graph paper and would
look like this:

Figure 143  2D Grid showing X and Y Axis Lines

3-D Space
The fundamental difference between 2-D and 3-D is that two dimensions pictures are

flat, while three-dimensional  pictures appear the have volume.  Three-dimensional space
is created using geometry.  At the basis of all computer-generated pictures is geometry.

The 3-D objects are created from 2-D geometric elements (sometimes called primitives).
Although the above example is very simple, it helps to show how 3-D objects are
constructed.  The user describes a surface shape, the program breaks it down into 2-D
geometric shapes.  3D Builder calculates the shape, the placement and the orientation of
an object based on its geometry, such as triangles and rectangles.
A three-dimensional coordinate system, similar to the “x-y” coordinated system in 2-D, is
defined in mathematics as a “world space” with height, width, and depth.  The 3-D
volume is represented by the “Z”-axis.  This space makes it possible to have objects that
not only appear three-dimensional, but can be rotated in three dimensions and viewed
from any angle.
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To select a point in 3-D space, the three coordinates must be listed in the order “X,
Y, Z”.  For example, if we use coordinate point  (2,4,3), we are addressing a point that is
two coordinate points along the “X” axis, 4 coordinate points along the “Y” axis and
three coordinate points along the “Z” axis.

3D Builder uses a right-handed coordinate system.  This being the convention of the
“X” direction being to the left and the right, “Y” in and out of the screen, and “Z” being
up and down.

Points
The basic entity of 3D models is the point.  The terms “point”, “coordinate” and

“vertex” are often used interchangeably.  “Point” refers to a single location in space that
can be located precisely.  A point is not really a “thing”; it is a place where a thing can
be.  The location of a point is specified as three numbers, the distance along the “X, Y,
Z” coordinate axes.  These three values define the point in space.

Lines
     A line is the simplest way to connect two points.  A line describes the shortest
distance between two points.  3D Builder uses the terms “line” and “edge”
interchangeably.

Faces
     A plane is defined as the flat surface that passes through both the line and the third
point.
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     Edges are the sides of polygons.  3D Builder uses the term “face” and “polygon”
interchangeably to describe the area between those edges.  When you create a face, its
points and edges are added to the 3D Builder database.

Axes Planes
There are three natural coordinate planes.
• The “XY” plane contains the “X” and “Y” axis lines.  Points in an “XY” axis plane

have the same “Z” value.
• Similarly, the “YZ” plane contains the “Y” and “Z” axis lines.  Points in an “YZ”

plane have the same “X” value.
• Also, the “ZX” plane contain the “Z” and “X” axis lines and points in an “ZX”

plane will have the same “Y” value.

3-D Modeling
You can learn a lot about 3-D modeling by thinking about the way things are made in the
world around you.  If you can mentally take apart some of the objects around you, you
will get a good idea of how to approach the process of modeling them in 3D.  If, for
example, you have a photograph of a table, in mentally breaking down the table into legs
and top, you come up with a list of faces to be created.

Artists trained in perspective drawing can create convincing simulations of 3D
objects.  This is labor intensive and if you change the orientation of the object, you have
to start all over again.  3D programs allow you to create three-dimensional objects that
are displayed on the screen.  Once these are created, they can be viewed from any angle,
scaled or rotated.  You use point, line and face tools to create 3D objects.

A photograph can capture a lot of information quickly and inexpensively.  With 3D
Builder, you can use the information on a photograph and convert it into a 3D model.
Use the calculate tool to begin the 3D Builder calculation process for converting the
information given about the photo image to a 3D model. The “Calculate” commands
begins the 3D Builder calculate process.  3D Builder does the complicated math  for you
and figures the x, y, and z coordinates.
3D Builder fosters some very sophisticated tools to locate the points, lines, and faces in
3D world space. It also calculates the distances between points, lines and faces.  3D
Builder creates the 3D model for you. With the special 3D Preview window, you can take
a look at the model before you export the files.  Then, you export the file to a rendering,
CAD or animation package.  3D Builder has the technology targeted at saving you time
and money, and a lot of frustrations.
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APPENDIX EAPPENDIX E

Technical Support FormTechnical Support Form
3D Builder Software                [  ] Pro                      [  ] PowerLite

Version__________Build__________(from About Box)

Hardware       RAM, in  MB____________________

Software       [  ] Windows NT, Version ____          [  ] Windows 95
                                   [   ]  Windows 98
Please Print or Write Carefully.
What Type of Objects are you Modeling?______________________________________
Number of Pictures Used?_____
What kind of Camera took the Photos?_______
Brief Description of the
Problem_____________________________________________
________________________________________________________________________

What specific steps in the modeling process were you trying to do when the problem
occurred?_______________________________________________________________
________________________________________________________________________

What steps have you already taken to “workaround” or solve the
problem?________________________________________________________________
________________________________________________________________________
_______________________________________________________________________

FAX this form to: 3D Construction Company, 1-423-543-4011.

Email to: threedc@usit.net

Your Name______________________________________________________________
Your Telephone Number____________________Your Fax Number________________
Your Email address_______________________________________________________
Best Time To Call You_____________________________________________________
Today’s Date_______________________________Time_________________________
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INDEX

—?—
?Axis Line Tool Icon, 64, 65

—0—
0,0,0. See 0,0,0 point
0,0,0 point, 29

—1—
1-hour photo finishing service, 182

—2—
256 color, 16
2-D, 221
2D information, 180
2-D Space, 220

—3—
30 day trial evaluation, 19
30 day trial period, 38, 112
35mm camera, 25
35mm cameras, 137
3-D, 221
3D Builder Calibration Guide, 183
3D button, 32. See Calculate button
3D CONCEPTS, 219, 224
3D Construction Company, 1, 3, 4, 119, 176,

202
3D Geometry, 32
3D model, 182
3-D Modeling, 223
3D models, 222
3-D objects, 221
3D Preview, 22, 52, 76, 116, 153, 154, 2-217,

223

3D Preview Window, 41, 45, 55, 116. See
Preview

3D space, 76
3-D Space, 221
3D Studio, 15, 22, 56, 84, 145, 147, 149, 154
3D View, 116
3-D volume, 221
3-point polygon, 67, 129. See Polygon tool

command. See Polygon tool command

—4—
4 Point Polygon RECTANGLE, 67
4 Point Polygon RECTANGLE Tool Icon, 129
4 Point Polygon Tool Icon, 67, 129

—5—
50mm lens, 180

—6—
640 by 480, 121
640 by 480 VGA screens, 23

—8—
8 character filenames, 149
800 by 600, 121
800 by 600 SVGA screens, 23

—A—
About 3D Builder, 2-217
About 3D Builder command, 119
accuracy, 176, 183, 187
Accuracy Features, 185
Accuracy suggestions, 30
accurate model, 28
accurate perspective correction, 55
Active files, 51, 117
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Active image, 58, 61
Active photo image, 131. See Image List Tool
active window, 140
add a new image, 130
Add a new photo image, 130, 138. See Insert

Photo Tool. See Insert Photo Tool
Add Image, 100
Add image to Project, 51, 138
Add Image to the Project, 89, 130
Add Images, 43, 138
Add New Window, 138
Add The Images, 25
Add window tool, 131
Adding Photos, 137
Additional Circle Points, 164
Additional Points on Curve, 170
address, 220
airplane, 179
Ambient, 70, 92
angle, 25, 179, 223
angles, 177
animation, 223
any geometric constraints. See constraint
approximate, 80, 124, 128, 195, 208
Approximate check box, 128
Approximate Point Tool, 197
Approximate Point Tool Icon, 63
Approximation tool, 180
arc, 162, 164
arc mini-toolbar, 134
arcs, 66, 160, 2-217
Area Calculations, 91
Arrange, 2-217
Arrange Icons command, 114
Arrow Tool, 122, 207, 208, 214. See Selector

Tool
As Calculated, 31, 78, 2-217
As Input, 31, 78, 2-217
aspect ratio, 45
assign colors, 70
assigning the material, 135
authorization code, 18, 39, 40, 111, 112
AutoCAD, 15
AutoCAD 3D, 145
Automatic cameras, 180
average difference, 52
axes, 214
Axes Coordinates. See Coordinate axes

Axes Planes, 223
Axial line, 34, 204
axial lines, 212
axis, 199, 210
Axis direction, 33, 207, 214
axis hint, 195
axis hint lines, 191
axis line, 220
axis lines, 27, 135, 212
Axis Plane, 61
Axis Planes, 87
axis system, 125

—B—
background, 180
Background Color, 88
backspace key, 68
backup, 19
base to extrude, 173
Batteries, 181
behind, 76
better accuracy, 184
Bezier spline curve, 21
Bezier spline curves, 66, 167
BMP, 22
BMP file, 71, 93, 149
BMP texture map file, 71
bounding box, 70, 140
Brightness, 85, 140
Browse, 147
bucket truck, 179
bullet, 78
Buttons, 42. See Toolbar

—C—
C:\Program Files\3DCo\3DBuilder, 17
CAD, 15, 145, 179, 223
CAD packages, 15
Calc, 30, 132, 145, 157
Calc3D, 22
Calculate, 32, 52, 72, 132, 203, 223
Calculate 3D, 32, 53, 72, 92, 145, 157, 2-217.

See Calculate button
Calculate Dialog Box, 30, 132
calculate tool, 223
Calculated Camera location, 83
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Calculated focal lens length, 81
Calculated view, 31
calculating focal length, 183
calculation process, 30
calibrate, 21, 185
Calibrate Camera Lens, 112
calibrate the camera lens, 195
calibrated camera lenses, 183
calibration, 187
calibration chart, 195
calibration for distortion and optical centering,

188
calibration grid program, 184
calibration process, 187
calibration program, 183
calibration project, 98, 190
Calibration Wizard, 183, 187, 190
camera, 21, 81, 95, 115, 180, 181, 211, 212
camera angles, 177, 180
camera calibration wizard, 21, 112
camera focal length, 187
camera focal lens, 83
Camera height, 33, 83, 203. See camera
Camera Heights, 179
Camera Information, 26
camera lens, 80, 190, 213
Camera Lens box, 104
Camera Lens Data File, 47, 48, 57
Camera lens decentering, 184
Camera Lens dialog box, 81, 192
Camera Lens distortion, 184
Camera Lens drop down box, 81
Camera lens focal length, 184
Camera lens focal length., 33. See focal length
Camera lens optical decentering, 184
Camera Lens Properties, 81
Camera Lens Properties dialog box, 81, 95
Camera Lens Property, 103, 194
Camera lens Wizard, 95
camera lenses, 47, 57, 115
camera list, 193
camera location, 84. See camera
camera magnification, 23, 104
camera name, 96
Camera Orientation, 85, 140
camera orientations, 212
camera position, 22
camera sensors, 98

camera settings. See camera
Camera size, 33
Camera Station, 29, 69, 80, 83, 84, 95, 177.

See insert
camera station layout, 177
camera station number, 83
Camera Station Properties, 95
Camera Stations, 30, 33, 44, 109, 116, 143,

176, 177, 179, 180, 181, 199, 210, 211
camera stations coordinates, 94
Camera Target Point, 84
camera target size, 193
camera tripod, 177
camera type, 96, 111, 194
Camera Viewpoints, 22, 56
Camera Wizard, 21
camera/lens combination, 112
Cameras, 15, 30, 33, 44, 52, 111, 115, 132,

180
Cameras positions, 52
Cameras unreachable, 30, 52, 132
Cancel, 50
Cartesian coordinate system, 220
Cascade, 2-217
Cascade command, 114, 141
CD, 17
CD Installation, 17
check box, 73, 74, 75, 87, 124, 158, 159
Check Boxes, 91
check mark, 46, 77
child. See object
Choosing Images, 25
Circle center, 162
circle point, 65, 164
circle tool, 160
Circle Tool mini-toolbar, 160
Circle, Curve, and Extrusion mini-toolbars:, 23
circles, 52, 66, 160, 199, 2-217
Circles and Arcs, 21
Circles mini-toolbar, 134
Circles Tips, 118
circular arc, 162, 164
circular arcs, 66, 160
clock (date and time), 200
Clockwise, 85, 140
Close, 140, 141, 2-217
Close caption bar, 79
Close command. See Exit command
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Close Project, 50
Close The Image, 140
close the loop, 68, 129
closed circle, 162
Closed Curve, 21, 167, 168, 171
close-ups, 179
cloudy, 180
Colinear, 72, 125, 128, 157, 158, 209
Colinear constraint check box, 125
Colinear Constraint” dialog box, 73
color, 25, 91, 92, 106, 149, 181
Color dialog box, 110
Color Page, 92
Color Settings, 109
Colors tab, 23
columns. See grid
Command button, 16
commands, 20, 42, 52, 58, 61, 78, 113, 117,

132, 223
Commands for creating geometry, 42
complex, organic objects, 198
conceptual modeling

modeling, 186
conceptual modeling project, 195
confidential, 202
confirmation message, 47, 57
confirmation message box, 50, 140
constraint, 115, 125, 128, 157
constraint branch, 73, 74, 75, 157
Constraint check boxes, 128
Constraint Project Tree, 76, 159
constraint properties window, 159
constraints, 72, 76, 157, 159, 185
Construction Hint Lines, 27
construction lines, 180
Contents command, 118
Contents of windows. See Save
Context sensitive help, 117. See help
Contrast, 85, 140
Contrast of the image, 85, 140. See Properties

command. See Properties command
control center, 115
control points, 185
control rod, 197
coordinate, 222
Coordinate Axes, 27, 33, 34, 64, 65, 127, 212,

214
coordinate axes plane., 64

Coordinate axis, 36, 206, 212, 213. See
Coordinate axes

Coordinate axis direction lines, 33
coordinate axis line, 64, 128
coordinate axis lines, 27
Coordinate Axis Pairs, 33
coordinate axis plane, 64
coordinate planes, 127, 223
coordinate point, 221
coordinate points, 220
coordinate system, 220
Coordinate Systems, 219
coordinates, 219
coordinates of the camera location, 84
CoPlanar, 73, 125, 157
Coplanar constraint check box, 125
Coplanar constraint” dialog box, 74
copy the texture map, 148
Copyright, 119
coverage, 180
Critical project, 181
cropped, 195
cropped texture file, 150
cropping, 184
Cropping in enlarger, 184
Cropping in scanner, 184
Cropping of the Photos, 182
CRTL +S, 51. See "Save command"
CTRL + O, 50. See "Open command"
CTRL +N, 49. See "New command"
cube, 195
cursor, 20, 42, 43, 61, 62, 63, 65, 68, 122,

127, 129
cursor arrow, 65
Curve, 87
curve merging, 135
curve plane, 168
Curve Sense Tool, 135
curve tool, 21, 66, 168
Curve Tool mini-toolbar, 167
curve weights, 23
curves, 52, 133, 167, 199
Curves mini-toolbar, 134
Curves Tips, 118
Custom Install, 17
Customer Service, 201, 202
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—D—
Data Exchange Format, 145
Decartes, 220
Decimal feet, 182
Default, 86, 92, 94, 109, 122, 129, 147, 149
Default cursor, 61. See Select command
Default directory, 17, 18
default material, 91
default object, 54
Defaults, 111
Defective package parts, 201
Delete, 44, 143, 199, 2-217
Delete command, 58
delete duplicates, 199
Delete key, 51, 58. See Delete command. See

Delete command
demo mode, 19, 38, 112
depth, 221
dialog box, 76
Diffuse, 70, 92
digital camera, 21, 25, 193, 198
Digital Camera Information Sheet, 105
digital camera sensors, 98
digital cameras, 23, 104, 137, 183
digitizer

frame grabber, 198
Direction arrow, 207
Direction indicator arrows, 128
direction of line, 135
Directory, 47, 51, 54, 130, 138
Display mini-toolbar, 23, 133
Display mini-toolbars, 88
Display of the status bar, 46, 78. See Status

bar
Display of the toolbar, 41, 46, 77. See Toolbar
distortion, 187
docked, 77
Docking toolbar, 121
Down, 124
Drag and Drop, 23
drag and drop to move point, 122
Draw, 56, 69, 70, 148, 150, 151, 154
Draw Menu, 32, 61, 2-217
Draw Path, 174
Draw/ Pick Color, 69
Draw/Circle, 160
Draw/Curve, 167

Draw/Extrusion, 172
Draw/Merge, 29
drive, 54
drives, 130, 138
drop down list, 26, 111
drop down list box, 70, 89, 91, 150
drop down list box., 70
duplicate face, 199
duplicate line, 199
duplicate point, 199
DXF, 54, 145
DXF layer. See export

—E—
edge, 222
Edit, 123, 140, 151
Edit A Line, 128
Edit command, 16, 58, 61
Edit Menu, 2-217
Edit Point, 124
Edit/ Delete, 58
Editing a Circle, 164
Editing a Circlular Arc, 164
Editing a Curve, 171
Editing an Arc, 164
Editing an Extrusion, 175
Editing an Individual Item, 58
ellipse, 160
end point, 63
end points, 212
ending point, 127
enlarger, 184
Equal Length, 158
Equal Length Constraint dialog box, 75
equivalent focal length, 98
erase, 153
error message, 199
Error Messages, 200
errors in modeling, 199
Errors in Password, 200
Estimate box, 82
Estimate Camera Lens Dialog Box, 82
Estimate Camera Target Height and Width”

Dialog Box, 193
Estimate Camera Target Size Dialog Box, 82
existing point, 63
Exit, 41, 47, 57, 93, 153, 2-217
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Exiting 3D Builder, 47
Export, 15, 25, 32, 49, 53, 54, 91, 92, 145,

147, 154
Export  command, 53
Export check box, 91
export circle, 165
Export Dialog Box, 32
Export Dialog Tab Page, 32
export file, 22
export file formats, 145
Export File Tab Page., 55
export files, 154
Export Options, 54, 146
exported, 180
exporting camera viewpoints, 56
Extrude, 2-217
Extrusion mini-toolbar, 134
Extrusion Tips, 172
extrusion tool, 21
Extrusion Tool mini-toolbar, 172
extrusions, 52, 68, 172
Extrusions Tips, 118
eye, 208, 214
eye dropper, 69, 151

—F—
F3, 22, 52
F4, 22, 45
face, 59, 76, 87, 92, 151, 173, 199, 222, 223
face material, 59
Faces, 32, 52, 58, 72, 73, 86, 91, 115, 116,

125, 128, 133, 149, 159, 199
features, new, 21
Field Guide Forms, 177, 179
Field notes, 181, 182, 212
Field Notes Forms, 33, 215. See Appendix B
File, 30, 32, 47, 49, 51, 54, 72, 117, 145, 157
File format, 32
file format to be exported, 54
file formats, 137. See import
File Menu, 2-217
File name, 47, 54, 79, 89, 130, 138
File requester box, 50, 51
file type, 51, 143
File/Calc3D, 173, 175
File/Calculate 3D, 127
File/Calculated 3D Preview, 45

File/Export, 55
Film, 176, 180, 181
Film flatness, 184
Film Height, 193
film scanners, 184
film size, 96
Film Width, 193
filmstrip, 142
Filter Edges, 86
Filter Tool, 140
fine tune point location, 107
fine tuning, 208, 212
fine-tune, 124
Finish button, 39
Flip Axis Sense, 174
Flip Line/Curve Sense  Tool, 135
flipping the direction of the curve, 135
Floppy Disk Installation, 18
focal length, 21, 33, 82, 188, 212, 213. See

camera
focal length box, 193
Focal Length Conflicts, 200
focal length of the lens, 98
focal length source, 98
focal lens, 95
Focus setting, 181
Fonts, 106, 109
format, 54, 147
Frame, 181
frame grabber, 198
free form curves, 66
free-form (Bezier  spline) curves, 21, 167
Freeform Bezier curve, 2-217
free-form curves, 167
Full Install, 17
Functions, 37, 41, 191

—G—
General tab page, 124
Generic digital camera, 23
geometric elements, 221
geometric shapes, 221
geometry, 221
Getting Help, 20
Getting Started, 25
Glare, 178
Global axis/plane drop down list box, 128



      3D Builder Index 243

global coordinate planes, 92
Global Coordinates input boxes, 124
global list box, 128
global plane list, 92
grayed out, 76, 125, 128
grid, 92, 123, 181, 198
grid lines, 220
grid location, 125
grid object, 92
grid plane, 92
Grid Point, 123
Grid Point tool, 62, 123
Grid Point Tool Icon, 62, 123
grid spacing, 92
grid table, 198
Grid Tool window, 62
grids, 125

—H—
Height, 82, 221
helicopter, 179
help, 20, 64, 2-217
Help menu, 118, 2-217
Help tool, 133. See On-line help
Help tool icon. See help
Help/Tutorial, 22
Helpful Tips on Circle, 161
Helpful Tips on Curves, 168
Helpful Tips on Extrusion, 172
Hidden Point, 124
hierarchy structure, 91
high resolution film scanner, 185
highlight, 58, 62, 68, 72, 73, 74, 75, 76, 92,

123, 157, 158, 159
highlighted, 125
Hint, 124, 157
Hint line, 78. See Status Bar
hint lines, 27
hints, 180
horizontal, 64, 127, 220
horizontal grid, 125
horizontally, 129, 139

—I—
icon, 121, 141, 207, 208, 214
IGES, 54, 145

Image, 43, 79, 92, 111, 124, 128, 140, 208,
212, 223

Image Area, 124
Image files, 25
image list tool, 79, 131
Image List tool icon, 79
Image Properties, 26, 81, 192. See View
image properties box, 213
Image properties tab page, 84
image properties window, 84
image resolution, 184
image scanning, 184
Image type, 51
image view, 76
image views, 115
image window, 25, 26, 41, 70, 79, 113, 151
Image/Photo Data, 213
images, 137
Import, 32
Import file, 145
Importing File Formats, 137
Improve Accuracy, 185
Improved accuracy, 176. See Photo Tips
Inches, 182
independent measures, 186
Independent mini-toolbars, 133
individual machine, 19
Information Box, 152
information is not known,, 195
initial estimate, 52
initial estimates, 194
Initial Graphics Exchange Specification, 145
Insert, 25, 70, 89, 92, 93, 123, 150
insert a photo, 94
Insert Camera Lens, 95, 189
Insert Camera Station dialog box. See insert
Insert camera wizard, 95
Insert Grid. See grid
Insert Grid dialog box. See grid
Insert Material, 93. See material
Insert menu, Insert Material, 93
Insert Object. See insert
Insert Photo, 26, 89. See Insert
Insert Photo dialog box, 130
Insert photo tool, 130, 137
Insert Station. See camera
Insert Station” command, 95
Insert/Camera Lens, 26
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Install button, 40
installation, 17
Installation Instructions, CD, 17
Installation Instructions, Floppy Disks, 18
Installation Procedures, 17
internal magnification, 193
internal sensor size, 102
Internet, 54, 145
Internet browser, 22, 118
Internet Browsers, 145
Inventor, 22, 54, 56, 111, 198,145, 147, 154
Inventor Studio, 56
Invert the image, 85, 140. See Properties

command. See Properties command

—J—
JPEG file, 71
JPEG texture map file, 71
JPEG Texture Maps, 22
JPG, 22, 149
JPG file, 93
just-in-time helpful tips, 118
Just-In-Time On-Screen Helps/Circle Tool,

161
Just-In-Time On-Screen Helps/Curve Tool,

168
Just-In-Time On-Screen Helps/Extrusion Tool,

172

—K—
Key features, 27
key points of interest, 176
keyboard accelerator keys, 46
Keyboard Accelerators, 41, 2-217
Known Camera Height, 33, 185. See camera.

See camera height
known camera points, 185
known control points, 185
known data, 124
Known Lengths, 35, 36
known measured objects, 185
known measurements, 185
Known points, 34, 35, 36, 204, 206, 209
Known points are colinear, 209

—L—
ladder, 179
Left, 124
left hand coordinate system, 220
Length, 33, 34, 35, 204, 205, 212, 213
length of a line, 197
lens, 95
lens cap, 181
lens distortion, 180, 184
lens focal length, 81, 97, 212. See camera
lens.dat, 47, 190
lens.dat file, 103
Lenses, 44, 115, 177, 179. See Camera data
Liability, 4
LICENSE, 3, 37, 111, 200
License Authorization Instructions, 18
license authorization procedures, 37
License Wizard, 18, 37, 111
Light meter, 180
lighting, 178, 180
line, 59, 72, 74, 86, 87, 109, 121, 128, 158,

173, 180, 2-217, 222, 223
Line command, 63. See Toolbar
line configurations, 63
Line Dialog Box, 75, 128, 158, 159
line directions, 135
Line Flip, 24
Line Properties, 135, 197
Line tool, 63, 68, 127
Line tool command, 63. See Toolbar
Line Tool Dialog Box, 31, 65
line tool icons, 63
Line tool mini-toolbar, 170
Line Weight, 110
line weights, 23
Lines, 27, 32, 33, 34, 35, 36, 52, 58, 72, 115,

125, 133, 159, 199, 204, 205, 206, 207,
208, 209, 212, 214

List files of type drop down list box, 130
LIST OF FIGURES, 225
local coordinates, 125
local objects, 125
locate the camera, 176
location, 177
Location of targets, 184
Locked. See point
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—M—
machine ID, 200
Machine ID number, 39, 112
Magnify, 79, 139. See Zoom In command. See

Zoom In command. See Zoom In command
magnifying glass, 130
Main  menu, 42
Main menu bar, 45
Main project window., 46, 77. See project

window
Make, 72, 74, 75, 157, 158, 159
Make Behind, 72, 76, 199
Make Colinear, 72, 157, 158
Make CoPlanar, 73, 157
Make Equal Length, 74, 158
Make Parallel, 75, 157, 158
Make Perpendicular, 75, 159
Make Perpendicular constraints, 23
manufacturer’s data on the sensor size, 103
Many Point Polygon tool icon, 67, 129
master “lens.dat” file, 103
master lens.dat, 47
material, 59, 70, 92, 93, 149, 150
material box, 93, 151
material colors, 149
Material Data File, 57
Material dialog box, 92
Material List, 70
Material Properties, 59, 92, 151
material type, 59
Material.dat, 93
material.dat file, 22
Materials, 3, 4, 44, 58, 70, 91, 115, 116, 117,

119, 150, 151
Materials box, 150
Materials dialog box, 92, 153
Materials drop down list box, 151
Materials list, 150
Materials Property Box, 93, 150
Materials tree branch, 59
Maximize, 140
maximum setting. See grid
measure the distance, 182
Measured. See measurements
Measured Length input box, 128
measurement, 25
Measurements, 25, 33, 34, 176, 181, 204

Measuring device, 182
Measuring devices, 177
memory, 42
Menu, 16, 17, 20, 21, 25, 30, 31, 32, 42, 45,

46, 47, 49, 51, 58, 61, 77, 78, 113, 117,
160, 212, 213

Menu command, 16, 212
Merge, 15, 62, 68, 122, 126, 163, 170, 195, 2-

217
Merge command, 126
Merge point tool, 126
merge the circles, 160
Merge Tool, 29, 32, 210
merged points, 199
merges the two points, 68
Merging Curves, 170
Merging process, 32. See Merge
merging the curve, 135
message box, 93
Microsoft Windows, 15
mid-range lens, 180
Minimize, 140, 141
minimum. See grid
mini-toolbars, 23
mirror, 179
Mixed Lenses, 179
Model, 32, 180, 182
Model due YESTERDAY, 198
modeling errors, 199
Movable toolbar, 121. See Docking toolbar
Multiple Images, 29, 32, 141
Multiple Line, 65
multiple photos, 179
multiple select, 61, 122, 138
multi-select images, 138

—N—
name, 92
Name of Material Box, 91
Name of the Object. See object
natural cues, 27
natural features, 28, 194
Natural Queues, 33, 34, 204. See Queues
Need model ASAP, 198
Negative, 85, 140
Negative scanner, 198
negatives, 182, 195
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Network, 90, 130, 138
New, 81, 93, 150
New  tool, 174
New button, 83
new camera station, 83, 94
New command, 49
new features, 21
New File, 2-217
new image, 138
new image window, 139
new point, 122
New Project, 43, 49
New Window, 26, 43, 113, 138, 141, 2-217
New Window command, 113, 138
New Window tool, 114
Next image, 78, 79, 80, 2-217
No measurements, 204
No measurements known

measurements, 194
No natural right angles, 195
No reference marks visible

reference marks, 194
Non-colinear, 34, 204
Non-Planar curves, 167
Non-textured materials, 22
Normal Project, 43

—O—
object, 17, 32, 60, 91, 109, 121, 149, 151, 178,

180
Object and Material Assignment, 135
Object and Material Drop Down List Box Icon,

63
Object dialog box. See object
Object Local tab, 125
object points. See object
Object Properties, 60
object properties box, 151
Objects, 15, 25, 28, 44, 54, 58, 61, 76, 115,

116, 125, 147, 151, 154, 176, 182
objects tree, 92
Objects tree branch, 60
objects with unusual shapes, 198
obstacles, 177
obstruction, 65, 180
obstructions, 177
odd size texture map, 111, 198

On A Curve, 125
on screen, just-in-time helpful tips, 118
one beep signal, 52
one photo, 179, 210
on-line form, 22
On-Line Help, 20, 117, 118. See Help

command
online tutorials, 22
Only Show, 87
open circle, 162
Open command, 50
Open Curve, 21, 167, 168
Open Project, 50, 2-217
Open windows, 45. See Windows menu
Operating defaults, 106
Optical decentering, 184, 187
optical distortion, 187
optics, 98
Options, 106
Options Export, 55
ordinal, 219
orient, 211
Orient the camera, 34, 204. See camera

orientation
orientation, 27, 84, 140
orientation export, 22
orientations, 220
Origin, 33, 34, 204, 219. See 0,0,0 point
Origin point, 34, 204
overcast, 180
overlap, 177
Overlapping Coverage, 177
overview, 115
overview shot, 181

—P—
Paint program, 151
palette, 110
Pan, 29, 79, 129, 2-217
Pan tool, 79, 129, 139
Parallel, 75, 92, 128, 158, 208
Parallel Constraint dialog box., 75
Parent Object, 92. See object. See object
password, 37, 200
Password Problems, 200
percentage of calculations, 113
Perpendicular, 23, 75, 157, 159
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perspective, 147, 148
perspective correction, 55, 154
Perspective Correction for Texture Maps, 55
perspective distortions, 56
perspective drawing, 223
perspective matching, 185
Perspective pictures, 208
Photo, 25, 89, 93, 139, 143, 150, 176, 2-217,

223
Photo CD, 25, 90, 137, 182, 184, 198
Photo CD Select Resolution Size Box, 85
Photo CD Size, 140
Photo Data, 212
photo enlarger, 184
photo session, 176
photo shoot, 28, 176, 180, 181
Photo Tips, 25, 176
photograph, 223
photographic enlargement, 184
photographic supply shop, 181
photographs, 137, 182, 220
Photos, 15, 16, 21, 25, 26, 27, 44, 52, 115,

132, 143, 180, 181, 182, 199
Photos Cropping, 182
Pick, 36, 61, 206
Pick Color, 69, 70, 151
Pick Color Dialog Box. See Draw
picking a color, 149
Pictures taken by someone else, 195
pixel, 212
pixel resolution, 183
pixel size, 71, 150
Placing Points Outside an Image, 80
planar curves, 167
Plane, 36, 73, 92, 157, 160, 199, 206, 210,

222, 223
plane of the curve, 168
Planning, 176, 177
plus sign (+), 17
point, 29, 59, 68, 72, 73, 86, 109, 121, 123,

125, 210, 2-217, 222, 223
point address, 220
Point Dialog Box, 73, 158
point location, 196
Point location is unseen, 197
Point Merge tool, 69
Point on a Circle, 65
Point on a Curve, 65

Point Pair Tool Icon, 62, 123
Point Properties, 125, 196
Point tab page, 123
Point Tool, 17, 27, 31, 32, 62, 122, 126
Point tool command, 62. See Toolbar
point tool icons, 62
Pointer tool, 121. See Selector tool
Points, 27, 28, 29, 30, 32, 33, 34, 35, 36, 52,

58, 62, 63, 67, 68, 72, 87, 92, 115, 122,
125, 126, 129, 132, 133, 157, 158, 159,
177, 182, 199, 203, 204, 206, 208, 209, 211

points on the circle, 122
polygon, 70, 2-217, 222
polygon configurations, 66, 129
Polygon Object and Material Tool Icon, 67
Polygon Plane Tool, 67
Polygon tool, 66, 128. See Toolbar
polygon tool icons, 66, 129
polygons, 128
Polyline Tool, 65, 164, 170
pop-up, 192, 193
pop-up menu, 151
power shortcut keys, 22
preferences, 106
primitives, 221
Print paper flatness, 184
print scanner, 184
Prior Image, 79, 2-217
problem, 52, 191
Problem Area, 147
Problem Reporter, 147
Problems, 55, 88, 180, 200
Problems not Listed, 200
Product information, 201
Progress reporter, 30, 52, 113, 132
projec, 115
Project, 43, 58, 59, 73, 74, 92, 103, 116, 130,

131, 138, 142, 143, 151, 179, 199
Project file, 50, 89, 94, 154
Project files, 32, 44, 91
Project settings, 94. See options
project tree, 58, 60, 116, 142, 159
Project Window, 22, 41, 44, 58, 72, 76, 91,

115, 142, 143, 151, 157, 199
projector lens, 184
proofs, 182
Properties, 58, 59, 75, 80, 140, 151, 192, 194,

2-217. See View
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Properties Box, 151
Properties window, 59, 74, 92
property box, 208
property window, 115
Props, 177

—Q—

QUICK GUIDE, 25

—R—
radial lens distortion, 183
rapid conceptual modeling, 186
rapid prototyping machines, 54
Read Me file, 18
Recent File, 117
Recent File” command, 117
rectangle, 67, 70, 93, 129, 150
rectangles, 221
Reference, 29
reference marks, 194, 198
reference point, 219
reference points, 28, 29, 177. See targets
Reference targets, 25, 27, 28, 32, 160, 167,

181, 182
Refresh, 149
Registration, 201
Registration address, 201
Registration card, 4, 20, 201
Remove. See Delete command
rendering, 223
Rendering package, 32, 49
rendering program, 84
Rene Decartes, 220
reposition, 124
resize, 142
resized, 45, 79
Resizing the window, 116
Resolution Size, 85
Right, 124
right hand coordinate system, 220
Right handed coordinate system, 207
right-handed coordinate system, 174, 222
rigid pole, 179
rooftop, 179
Rotate, 140

rotated, 116, 223
rows. See grid
rubber-banded, 65

—S—
Safety hazard, 177
same length, 74, 128, 157, 158
same point, 109
Same Point tool, 124
Same Point Tool Icon, 62, 123
Save, 32, 41, 47, 51, 132, 143, 2-217
Save As, 47
Save As Dialog Box, 47
Save Project, 51
Save Project As, 51
Saving A Project, 47
Scale, 34, 181, 194, 204
scaled, 223
scanner, 198
Scanner position accuracy, 184
Scanner sampling resolution, 184
scanners, 137
scanning from prints, 185
scanning prints, 183
screen, 82
Screen Layout, 23
Scroll, 79, 129, 139. See Pan Tool command
second beep signal, 52
select, 121
Select All command, 61
Select command, 61
Select First Point, 126. See Merge point

command
Select image, 90, 139, 2-217
Select Image command, 79
Select Image Dialog Box, 79, 131, 142
Select Image list, 79, 131, 142. See Image List

tool. See Image List tool
Select Photo dialog box, 130, 138. See Insert

Photo Tool. See Insert Photo Tool
Select This Point, 126. See Merge Point

command
Selector, 128
Selector tool, 121, 122, 171, 175
Selector tool icon, 123
semi-automatic mode, 69
Semi-Automatic Point Matching, 69, 126
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sensors, 98
Set button, 109
set of materials, 149
Setting the colors, 70
Setting the object, 135
settings. See grid
Settings/Line Weight, 110
Setup, 181
Shift, 73, 158, 159
shift key, 122
Shortcut, 42, 46, 51, 58. See Toolbar

commands
shortcut keys, 22
shrink, 124
Single Point Tool Icon, 62, 122
Skew, 65, 127
Skew Line Tool Icon, 64
Small Object, 178
snap, 72, 158
Snap-to, 63
Software License Agreement, 3
Solid, 88
Sources of Error, 184
spacing, 92
Specular, 70, 92
spin control, 150
spin control arrows, 71
spline curves, 66
Split, 114, 2-217
Splitter, 140
Splitter bar, 43, 114, 139
Splitter window, 25, 43
STARTING A PROJECT, 41
starting point, 127
Station. See camera
Station Location, 81
Station Location tab page, 83
station number. See camera
stations, 115
Stations/Photos, 143
Status bar, 41, 42, 46, 65, 68, 78, 126, 129,

199. See Status bar
Status Bar command, 78
Step back. See Zoom Out command
STL, 54, 145
story-board, 182
sub-pixel positioning, 184
sub-pixel precision, 22

sun, 180
surface properties, 92
surface shape, 221
System Requirements, 16

—T—
tab, 109
tab page, 26, 80
tagged, 91, 92
tape measure, 99, 188
target, 182
target features, 184
Target Film Height and Width., 82
Target Height, 193
Target locations, 181
Target points, 33
Targets, 25, 27, 32, 99, 176, 177, 181, 182,

185, 188, 194, 198. See reference targets
technical support, 20, 201, 202
telephoto, 97
Texture, 91, 149, 150
texture a circle, 165
texture a circlular arc, 165
texture an arc, 165
texture an object, 66
texture coordinates, 56, 148
texture file name, 154
texture file name embedded, 56
Texture Map, 70, 93, 111, 198,  149, 151
Texture Map dialog box, 71, 150
texture map from the photo, 150
texture map image file, 148
Texture Map Tool, 150
Texture maps, 56, 115, 116, 147
Texture Pattern, 70, 92
Texture Pattern icon, 70
textures, 25, 117
Texturing a Curve, 171
The Project Settings, 106
the texture map section, 93
three dimensions, 220
threedc@usit.net, 200
three-dimensional coordinate system, 221
Thumbnail, 25, 43, 79, 131, 140, 151
Tile, 2-217
Tile command, 114, 141
tip, 176



      3D Builder Index 250

tips, 118
Tips on Curves, 168
toggle switch, 78
tool, 157
tool bar, 42
Tool Bar command, 77
tool icon, 131, 138
Tool icons, 77. See Toolbar
Toolbar, 20, 29, 30, 31, 32, 41, 46, 62, 63, 70,

74, 75, 76, 77, 79, 90, 109, 114, 118, 121,
122, 123, 126, 127, 130, 131, 132, 133,
137, 142, 143, 145, 151, 207, 208, 214

ToolBar ribbon, 77
Tools/Calibrate Camera Lens, 187
Tools/License menu, 38
Tools/Verify Points, 22, 102, 106
Touch Up, 152
Touching Up Textures, 151
tree control level, 116
Tree control system, 44, 115. See Project

Window
tree listings, 115
triangulation solver, 185
Turn the image by 90 degree, 85, 140. See

Rotate. See Properties command. See
Rotate. See Properties command

tutorial image files, 19
tutorials, 118
two dimensions, 221
type of camera, 96
Type of Project, 43
types of colors, 70

—U—
Unknown camera type, 192, 193, 195
Unknown focal length, 191
Unlocated. See point
unlocated points, 87. See Calculate 3D
unnamed-1, 54, 147
Unreachable, 30, 52, 132
unrestricted use, 19, 38, 112
Unsaved information, 47
Up, 124
Upgrade, 201
upgrades, 20
Using Help, 2-217

—V—
Verified check box, 124
Verify occurrences/ same point, 108
Verify Point wizard, 107
Verify Points, 106
Verify Points Wizard, 106
Verify Wizard, 102
Version number, 119
vertex, 222
vertical, 64, 127, 220
vertical grid, 125
vertically, 129, 139
video camera, 25, 198
video cameras, 98, 137
View, 26, 29, 52, 80, 86, 90, 113, 139, 140,

142, 207, 208, 212, 214
View Filter, 86, 207, 208
View Filter dialog box, 87
view finder, 185
View Image Properties, 83
View menu, 31, 46, 77, 78
View Menu Commands, 76
View/ Select Image, 79
View/“Prior” Image, 79
View/All, 80
View/Background Color, 45
View/Background Colors, 116
View/Next Image, 79
View/Solid, 45, 116
View/Wireframe, 45, 116
View/Zoom Out, 80
ViewFilter mini-toolbar, 88
viewfinder, 179, 180
Viewing an Extrusion, 175
Virtual Reality Modeling Language, 145
Visible, 29, 46, 77, 78, 210, 211
visible features, 194
Visible Height, 82
Visible Width, 82
VRML, 22, 54, 56, 145, 147, 154
VRML 2.0, 22

—W—
Warranty and Disclaimer, 3
Wavefront, 54, 56, 111. 198, 145, 147, 154
Web, 145
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wide angle, 97
wide angle lenses, 187
Widely Spaced Angles, 177
Width, 82, 221
Window, 52, 58, 59, 90, 92, 116, 131, 141,

143, 151, 159, 199
Window/3D Preview, 22
Windows 98, 16
Windows commands, 113
Windows menu, 45, 113
WindowsNT, 16
Wireframe, 88
wizard, 106
world space, 221

—X—
X, 33, 34, 35, 52, 132, 204, 205, 207, 209,

214, 220, 223
X axes do not intersect, 208
X axis line direction conflict, 207
X Line Tool Icon, 64
Xhost ID, 200
XNETINST.TMP, 18
XY, 223
XY Line Tool Icon, 64

—Y—
Y, 33, 34, 52, 132, 204, 205, 207, 209, 214,

220, 223

Y axes do not intersect, 208
Y axis line direction conflict, 207
Y Line Tool Icon, 64
YZ, 223
YZ Line Tool Icon, 64

—Z—
Z, 33, 34, 52, 132, 204, 205, 207, 209, 214,

220, 221, 223
Z axes do not intersect, 208
Z axis line direction conflict, 207
Z Line Tool Icon, 64
Zoom, 2-217
Zoom Feature, 24
Zoom In, 79, 124, 130, 139, 2-217. See Zoom

In command. See Zoom In command. See
Zoom In command

Zoom In command, 79, 139
Zoom in tool, 130, 139
Zoom lens, 97
Zoom Out, 80, 124, 2-217. See Zoom Out

command
Zoom Out command, 80
Zoom out tool, 130, 139
Zoom Tool, 129
zooming in, 184
ZX, 223
ZX Line Tool Icon, 64


